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Please be sure to read this user’s guide before using the Toshiba Pocket
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to learn about important safety issues.
?After reading this document, keep it in a convenient place for future
reference.
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Safety precautions
?Please carefully read “Safety precautions?before using the Toshiba
Pocket PC e800/e805 and ensure that you are aware of correct handling
procedures.
?The precautions provide essential information for the protection of
the
user and others from possible injury and property damage. They also
provide information on the safe handling of this product.
?Please check that you fully understand the definition of the following
messages (signs and graphical symbols) before reading the text, and
always follow the instructions provided.
NOTE
Safety instructions
All safety instructions must be read carefully and must be fully
understood,
before attempting to use your Toshiba Pocket PC. This manual
contains the safety instructions that must be observed in order to avoid
potential hazards that could result in personal injuries or could damage
your computer. The safety instructions have been classified according
to
the seriousness of the Risk, as follows:
Meaning Signal Word
Indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.
Indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.
Indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.
Indicates a potentially hazardous situation which, if not
avoided, may result in property damage.
Provides important information.
Always request and obtain prior consent and approval of an authorized
airline representative before using your Pocket PC aboard an aircraft.
Always follow the instructions of the airline representative whenever



using
your Pocket PC aboard an aircraft, to prevent any possible interference
with airborne electronic equipment. Your Pocket PC produces low levels
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of RF energy due to the generation of digital timing pulses by its clock
oscillator circuits. Your Pocket PC has been equipped with internal
shielding
to minimize any stray emissions of RF energy. Airlines may nevertheless
prohibit the on-board use of all portable PCs (and all other portable
electronic devices that could potentially emit stray RF energy),
particularly
during take-offs and landings, to prevent any possible interference
with
the reception of signals by airborne electronic navigational devices.
Certain locations, such as hospitals, may restrict the use of Pocket
PCs
and other devices that emit low-level RF energy.
Always comply was posted prohibitions of the use of RF-emitting devices,
such as in hospitals. Failure to follow such directives could result
in the
interference with medical equipment and/or devices.
Never come closer than 16 cm (6 inches) to a person with a heart pacemaker
implant when using this Pocket PC in combination with a mobile
cellular telephone. Failure to do so could result in interference with
the
function of the pacemaker.
Never use a Pocket PC while driving an automobile or any other moving
vehicle. Always pull out of traffic and come to a stop in a legally
permissible
and safe location before using your Pocket PC. Failure to do so could
result in serious bodily injury in a traffic accident.
Never use your Pocket PC while walking. Usage while walking could
result in bodily injury caused by inattention to automobile traffic
or other
pedestrian hazards.
Never allow metallic objects, such as staples and paper clips, to enter
inside your Pocket PC. Metallic objects, such as staples and paper clips,
if



allowed to enter your Pocket PC, could cause the generation of excess
heat or fire.
Never connect terminals (metal parts) to metallic objects (such as
wires).
Connecting terminals to metal objects could cause excessive heat or
fire.
Always immediately turn the battery switch to the “off?position and
disconnect
the AC Adaptor from the power outlet in the event the Pocket PC
emits an unusual odor or sound or generates smoke.
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Never use or store your Pocket PC in the following locations:
Anywhere it may be exposed to water, such as a bathroom or sauna;
In conditions of high humidity, such as in the rain or fog; Where your
Pocket PC will be exposed to high temperatures, such as near a fire
or
equipment that emits high temperatures; In direct sunlight; or In a
sealed
automobile left in the sun and subject to high temperatures.
Never drop your Pocket PC or subject it to severe shock. Dropping your
Pocket PC or subjecting it to severe shock could cause the removable
battery to leak, ignite and/or rupture.
Always immediately remove your Pocket PC and its battery from the
vicinity
of any open flame in the event the removable battery leaks liquid or
emits an unusual odor. Continued use of your Pocket PC under either
of
these conditions could cause ignition (i.e., fire) of the leaked battery
liquid,
or rupture.
Never touch any fluid that might leak from the removable battery. Such
liquid when in contact with the eyes or skin, could cause injury to
the skin
or eyes. Should the liquid come into contact with the eyes, irrigate
the
eyes thoroughly with clean water and immediately seek medical
attention.
In the event the liquid comes into contact with the skin or clothing,



wash it
away immediately with clean water.
Never attempt to disassemble, repair or make any modification to your
Pocket PC. Disassembly, modification or any attempt at repair could
cause bodily injury or property damage, as well as damage to the Pocket
PC itself.
Failure to follow the above directions concerning use and storage could
result in damage to your Pocket PC or bodily injury and property damage
due to battery liquid leakage, fire or rupture.
Never raise the sound volume level to high when using your Pocket PC
with earphones. An excessive sound volume level could cause damage to
your hearing.
Never touch the liquid that might leak from a broken liquid crystal
display.
Contact with this liquid could cause a skin rash. If the crystal display
liquid
should come into contact with the skin or clothing, wash it immediately
with clean water.
Never allow infants or small children within reach of your Pocket PC.
Infants or small children could injure themselves if allowed access
to your
Pocket PC.
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Never attempt to disassemble or repair an AC Adaptor, and never alter
their Power Supply Cables or plugs as exposure to electric shock hazards
could result.
Always contact an authorized service provider, if repair or replacement
is
required.
Always use the AC Adaptor that has been provided with your Pocket PC.
Bodily injury or property damage could occur as a result of the use
of an
unauthorized and incompatible AC Adaptor in violation of this Warning.
Never connect or disconnect the AC Adaptor with wet hands. Connecting
or disconnecting the AC Adaptor to a power source with wet hands could
cause electric shock.
Never place an AC Adaptor on a wooden surface (or any other surface
that could be marred by exposure to heat) while it is in use, since



its surface
temperature increases during normal use. Always rest it on a suitable
heat-insulating material.
Never cover the AC Adaptor with any object while it is in use, and never
place it adjacent to a heat source. An excessive temperature increase
could detrimentally affect its performance.
Never place a Power Supply Cable near a heat source, as damage to the
cord or to its insulation could result.
Always use a surge protector when utilizing the AC Adaptor during an
electrical storm. Otherwise, a power surge could result in the loss
of
stored data.
Insert the power plug to a household electric outlet.
When travelling abroad, never plug the AC Adaptor into a power source
that does not correspond to both the voltage and the frequency specified
on the rating plate of the unit, as equipment damage will result.
Never attempt to connect or disconnect the power plug with damp or wet
hands. Connecting or disconnecting the power plug with damp or wet
hands could result in an electric shock.
Never leave an open container, such as a cup or glass, containing a
liquid
near the AC Adaptor. Spilled liquid coming in contact with the AC
Adaptor could cause a fire or electric shock.
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Always ensure the power plug pins are clean and free of dust or other
foreign
material by wiping the pins with a clean dry cloth. Dust or other foreign
material accumulation on the power plug pins could cause fire.
Always unplug the power plug from an outlet by grasping the power plug
itself. Never pull on the Power Supply Cable to disconnect the Power
Supply Cable from an outlet. Pulling on the Power Supply Cable could
cause a fire or electric shock as a result of damage to the Power Supply
Cable.
Never use a worn or damaged AC Adaptor Power Supply Cable or plug,
or a worn or damaged extension cord or plug. The use of a worn or damaged
Power Supply Cable or plug could result in electric shock or fire.
Always contact an authorized service provider immediately to obtain
a



suitable Power Supply Cable replacement.
Never bend or twist a Power Supply Cable, and never pull on a Power
Supply Cable in an attempt to remove a plug from an outlet. Always grasp
the plug directly when unplugging a Power Supply Cable to avoid causing
any damage to the cord.
Never plug the AC Adaptor into an overloaded multiple outlet, power
strip
or surge protector to prevent blowing a fuse or tripping a circuit
breaker.
Never place heavy objects on a Power Supply Cable, as that could result
in damage to the cord.
Always confirm that the AC Adaptor plug (and the extension cord
and plug, if any) have been fully inserted into the receptacle, to
assure a secure electrical connection.
NOTE
Under certain conditions, data may be lost, including:
Misuse of your Pocket PC; Subjecting the main unit of your Pocket PC
to
static electricity and/or noise; Total loss of electric charge in the
removable
battery; and Servicing of your Pocket PC.
Avoid connecting your Pocket PC to an external device such as a computer
in an environment likely to be affected by static electricity. For
example
during low-humidity weather, shuffling your shoes upon a rag can
produce static electricity. Before you handle your computer, you should
touch a grounded object to discharge any static electricity from your
body.
Avoid using your Pocket PC in environments that are likely to be affected
by static electricity or are prone to high electrical noise. If you
connect
your Pocket PC to a computer via the docking cradle for data transfer
or
data restoration purposes, Toshiba will not be responsible for any
Pocket
PC or computer malfunction, problems with data transfer or data
modifications/
loss that may occur in these environments.
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Use your Pocket PC only in locations with the following ambient
environmental
conditions:
Under normal operational use with temperatures between 0°C and 40°C
(32°F and 104°F); With humidity of 30% to 80%; and When charging the
battery with temperatures between 5°C and 40°C (41°F and 104°F).
Do not store or use your Pocket PC in the following locations:
Those subject to extremely high or low temperatures; Dusty locations;
and Locations or sites subject to strong vibration.
Use or storage in these location, sites or areas can result in product
failure,
malfunction or loss of data.
Do not subject your Pocket PC to sudden and severe temperature
changes. This could result in moisture condensation in the Pocket PC
that
could cause damage to your Pocket PC, computer function loss, and/or
the loss of data. In the event of moisture condensation, allow your
Pocket
PC to dry out completely.
It is normal for the AC Adaptor to become warm when charging.
Disconnect the power plug from the outlet when not in use.
Take care not to sit on your Pocket PC when it is located in the back
pocket of trousers, etc. This could cause damage to your Pocket PC or
malfunction of the Pocket PC functions.
Do not place objects on top of your Pocket PC or drop them on top of
your
Pocket PC. This could cause damage to your Pocket PC and/or malfunction.
Clean terminals (metallic parts) on a regular basis with a cotton swab.
Dirty terminals could affect battery charging.
Never use organic solvents such as benzene or paint thinner to clean
your Pocket PC. Use of these solvents can cause deformation or
discoloration.
Do not wipe the display with a damp or wet cloth or touch the display
with
damp or wet hands. Wiping or touching the display under this condition
can cause product failure or malfunction. Always use a soft dry cloth
to



wipe the display.
When using the “SD memory card?and/or ?CF) compact flash
card,?be sure to read the relevant instruction manual and ensure
that you know the proper procedures for their use.
Never subject the card to any severe shock while connected to your
Pocket PC. Such a shock can cause damage to the card and a malfunction.
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Do not carry your Pocket PC with the card connected to it. This can
result
in the damage or loss of the card.
Never connect cradle terminals with metallic objects, such as wires.
Connecting
these terminals with metallic objects may cause the production of
excess heat, burns and damage to the charger and/or your Pocket PC.
Lithium-Ion batteries are recyclable. Never dispose of the battery with
ordinary waste.
Never bend or twist your Pocket PC. This could cause damage to your
Pocket PC or malfunction of the Pocket PC functions.
Supplementary Information:
Weitere Informationen:
Informations complérnentaires:
Información complementaria:
Ulteriori informazioni:
Ytterligare information:
“The product complies with the
requirements of the Low Voltage
Directive 73/23/EEC and the EMC
Directive 89/336/EEC.?
“Das Produkt entspricht den
Anforderungen der Niederspannungs
Richtlinie 73 23/EG und der
EMC-Richtlinie 89/336/EG.?
“Ce produit est conforme aux exigences
de la directive sur les
basses tensions 73/23/CEE et de la
directive EMC 89/336/CEE.?
“El Producto cumple los requistos
de baja tensión de la Directiva 73/



23/CEE y la Directiva EMC 89/336/
CEE.?
“Il prodotto ?conforme ai requisiti
della direttiva sulla bassa tensione
73/23/EG e la direttiva EMC 89/
336/EG.?
“Produkten uppfyller kraven enligt
lägspänningsdirektiver 73/23/EEC
och EMC-direktiv 89/336/EEC.?
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Working environment
This product was designed to fulfill the EMC (electromagnetic
compatibility)
requirements for “residential, commercial and light industry
environments?
Toshiba does not approve the use of this product in working environments
other than “residential, commercial and light industry environments?
For example, the following environments are not approved:
?Industrial Environments (environments with a main voltage >230V~)
?Medical Environments
?Automotive Environments
?Aircraft Environments
Any consequences resulting from the use of this product in working
environments
that are not approved are not the responsibility of Toshiba Corporation.
The consequences of the use of this product in non-approved working
environments may be:
?Interference with other devices or machines in the nearby surrounding
area
?Malfunction of, or data loss from, this product caused by disturbances
generated by other devices or machines in the nearby surrounding
area
Therefore Toshiba strongly recommends that the electromagnetic
compatibility
of this product be suitably tested in all non-approved working
environments before use. In the case of automobiles or aircraft, the
manufacturer
or airline respectively should be asked for permission before use



of this product.
Furthermore, for general safety reasons, the use of this product in
environments
with explosive atmospheres is not permitted.
CE compliance
This product and the original options are designed to observe the related
EMC (Electromagnetic compatibility) and safety standards. However,
Toshiba cannot guarantee that this product still observes these EMC
standards
if options or cables not produced by Toshiba are connected or
implemented. In this case the persons who have connected/implemented
those options/cables have to make sure that the system (PC plus options/
cables) still fulfils the required standards. To avoid general EMC
problems,
the following advice should be observed:
?Only CE marked options should be connected/implemented
?Only best shielded cables should be connected
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FCC Notice
“Declaration of Conformity?
This equipment has been tested and found to comply with the limits for
a
Class B digital device, pursuant to part 15 of the FCC Rules. These
limits
are designed to provide reasonable protection against harmful
interference
in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in
accordance
with the instructions, may cause harmful interference to radio
communications.
However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined
by
turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:
?Reorient or relocate the receiving antenna.



?Increase the separation between the equipment and receiver.
?Connect the equipment into an outlet on a circuit different from that
to
which the receiver is connected.
?Consult the dealer or an experienced radio/TV technician for help.
Only peripherals complying with the FCC class B limits
may be attached to this equipment. Operation with noncompliant
peripherals or peripherals not recommended
by Toshiba is likely to result in interference to radio and
TV reception. Shielded cables must be used between the
external devices and the computer’s USB ports, external
monitor port, PS/2 keyboard port and PS/2 mouse
port.Changes or modifications made to this equipment,
not expressly approved by Toshiba or parties authorized
by Toshiba could void the user’s authority to operate the
equipment.
This device complies with part 15 of the FCC Rules. Operation is subject
to the following two conditions:
1. This device may not cause harmful interference
2. This device must accept any interference received, including
interference
that may cause undesired operation.
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BSMI Notice (Taiwan Only)
Canadian Regulatory Information
(Canada Only)
This digital apparatus does not exceed the Class B limits for radio
noise
emissions from digital apparatus as set out in the Radio Interference
Regulation
of the Canadian Department of Communications.
Note that Canadian Department of Communications (DOC) regulations
provide, that changes or modifications not expressly approved by
TOSHIBA Corporation could void your authority to operate this
equipment.
This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.
Cet appareil numérique de la class B respecte toutes les exgences du



Règlement sur le matériel brouilleur du Canada.
VCCI Notice
(Japan Only) Class BITE
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FCC Class B Digital Devices & Peripheral
Devices (Declaration of Conformity or
Certification Authorization)
Declaration of Conformity Label & Marking
Requirements
?User Manual must provide user information in accordance with
?5.19(a)(3), 15.21, 15.27 and 15.105(b):
Instruction Manual Federal
Communication Commission
Interference Statement
This equipment has been tested and found to comply with the limits for
a
Class B digital device, pursuant to Part 15 of the FCC Rules. These
limits
are designed to provide reasonable protection against harmful
interference
in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in
accordance
with the instructions, may cause harmful interference to radio
communications.
However, there is no guarantee that interference will not occur in a
particular
installation. If this equipment does cause harmful interference to
radio
or television reception, which can be determined by turning the
equipment
off and on, the user is encouraged to try to correct the interference
by one
of the following measures:
?Reorient or relocate the receiving antenna.
?Increase the separation between the equipment and receiver.
?Connect the equipment into an outlet on a circuit different from that
to



which the receiver is connected.
?Consult the dealer or an experienced radio/TV technician for help.
FCC Caution: Assure continued compliance (for example, use only
shielded interface cables when connecting to computer or peripheral
devices). Any changes or modifications not expressly approved by the
manufacturer of this device could void the user's authority to operate
this equipment.
This device complies with Part 15 of the FCC Rules. Operation is subject
to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.
Toshiba America Information Systems, Inc.
 IMPORTANT NOTE:
 FCC Radiation Exposure Statement:
 This equipment complies with FCC radiation exposure limits set forth
for an uncontrolled environment. End users must follow the specific
operating instructions for satisfying RF exposure compliance.

 

This transmitter must not be co-located or operating in conjunction
with any other antenna or transmitter.

9740 Irvine Blvd.
Irvine, CA 92618-1697
1-800-Toshiba
Responsible Party:
Telephone No:
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Chapter 1: Getting Started
Chapter 1:
Getting Started
Welcome
Congratulations on purchasing your Toshiba Pocket PC. Due to the size
and capabilities of this device, you can keep your most important
business
and personal information up-to-date and close at hand. Microsoft?
ActiveSync?increases the power of your device by allowing you to
synchronize
the information on your desktop or laptop computer with your
device.
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Where to Find Information
This book describes your Pocket PC hardware, provides an overview of
the programs on your Pocket PC, and explains how to connect your
Pocket PC to a desktop computer, a network, or the Internet. For
instructions
on setting up your Pocket PC and installing ActiveSync, see information
to help you use your Pocket PC.
For information on:
Programs on your Pocket PC
Additional programs that can be
installed on the Pocket PC
Connecting to and synchronizing with a
computer
Last-minute updates and detailed technical
information
Up-to-date information on your Toshiba
Pocket PC
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See this source:
This User’s Guide and device Help To



view Help, tap
The Pocket PC Companion CD.
The Quick Start Card or Active Sync
Help on your computer. To view Help,
open the Microsoft Active Sync application,
and then click Help.
The Read Me files, located in the
Microsoft Active Sync folder on the
desktop computer and on the Pocket
PC Companion CD.
http://www.pda.toshiba.com
and then Help.
Chapter 2:
Basic Skills
Your Toshiba Pocket PC e800/e805 is easy to learn how to use. This
chapter describes the use and customization of your Toshiba Pocket PC
e800/e805.
Parts Names and Function
Main unit (front view)
Power Button/Screen Light
Stereo headphone or
microphone input
Wireless communication LED
Recording Button
(Program Button 5)
Cursor Button/
Navigation Button
Program Button 1, 2, 3 & 4
(from the LEFT)
Cradle connection port
Optional Expansion Pack
Program Button Initial Settings
Program button 1 = Calendar
Program button 2 = Tasks
Program button 3 = Home
Program button 4 = Contacts
Program button 5 = Voice recorder
Cradle Connection Port
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Stylus
Battery/
Alarm LED
Touch Screen
Speaker
Guide Pin
Lock
Release Button
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Cradle Connection Port
Main unit (end view)
DC-IN socket
Cradle Connection Port
Optional Expansion Pack
USB Port
Cradle
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Hold Switch
Battery Switch
Wireless Communication
Switch
(Wireless lan model only)
RGB (Monitor) Port
Main unit ( back view )
SD CARD SLOT
STYLUS
CFII CARD SLOT
BATTERY PACK LOCK
Power Button
The power button performs the functions described in the table below.
Power button
Press and hold.
Press it quickly.
When the power is off
The power turns on.
The power turns on.
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CF RELEASE BUTTON (USE
STYLUS TO EJECT)
MIC
STEREO HEADPHONE OR
MICROPHONE INPUT
TOSHIBA SCROLLER
INFRARED PORT
RESET BUTTON
OPTIONAL EXPANSION PACK
DC-IN SOCKET
When the power is on
The screen light alternately
turns on/off.
The power turns off.
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Battery Switch
The battery switch supplies/cuts off the battery power to the Toshiba
Pocket PC e800/e805.
The setting of this switch at shipment is “ stop.?When using the Toshiba
Pocket PC e800/e805 for the first time, slide this switch to the left
(the
“supply?side) with the stylus.
Battery/Alarm LED
The Battery/Alarm LED indicates the machine condition.
Flashing orange
Orange
Yellow
Green
20
Switching the battery switch to the "stop" position at any
time will lead to loss of data.
BATTERY SWITCH
STOP SUPPLY
When the preset alarm time, which was set through Calendar
or Tasks, goes off, the lamp starts flashing.
Indicates charging of the battery.



The battery charging process is stopped due to the
ambient temperature being too high or low. Charge the
battery in an ambient temperature of approximately 41°F
to 104°F (5°C to 40°C).
Indicates full charge of the battery.
Chapter 2: Basic Skills
Wireless Communication Switch
(Wireless LAN model only)
1. To enable Wireless module, make sure the Wireless Communication
Switch is turned on. (The default setting is Power Off. Slide the
switch to the left to turn the power on.)
2. If this is your first time turning on the switch, the IP Address
Page
will pop up for you to set the IP address, Subnet mask and Default
gateway.
ON OFF
WIRELESS COMMUNICATION
SWITCH
Wireless LED Descriptions
LED indicates the different status:
Status LED
Wireless Communication Switch is turned OFF Off
Wireless Communication Switch is turned ON Orange
Hold Switch
When in use, the Hold switch icon will be displayed on command bar and
AP Keys 1 through 5, the Rocker Key, and Scroll Key will be disabled.
When not in use, these keys will be enabled again.
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How to Use the Stylus
The stylus is used for menu selection or data input on the touch-screen
of
the Toshiba Pocket PC e800/e805.
  Tap: Touch the screen once with the stylus to open items and select
options.
  Drag: Hold the stylus on the screen and drag it across to select text
and images. Drag in a list to select multiple items.
  Tap and hold: Tap and hold the stylus on an item to see a list of



actions available for that item. On the pop-up menu that appears, tap
the action you want to perform.
NOTE When you operate the touch screen of the Toshiba
Pocket PC e800/e805, use the supplied stylus.
If the tip of the stylus is damaged, do not use it. If you
operate the touch screen with a damaged stylus or a ballpoint
pen, the touch screen may be damaged.
When the stylus is damaged, please purchase a new
one.
About the Cursor Button
You can move a cursor (selection display) on the screen by pressing
the
upper, lower, right or left part of the cursor button.
You can select a program to launch by pressing the center part of the
cursor
button.
NOTE The cursor movement is different depending on the
screen. When the cursor is at the right or the left side of
the screen, it may not move.
About the Scroller
You can also move the cursor on the screen by moving the scroller up
and
down.
You can select a program to launch by pressing the scroller.
Method 2: Connect the supplied AC adapter and the Toshiba Pocket PC
e800/e805
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Battery Charging
When using the Toshiba Pocket PC e800/e805 for the first time, set the
battery switch to the supply side, and then charge the removable battery
with the supplied AC adapter.
How to Charge the Battery
You can use two charging methods.
NOTE Turn the unit off before connecting the AC Adapter and
your Toshiba Pocket PC e800/e805.
Method1: Connect the supplied AC adapter and the cradle as shown in
the figure below, and then insert the Toshiba Pocket PC e800/
e805 into the cradle.
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Method 2: Connect the supplied AC adapter and the Toshiba Pocket
e800/e805 as shown in the figure below.
NOTE For charging the battery, maintain an ambient temperature
from approximately 41°F to 104°F (5°C to 40°C).
When the lamp is lit in orange during the battery charging,
you can use the Toshiba Pocket PC e800/e805.
When the battery is completely charged, the LED alarm
lamp color will change to green.
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How to Attach/Detach the Main Battery Pack
1. Turn off the power.
2. Switch the Battery Pack Lock to release the battery pack.
3. Attach/Detach the battery from the Pocket PC.
Battery Pack Lock
Switch to release battery pack Lock
Release
Attach
Detach
NOTE You cannot turn on the power if the Battery Pack Lock is
in the Release Position.
You can change the main battery without data loss
because the Toshiba Pocket PC e800/e805 has a
rechargeable backup battery. However, the capacity of
the backup battery is limited, therefore when you change
the main battery, attach the new main battery and switch
the Battery Pack Lock to the lock side as soon as possible.
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How to Use the Optional High Capacity
Battery Pack
1. Detach the Main Battery.
2. Attach the High Capacity Battery pack to the Pocket PC.
3. Switch the Battery pack Lock to lock the High Capacity Battery pack.
NOTE
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Switch to Lock the High Capacity Battery
Pack.
You cannot turn on the power if Battery Pack Lock is at
the Release side.
You can replace the main battery with the High Capacity
Battery without data loss because Toshiba Pocket PC
e800/e805 has a rechargeable backup battery. However,
the capacity of the backup battery is limited, therefore
when you change the main battery, attach the new main
battery and switch the Battery Pack Lock to the lock side
as soon as possible. Chapter 2: Basic Skills
How to Prolong Battery Life
  Use the Toshiba Pocket PC e800/e805 with the AC adapter.
Under the following conditions where the power consumption will be
high, please use the AC adapter when:
  Operating while connected to your computer.
  Operating with a storage card or with any other optional equipment.
  In addition,
  Select the short power-off time in the setting menu to shorten the
time the unit will remain on if not used (see "Customize Your
Toshiba Pocket PC" on page 58).
  Turn off the screen light.
  Set the screen brightness to power saving mode and shortening
the light turn-off time (see "Customize Your Toshiba Pocket PC"
on page 58).
  Use your unit with an ambient temperature between 59¢XF and
77¢XF (15¢XC and 25¢XC). This temperature range is the most effective
for the battery.
  When you use the Toshiba Pocket PC e800/e805 in high or low
temperature environments, the operable time is shortened due to
the decrease of the battery capacity.
  You can save power if the wireless communication module is off.
Battery Life
The removable battery has a limited life. Repeated charging/discharging
of the battery gradually decreases operable time. When the operable
time
has been diminished, it is time to replace the removable battery with



a
new one.
  Do not leave the Toshiba Pocket PC e800/e805 in a place of high or
low temperature. It may shorten battery life.
If you have not used the Toshiba Pocket PC e800/e805
for several days, its battery charge level reading may be
inaccurate. Fully recharge the battery before using.
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Battery Charge Level and Stored Data Protection
If the battery charge level becomes extremely low, or the battery becomes
completely discharged, the memory data stored in the Toshiba Pocket
PC
e800/e805 could be lost.
When the low battery status icon or the alarm message appears,
immediately
connect the AC adapter to the Toshiba Pocket PC e800/e805 and
charge the battery.
  The removable battery gradually discharges even if the device is not
being used. When the Toshiba Pocket PC e800/e805 is left for a long
time, the removable battery of the Toshiba Pocket PC e800/e805 may
completely discharge.
  It is recommended to save the Toshiba Pocket PC e800/e805¡¦s memory
data to your computer or to a storage card.
  The manufacturer is not responsible for data change or clearance due
to battery discharge.
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How to Use the Optional Expansion Pack
You can use the Optional Toshiba Expansion Pack (as shown on page 17)
together with the Toshiba Pocket PC e800/e805 to connect to additional
peripherals.
DC-IN SOCKET
BATTERY SWITCH
WIRELESS
CRADLE CONNECTION PORT
OPTIONAL EXPANSION PACK
NOTE
NOTE



Parts and Functions of the Expansion Pack
The Cradle Connection Port allows you to connect the Expansion Pack
to the Cradle.
The RGB (Monitor) Port is a standard 15-pin RGB port for connecting
an
external display device such as a monitor or projector (640 x 480 64K
colors
@ 60Hz and 800 x 600 64K colors @ 60Hz).
The USB Port allows you to connect USB keyboard to the Pocket PC.
Release Button: When pressed, the Release Button releases the
Expansion Pack from the Toshiba Pocket PC e800/e805.
CRADLE CONNECTION
PORT
Only IA-Presenter and IA Screen Mirror (see page 193)
can output the image to the external monitor. Other applications
cannot output the image to the external monitor.
Use only a Microsoft?Pocket PC compatible keyboard.
Chapter 2: Basic Skills
COMMUNICATION SWITCH
(WIRELESS LAN)
RELEASE BUTTON
USB PORT
RGB (MONITOR) PORT
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Connecting the Expansion Pack to the Pocket PC
1. Plug the Guide Pins into the corresponding jacks on the Toshiba
Pocket PC e800/e805. A light click is heard when the Expansion
Pack is locked in place.
NOTE
Releasing the Expansion Pack from the Pocket PC
Press the Release Button on the Expansion Pack and gently remove the
Pack from the Toshiba Pocket PC e800/e805.
How to use the Optional USB Host Cable
The optional USB Host Cable allows you to connect a USB keyboard to
the Pocket PC.
To connect a USB keyboard to the Pocket PC:
1. Turn off the power.



2. Plug the optional USB Host Cable to the Pocket PC.
3. Connect a USB keyboard to the USB Port of the optional USB Host
Cable.
NOTE
NOTE
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The locks are based on foolproof design to help you connect
the Expansion Pack to the Pocket PC with the right
face-up, i.e. the face with the Release Button.
Charging the battery or connect AC adapter if the battery
power is low. You cannot use a USB keyboard if the battery
power is less than 15%.
Use only a Microsoft Pocket PC compatible keyboard.
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Initial Setup
When using the Toshiba Pocket PC e800/e805 for the first time, follow
the initial setup procedures below, after the battery has been charged.
1. Move the battery switch to the ¡§supply¡¨ position. The Toshiba Pocket
PC e800/e805 powers on automatically and the Welcome screen
appears. Tap the screen to start the following setup.
2. Execute touch screen correction.
When the align screen appears, tap the center of the cross target
with the stylus. The next target position changes upon tapping the
target. Five taps completes the positioning correction. The screen
then changes to the Stylus screen.
  If a finger or any other object touches the screen during correction,
the correction will be cancelled. Repeat the correction procedure.
3. Read how to use the stylus.
  Read and understand the stylus operation, and then tap NEXT.
NOTE For more information on stylus operation, See "How to
Use the Stylus" on page 22.
4. Learn the pop-up menu operation.
  Read the on-screen explanation and then follow the instructions.
Display the pop-up menu, and cut and paste the data according
to the screen instructions.
  After you finish the paste operation, this stage is completed. Tap
NEXT.
5. Set the TIME ZONE.



  When tapping the right   mark, the city and the time zone lists
appear. Tap the desired city and time zone.
  When the setup is completed, tap NEXT.
6. To complete the initial setup.
  When the Complete screen appears, the initial setup is completed.
  After tapping the screen, you can use the Toshiba Pocket PC
e800/e805.
NOTE When you tap the Complete screen, the Today screen
appears. For more information on the Today screen, see
"Today Screen" on page 36.
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Inserting a CF II Card
1. Turn off the power.
2. Remove the dummy card.
3. Insert the CF II Card.
To remove a card:
1. Turn off the power.
2. Lightly press down the release button with the stylus. The button
will
pop out. Press down on the release button again. The card will withdraw
slightly from the slot.
3. Pull the card straight up to remove.
RELEASE BUTTON
NOTE Use stylus to release the CF card.
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Inserting an SD Card
1. Turn off the power.
2. Remove the dummy card.
3. Insert the card with its contact surface (metal contact surface)
facing
the back of the Toshiba Pocket PC e800/e805.
4. Press down on the card until it clicks into place.
To remove a card:
1. Turn off the power.
2. Lightly press down the card until a clicking sound is heard. The
card



will pop out slightly from the slot.
3. Pull the card straight up to remove.
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Connecting to a Computer
Before connecting your Toshiba Pocket PC e800/e805 to a computer,
check the following.
  ActiveSync has been installed on your computer. (See Chapter 3.)
  The position of connecting port on the computer may differ according
to the computer type.
To Connect Using the Supplied Cradle:
1. Connect the USB cradle to your computer as shown in the illustration
below.
2. Insert the Pocket PC into the cradle.
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To connect directly using a connection cable:
Connect the Toshiba Pocket PC e800/e805 directly to your computer
using an optional USB Sync Cable.
When the Toshiba Pocket PC e800/e805 is connected to
another device via a USB Sync Cable do not plug the AC
adapter directly into the Pocket PC as this may lead to
interference. Instead, plug the AC adapter into the port
on the USB Client cable connector.
35
Toshiba Pocket PC e800/e805 User’s Guide
Tap to create a new item.
Today Screen
When you turn on your device for the first time each day (or after 4
hours
of inactivity), you’ll see the Today screen. You can also display it
by tapping
and then Today. On the Today screen, you can see at a glance
important information for the day.
Tap to view network status and options.
Tap to change volume or mute all sounds.
Tap and hold to change time format. Tap to go to
a program.



Tap to change date and time.
Tap to change owner information.
Your day at a glance. Tap to
open the associated program.
Tap to disconnect from
ActiveSync.
Following are some of the status icons you may see.
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Meaning Status Icon
Turns all sounds on and off
Main battery is charging
Main battery is low
Main battery is very low
Main battery is full
Connection is active
Connection is inactive
Synchronization is occurring
Notification that one or more instant messages were
received
Notification that one or more email messages were
received
Traffic Monitoring Utility (W-LAN model only)
NOTE If more notification icons need to be displayed than there
is room to display them, the Notification icon, , will display.
Tap the icon to view all notification icons.
Program
You can switch from one program to another by selecting it from the
menu. (You can customize which programs you see on this menu. For
information,
see “Adjusting Settings,?later in this chapter.) To access some
programs,
you’ll need to tap , Programs, and then the program name.
You can also switch to some programs by pressing a program button. Your
device has one or more program buttons located on the front or side
of the
device. The icons on the buttons identify the programs they switch to.
NOTE Some programs have abbreviated labels for check boxes



and drop-down menus. To see the full spelling of an
abbreviated label, tap and hold the stylus on the label.
Drag the stylus off the label so that the command is not
carried out.
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The following table contains a partial list of programs that are on
your
device. Look on the Toshiba Pocket PC Companion CD for additional
programs
that you can install onto your device.
Description Program Icon
ActiveSync Synchronize information between your
device and computer.
Calendar Keep track of your appointments and create
meeting requests.
Keep track of your friends and colleagues. Contacts
Send and receive email messages. Inbox
Pocket Internet Explorer Browse Web and WAP sites, and download
new programs and files from the Internet.
Notes Create handwritten or typed notes, drawings,
and recordings.
Keep track of your tasks. Tasks
Pocket Excel Create new workbooks or view and edit Excel
workbooks created on your computer.
MSN Messenger Send and receive instant messages with your

MSN Messenger contacts.
Pocket Word Create new documents or view and edit Word
documents created on your computer.
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Navigation Bar and Command Bar
The navigation bar is located at the top of the screen. It displays
the active
program and current time, and allows you to switch to programs and close
screens.
Use the command bar at the bottom of the screen to perform tasks in



programs.
The command bar includes menu names, buttons, and the Input
Panel button. To create a new item in the current program, tap New.
To
see the name of a button, tap and hold the stylus on the button. Drag
the
stylus off the button so that the command is not carried out.
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Tap and hold to display the
pop-up menu.
Lift the stylus and tap the
action you want
Tap outside the menu to close
it without performing an action.
Pop-up Menus
With pop-up menus, you can quickly choose an action for an item. For
example, you can use the pop-up menu in the contact list to quickly
delete
a contact, make a copy of a contact, or send an email message to a contact.
The actions in the pop-up menus vary from program to program. To
access a pop-up menu, tap and hold the stylus on the item name that
you
want to perform the action on. When the menu appears, lift the stylus,
and
tap the action you want to perform. Additionally, you can tap anywhere
outside the menu to close the menu without performing an action.
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Notifications
Your device reminds you in a variety of ways when you have something
to
do. You can be notified in any of the following ways:
  A message box appears on the screen.
  A sound, which you can specify, is played.
  A light flashes on your device.
To choose reminder types and sounds for your device, tap and then
Settings. In the Personal tab, tap Sounds & Notifications. The



options you choose here apply throughout the device.
Enter Information on Your Toshiba Pocket
PC
You have several options for entering new information:
  Use the input panel to enter typed text, either by using the soft
keyboard
or other input method.
  Write directly on the screen.
  Draw pictures on the screen.
  Speak into your device microphone to record a message.
  Use MicrosoftR ActiveSyncR to synchronize or copy information from
your computer to your device. For more information on ActiveSync,
see ActiveSync Help on your computer.
Entering Text Using the Input Panel in the VGA Mode
Use the input panel to enter information in any program on your device.
You can either type using the soft keyboard or write using Letter
Recognizer,
Block Recognizer, or Transcriber in VGA mode. In either case, the
characters appear as typed text on the screen.
To show or hide the input panel, tap Input Panel. Tap the arrow next
to
the Input Panel button to see your choices.
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Tapping the CAP key while using the soft keyboard, the lowercase soft
keyboard appears
When you use the input panel, your device anticipates the word you are
typing or writing and displays it above the input panel. When you tap
the
displayed word, it is inserted into your text at the insertion point.
The more
you use your device, the more words it learns to anticipate.
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To change word suggestion options, such as the number
of words suggested at one time, tap , Settings, Personal
tab, Input, and then the Word Completion tab.
To type with the soft keyboard:



1. Tap the arrow and then Keyboard.
NOTE
2. On the soft keyboard that is displayed, tap the keys with your stylus:
NOTE To use larger keys, tap the arrow, Options, select
Keyboard in Input method, and then select Large Keys.
To use Letter Recognizer:
With Letter Recognizer you can write letters using the stylus just as
you
would on paper.
1. Tap the arrow and then Letter Recognizer.
2. Write a letter in the box.
When you write a letter, it is converted to typed text that appears
on the
screen. For specific instructions on using Letter Recognizer, with
Letter
Recognizer open, tap the question mark next to the writing area.
To use Block Recognizer:
With Block Recognizer you can input character strokes using the stylus
that are similar to those used on other devices.
1. Tap the arrow and then Block Recognizer.
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2. Write a letter in the box.
When you write a letter, it is converted to typed text that appears
on the
screen. For specific instructions on using Block Recognizer, with Block
Recognizer open, tap the question mark next to the writing area.
To use Transcriber:
With Transcriber you can write anywhere on the screen using the stylus
just as you would on paper. Unlike Letter Recognizer and Block
Recognizer,
you can write a sentence or more of information. After you finish
writing, pause and let Transcriber change the written characters to
typed
characters.
1. Tap the arrow and then Transcriber.
2. Write anywhere on the screen.
For specific instructions on using Transcriber, with Transcriber open,



tap
the? in the lower, right-hand corner of the screen.
To select typed text:
If you want to edit or format typed text, you must select it first.
?Drag the stylus across the text you want to select.
You can cut, copy, and paste text by tapping and holding the selected
words and then tapping an editing command on the pop-up menu, or by
tapping the command on the Edit menu.
Writing on the Screen
In any program that accepts writing, such as the Notes program, and
in
the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus
to write directly on the screen. Write the way you do on paper. You
can

edit and format what you’ve written and convert the information to text
at a
later time.
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To write on the screen:
?Tap Pen to switch to writing mode. This action displays lines on the
screen to help you write.
Tap the Pen button and use your stylus like a
pen.
NOTE Some programs that accept writing may not have the Pen
button. See the documentation for that program to find out
how to switch to writing mode.
To select writing:
If you want to edit or format writing, you must select it first.
1. Tap and hold the stylus next to the text you want to select until
the
insertion point appears.
2. Without lifting, drag the stylus across the text you want to select.
If you accidentally write on the screen, tap Tools, then Undo and try
again. You can also select text by tapping Pen to deselect it and then
dragging the stylus across the screen.
You can cut, copy, and paste written text in the same way you work with



typed text: tap and hold the selected words and then tap an editing
command
on the pop-up menu, or tap the command on the Edit menu.
To convert writing to text:
?Tap Tools and then Recognize.
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If you want to convert only certain words, select them before tapping
Recognize on the Tools menu (or tap and hold the selected words and
then tap Recognize on the pop-up menu). If a word is not recognized,
it is
left as writing.
The writing is turned into
text.
Select the text you want to convert
and tap Recognize on the pop-up
menu.
If the conversion is incorrect, you can select different words from
a list of
alternates or return to the original writing. To do so, tap and hold
the incorrect
word (tap one word at a time). On the pop-up menu, tap Alternates.
A menu with a list of alternate words appears. Tap the word you want
to
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use, or tap the writing at the top of the menu to return to the original
writing.
Tap to return to your original
writing.
Or, tap the word you want to use.
Tips for getting good recognition:
?Write neatly.
?Write on the lines and draw descenders below the line. Write the cross
of the “t?and apostrophes below the top line so that they are not confused
with the word above. Write periods and commas above the line.
?For better recognition, try increasing the zoom level to 300% using
the



Tools menu.
?Write the letters of a word closely and leave big gaps between words
so that the device can easily tell where words begin and end.
?Hyphenated words, foreign words that use special characters such as
accents, and some punctuation cannot be converted.
?If you add writing to a word to change it (such as changing a ??to
an
?? after you attempt to recognize the word, the writing you add will
not be included if you attempt to recognize the writing again.
Drawing on the Screen
You can draw on the screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you
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select items and how they can be edited. For example, selected drawings
can be resized, while writing cannot.
To create a drawing:
?Cross three ruled lines on your first stroke. A drawing box appears.
Subsequent strokes in or touching the drawing box become part of the
drawing. Drawings that do not cross three ruled lines will be treated
as
writing.
NOTE
48
The drawing box indicates
the boundaries of the
drawing.
You may want to change the zoom level so that you can
more easily work on or view your drawing. Tap Tools and
then a zoom level.
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To select a drawing:
If you want to edit or format a drawing, you must select it first.
?Tap and hold the stylus on the drawing until the selection handle
appears. To select multiple drawings, deselect the Pen button and
then drag to select the drawings you want.
You can cut, copy, and paste selected drawings by tapping and holding
the selected drawing and then tapping an editing command on the pop-up



menu, or by tapping the command on the Edit menu. To resize a drawing,
make sure the Pen button is not selected, and drag a selection handle.
Recording a Message
In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording
a
message. In Calendar, Tasks, and Contacts, you can include a recording
in the Notes tab. In the Notes program, you can either create a standalone
recording or add a recording to an existing note. If you want to add
a recording in a note, open the note first. In the Inbox program, you
can
add a recording to an email message.
To create a recording:
1. If you do not see the Record/Playback toolbar, tap .
2. Hold your mobile device's microphone near your mouth or other
source of sound.
3. Tap and make your recording.
4. Tap when finished. If you are recording in an open note, an icon
will appear in the note. If you are creating a stand-alone recording,
it
will appear in the note list.
NOTE You can quickly create a recording by holding down the
Record hardware button. When you hear the beep, begin
your recording. Release the button when you are finished.
The new recording is stored in the open note or as a
stand-alone recording if no note is open.
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To play a recording, tap the recording icon in the open note or tap
the
recording in the note list.
Indicates an embedded

recording.
Tap to begin
recording.
Tap to show or hide the Recording toolbar.
Using Text to Speech



Text to Speech synthesizes voice, and reads out emails, text files and
text
data on the clipboard. Text to Speech consists of three applications,
Mail
Speech, Text Speech and Speech Settings. Mail Speech displays unread
emails and reads them out.
Text Speech picks up text files in Toshiba Pocket PC e800/e805 and
reads them out. It also reads out text data on clipboard. Speech Settings
arranges the settings of Mail Speech and Text Speech. You can use one
application of Text to Speech at a time. Please exit the current one
to start
another application.
To setup Text to Speech from Companion CD:
1. Make sure your Pocket PC is connected to your computer and that
an ActiveSync connection has been established.
2. Start the Text to Speech installation by running the Setup program.
3. Check your Toshiba Pocket PC e800/e805 screen for any additional
steps required to complete the installation.
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Mail Speech
To start Mail Speech:
1. Open the Inbox, and set the mail account you want to read out
2. Tap Start, Programs, then Mail Speech.
Mail Speech starts reading the message from the header information of
unread email list. As the reading continues, the currently read phrase
is
highlighted.
Account name displays here.
the text.
?Stop: Stops reading the text.
?Exit: Exits Mail Speech.
Selected e-mail text displays here.
3. Tap and hold the selected words to display the pop-up Copy menu.
Select any of the following:
?Play: Starts reading out the text of the selected email.
?Pause: Stops reading. If you tap Play again, continues reading
4. Tap Tools. Select any of the following:



?Refresh: Refreshes the status of the email database.
?Settings: Starts the Speech Settings.
?Exit: Exits the program.
?About: Displays the version information screen.
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NOTE
Test Speech
Text Speech reads a text file and the data stuck on the clip board.
To read out a text file:
1. Tap Start, Programs, then Text Speech.
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If the next mail header is chosen during reading of an
email, it stops the voice synthesis and the reading, then it
starts reading the newly selected mail.
Mail information displayed in the mail header information
area is descending order, that is the older mails are on
the top and the newer mails are shown in the lower area,
by every service.
After all mail is read, the voice service announces, "There
is no more unread file.?
When there is an attached file, the voice service
announces "with attachment". It does not announce the
"TO" or "CC" of a mail header.
While reading an email, DO NOT synchronize your
Toshiba Pocket PC e800/e805 with the PC.
The text may not be displayed correctly depending on the
mailer of the sender. US ASCII (us-ascii) and 8-bit Western
Europe (iso-8859-x) character code are supported. In
case of other codes than the above is used, it may not be
displayed correctly. The text used 8-bit Western Europe
sometimes may not be displayed correctly and the voice
synthesis works incorrectly.
A difference may be between the text displayed by the
mailer of Pocket PC and the text currently displayed by
Mail Speech. To read out the text displayed in mailer of
Pocket PC, copy and paste it into Text Speech to use the



voice synthesis.
This application supports base 64 and quoted-printable
non-encoded. If the text is encoded, it cannot to be displayed.
UUENCODE is not supported. When the text is
longer than 2k bytes, the part over 2k bytes is not read.
2. From the Tools of the command bar, tap Open. The list of the text
files stored in your Pocket PC e800/e805 is displayed.
3. Select any of the following:
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File list.
?Folder: Select the folder from the pull-down menu.
?Cancel: Close the file selection screen and return to the Text
Speech screen.
?Type: Only text file (*.txt) is available.
?File list: Display Name, Folder, Date, Size, Type and Location.
The width for each item can be adjustable. The file to read should
be under \My Documents.
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4. Tap the file you want read. The text is displayed.
5. Select any of the following:
To read the text copied on clipboard:
Copied data on clipboard can be read by Text Speech, including data
from
Pocket Internet Explorer or Pocket Internet Explorer.
1. Within Pocket Internet Explorer, copy the text data to the clipboard.
2. Tap Start, Programs, then Text Speech. If the Text Speech applica-
3. Tap and hold the Text Area, then select Paste from the pop-up
menu. The data on the clipboard is displayed on Text Area. You can
input text directly on Text Area, using the Input Panel.
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T e x t area.
F i l e status.
?Play: Starts reading the text.
?Pause: Stops reading. If you tap Play after Pause, voice synthesis
will start from the position where it was paused.
?Stop: Stops reading. If you tap Play after Stop, it will start from
the beginning of the text.



?Exit: Exits the program.
tion is already opened and a text data is displayed on Text Area, tap
and hold the Text Area, then Clear All from the pop-up menu.
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4. Tap Play.
NOTE You can input text directly in the Text Area, using the Input
Panel The maximum size of a text file or clipboard data to
be read is 32KB. Text Speech begins reading at the cursor
on the text.
Speech Settings
To start Speech Setting, tap Start, Programs, then Speech Settings.
You
can also start Speech Settings by tapping Tools, then Settings on the
Mail Speech or the Text Speech screen.
Reading Tab
Select any of the following:
?Tone: Changes the tone of the voice (default value: 0).
?Speed: Changes the reading out speed (default value: 0).
?Default Value: Reset all values to the default.
?Not read more than 2/3 marks: If selected, the continuous
marks on the text are skipped when reading out. You can define
the skipping case (continuous 2 or 3 marks) from the pull-down
list.
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Reading Tab
  Select a time interval:
reading the following mail.
  Check at least one of the following:
¡E The reading mail turns into a read: Sets the interval time for
¡E Read the name of the sender, Read the subject, Read the
date of receipt, Read the message.
¡E After reading wait for: Sets the time interval for reading the
following
mail. To read the message while this setting is available,
tap the message area within the interval time. Only available
when the check box ¡§Read the message.¡¨ is cleared.
  Default Value: Resets all the values to the default.



O n c e s e l e c t e d ,
t h e s t a t u s o f t h e
r e a d i n g c h a n g e s
f r o m r e a d t o u n r e a d .
A t l e a s t o n e i t e m
m u s t b e s e l e c t e d .
S e t t h e r e a d i n g
i n t e r v a l t i m e h e r e .
Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert preset
or frequently used messages into the text entry area. To insert a
message,
tap My Text and tap a message. Select the message you wish to
edit and make desired change.
NOTE You can add text after inserting a My Text message
before sending it.
To edit a My Text message, tap Tools and then Edit My Text Messages.
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Tap to select a prewritten
message.
Find and Organize Information
The Find feature on your device helps you quickly locate information.
?On the menu, tap Find. Enter the text you want to find, select a
data type, and then tap Go to start the search.
NOTE To quickly find information that is taking up storage space
on your device, select Larger than 64 KB in Type.
You can also use the File Explorer to find files on your device and
to organize
these files into folders.
1. On the menu, tap Programs, and then select File Explorer.
2. Tap My Device, and then tap to open any folder.
3. To change folders, tap My Device, point to your folder, and then
tap
to open. Tapping Name allows you to sort the folders by ascending
or descending order.
4. To create a new folder, tap and hold on the screen, and then select
New Folder from the pop-up window.
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Customize Your Toshiba Pocket PC
NOTE A next to a file name indicates the file is saved on a
storage card.
You can move files in File Explorer by tapping and holding
the item you want to move, and then tapping Cut or
Copy and Paste on the pop-up menu.
You can customize your device by adjusting device settings and
installing
additional software.
Adjusting Settings
You can adjust device settings to suit the way you work. To see available
options, tap , Settings, then the Personal or System tab located at
the bottom of the screen.
You might want to adjust the following:
?Clock, to change the time or to set alarms
?Menus, to customize what appears on the menu, and to enable a
pop-up menu from New
?Owner Information, to enter your contact information
?Password, to limit access to your device
?Power, to maximize battery life
?Today, to customize the look and the information that is displayed
on
the Today screen

Adding or Removing Programs
Programs added to your device at the factory are stored in ROM (readonly
memory). You cannot remove this software, and you’ll never accidentally
lose ROM contents. ROM programs can be updated using special
installation programs with a *.xip extension. All other programs and
data files added to your device after factory installation are stored
in RAM
(random access memory).
You can install any program created for your device, as long as your
device has enough memory. The most popular place to find software for
your device is on the Pocket PC Web site (http://www.microsoft.com/
mobile/pocketpc).
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To add programs using ActiveSync
You’ll need to install the appropriate software for your device on your
desktop computer before installing it on your device.
1. Determine your device and processor type so that you know which
version of the software to install.
Tap and then Settings. On the System tab, tap About. In the
Version tab, make a note of the information in Processor.
2. Download the program to your computer (or insert the CD or disk
that contains the program into your computer). You may see a single
*.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of
files
for different device types and processors. Be sure to select the program
designed for the Toshiba Pocket PC e800/e805 and your
device processor type.
3. Read any installation instructions, Read Me files, or documentation
that comes with the program.
Many programs provide special installation instructions.
4. Connect your device and computer.
5. Double-click the *.exe file.
?If the file is an installer, the installation wizard will begin. Follow
the directions on the screen.
Once the software has been installed on your computer, the
installer will automatically transfer the software to your device.
?If the file is not an installer, you will see an error message stating
that the program is valid but it is designed for a different type of
computer. You will need to move this file to your device. If you
cannot find any installation instructions for the program in the
Read Me file or documentation, use ActiveSync Explore to copy
the program file to the Program Files folder on your device. For
more information on copying files using ActiveSync, see Active-
Sync Help.
Once installation is complete, tap , Programs, and then the program
icon to switch to it.
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To add a program directly from the Internet



1. Determine your device and processor type so that you know which
version of the software to install.
Tap and then Settings. On the System tab, tap About. In the
Version tab, make a note of the information in Processor.
2. Download the program to your device straight from the Internet using
Pocket Internet Explorer. You may see a single *.xip, *.exe or *.zip
file, a Setup.exe file, or several versions of files for different device
types and processors. Be sure to select the program designed for
the Toshiba Pocket PC e800/e805 and your device processor type.
3. Read any installation instructions, Read Me files, or documentation
that comes with the program. Many programs provide special installation
instructions.
4. Tap the file, such as a *.xip or *.exe file. The installation wizard
will
begin. Follow the directions on the screen.
To add a program to the Start menu
Tap , Settings, Menus, the Start Menu tab, and then the check box for
the program. If you do not see the program listed, you can either use
File
Explorer on the device to move the program to the Start Menu folder,
or
use ActiveSync on the computer to create a shortcut to the program and
place the shortcut in the Start Menu folder.
?Using File Explorer on the device: Tap , Programs, File
Explorer, and locate the program (tap the folder list, labeled My
Documents
by default, and then Local Device to see a list of all folders
on the device). Tap and hold the program and tap Cut on the pop-up
menu. Open the Start Menu folder located in the Windows folder, tap
and hold a blank area of the window, and tap Paste on the pop-up
menu. The program will now appear on the menu. For more information
on using File Explorer, see “Find and Organize Information,?earlier
in this chapter.
?Using ActiveSync on the computer: Use the Explorer in ActiveSync
to explore your device files and locate the program. Right-click the
program, and then click Create Shortcut. Move the shortcut to the
Start Menu folder in the Windows folder. The shortcut now appears on
the menu. For more information, see ActiveSync Help.



To remove programs
?Tap and then Settings. On the System tab, tap Remove Programs.
If the program does not appear in the list of installed programs, use
File
Explorer on your device to locate the program, tap and hold the program,
and then tap Delete on the pop-up menu.
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Setting Password
You can protect data or settings from a third person by setting a password
which is requested when turning power on.
1. Tap and then Settings. On the Personal tab, tap Password.
2. Select the type of password you would like to use.
3. Enter a password and tap OK.
4. Tap YES on the confirmation screen. The password is saved and the
screen returns to the Personal tab screen
If you tap YES on the confirmation screen to return to the Personal
tab
screen, it becomes necessary to enter the password even for displaying
the Password setting screen.
In case you forget the password, it is necessary to initialize the Pocket
PC. Please note that when initialization is executed, data or settings
stored in the Pocket PC are all deleted.
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To Set Screen Light
You can set the screen brightness for better sight according to a place
of
use. You can also set the time that elapses until the screen light turns
off
automatically after the last operation.
1. Tap and then Settings. On the System tab, tap Screen Light.
2. Set the Screen Light on battery power.
-or set the screen light on External power.
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3. Set the Brightness level.
4. When finished, tap OK to return to the System tab screen.
Setting Power



1. Tap and then Settings. On the System tab, tap Power.
Options are 1, 2,3,4, and 5
minutes until device will turn off
in battery-powered mode if not
used. Check box to left to
engage this feature.
Options are 1, 2, 5,10, 15, and
30 minutes until device will turn
off in external-powered mode if
not used. Check box to left to
engage this feature.
2. Set the Power.
You can set to confirm the battery remaining power and the time that
elapses until the power turns off after the last operation.
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Tap and set the screen light g
brightness level by move the cursor g y
up or down. If Power Save is
activated, the screen light turns
o f f .
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3. Select the Option tab to adjust when battery alarm will come on,
and
to enable/disable Record and Program buttons wake up.
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4. Select CPU speed tab to set the CPU performance. To conserve
battery power, but decrease performance, select 200 MHz.
Tap Apply to change the setting, then the confirmation screen is
displayed.
If you tap Yes, your LCD screen will become black and come back in a
few seconds, and then the setting has changed. If you tap No, the setting
has not changed.
5. When finished, tap OK to return to the System tab screen.
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Setting Memory



You can adjust the data storing memory and the program running memory.
You can also confirm the free space of a storage card and so on.
Memory for the Pocket PC is managed automatically.
To change Memory allocation:
1. Tap and then Settings. On the System tab, tap Memory to
display the Memory setting screen.
2. Drag the knob left to right to adjust the memory allocation between
Storage and Program.
3. When finished, tap OK to return to the System tab screen.
To confirm usage status of a storage card:
1. Tap Storage card tab on the Memory setting screen.
2. When finished, tap OK to return to the System tab screen.
To release memory:
If memory is running short of its capacity, i.e., you will receive an
error
message display, the following methods are available to release the
memory:
Transfer data to a storage card and the like and delete them from the
Pocket PC, delete unnecessary files, quit a program in execution, and/or
delete a program not in use.
For more information on detailed operation method or the memory
release method other than the above, see online help.
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NOTE
Flash ROM Disk (NAND Flash Memory)
The Flash ROM Disk (NAND Flash Memory) contains the built-in storage
for the Pocket PC.
Data, files or programs can be stored on the Flash ROM Disk from the
following
sources: File Explorer, Pocket Word, Pocket Excel, Notes of
Pocket Outlook, and DataBackup.
Data can be accessed on the Flash ROM Disk by using File Explorer.
1. On the Start menu, tap Programs, and then File Explorer.
2. Open Local Device folder, and then tap Flash ROM Disk.
To confirm the memory available on the Flash ROM Disk, do the following:
1. On the Start menu, tap Settings, System tab, and then Memory.
2. Tap the Storage Card tab, and then select Flash ROM Disk.



To store data from Pocket Word, Pocket Excel or Notes of Pocket Outlook,
open the application and do the following:
1. Select a location for storage by tapping Tools, Options, and then
select either CF card, SD Card or Flash ROM Disk.
2. Tap OK.
When accessing the data on the Flash ROM Disk, DO
NOT turn off the power or reset the Pocket PC.
To store attachments in Inbox of Pocket Outlook, open the
application and then Tools, Options, Storage Tab. Select
Store attachments on storage card. This will store the
attachments on the Flash ROM Disk.
Data stored on the Flash ROM Disk are not backed up. See "Making a
Backup" on page 185 for information on how to make a backup of data
on
the Flash ROM Disk. Periodic backups of data stored on the Flash ROM
Disk is recommended.
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Setting Advanced Sounds
This program allows you to adjust the volume of the built-in speaker
and
headphone speaker on your Pocket PC. To adjust the system volume, tap
Start, Settings, Personal tab, Sounds and Notifications.
1. Tap Start and then Settings. On the System tab, tap Advanced
Sounds.
2. Select the Built-in tab and adjust the Volume of the built-in speaker.
3. If using headphones, select the Headphone tab and make adjustments.
Setting Microphone
This program sets the Automatic Gain Control (AGC) for the built-in
microphone.
1. Tap and then Settings. On the System tab, tap Microphone.
2. Select the box below for automatic gain control or leave the box
clear
for manual control.
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daytime
Ta p to select the city.



Setting the World Clock
World Clock displays the time and date of multiple cities in a screen.
You
can select the cities easily, by tapping the map or pull-down list.
Home
nighttime
Visit1
Visit2
DST (Daylight Saving Time) is applied automatically.
1. Tap Tools.
2. Select any of the following:
?Select: A zoomed map is displayed on the screen. You can
select a city and assign to Home or others, by tapping on the
map. (For detail, refer to the next page.)
?Alarm: Alarm setting is displayed. You can set alarm, or arrange
the detail settings.
?About: The version information is displayed.
NOTE
To select the city from a zoomed map:
1. Tap Select from Tools menu.
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2. Select the city by tapping on the zoomed map.
3. Select Home, Visit1 or Visit2 from the pull-down list.
4. Tap OK.
Toshiba Voice Recorder (TVR)
The Toshiba Voice Recorder (TVR) is a media player for both desktop
and
Pocket PCs. TVR offers a flexible way to record your voice as a .wav
file.
To set the TVR options:
1. Tap File, and then Options.
- - - T O S H I B A V o i c e R e c o r d e r
2. Select Assign to Record button.
3. Confirm that the document path is /My Documents.
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the selected city is



displayed.
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To use TVR to record:
1. Tap the record button, PDA starts and immediately records a clip.
2. Tap on record again and stop recording. File names are listed as
"TVRMMDDYYYYHHMMSS.wav¡¨. These are in the date (DD/MM/
YEAR HH:MM:SS), length (HH:MM:SS) and quality (LP/HQ) format.
3. You can toggle between time recorded and time available to record
given storage in current media at the current record quality level.
To play a file from the TVR:
1. Tap on the clip name.
2. Tap Stop button to stop.
3. Scroll with jog-dial and click in the action button to play the file.
Tap
Stop button to stop.
4. You can tap on the time being displayed and toggle between time
played and time left to play to display left time.
NOTE Clips recorded on the TVR can be played through
Microsoft Windows Media Player on computers with either
Windows 2000 and Windows XP operating systems.
Need actual screen shot
The TVR offers several convenient features:
  AGC: If the Automatic Gain Control (AGC) is enabled, the slider is
disabled.
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  Assign Record button: This assigns the TVR to the record button
  Select clips location: Open a small window with the top directory tree
of the PDA (including storage cards).
  Single tap to play.
  Combo slider/progress bar control:
¡E Playback: The slider advances to the end of clip at the same time
as progress bar. You can move the slider to advance/rewind playback.
NOTE Playback can only be done at certain time increments, 1-2
seconds, (e.g., until the end of the file).
¡E Recording: The slider is fixed at the end position (right). The
progress bar shows the time left in the current storage device
(PDA, SD, etc.) at the current quality level.



  Microphone gain slider and combo box are available to choose pre-
set
gain settings and one check box to enable/disable the AGC.
  The Record button, when it is mapped to the TVR, will start the TVR
and immediately start recording. To stop recording, press the same
button again (no need to keep the button pressed).
Using Voice Command
With Voice Command, you can operate Pocket PC ¡§hands free¡¨ without
tapping or pressing buttons on your Toshiba Pocket PC e800/e805.
The Voice Command application has 3 components:
  Global Command: the command always available
  User Command: the command that users can assign freely, always
available.
  Command for each application: Command available only for the
foreground windows.
Installing the Voice Command
1. Make sure your Toshiba Pocket PC e800/e805 is connected to your
computer and that an ActiveSync connection has been established.
2. Start the Voice Command installation by running the Setup program.
3. After the program is installed successfully, a message displays to
inform you that the application has been allocated to the program
button 5 (recording button) automatically.
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4. After installation, the system requires resetting.
NOTE The Voice Command cannot “read?without the Toshiba
Speech System installed. Installation of the Toshiba
Speech System is highly recommended.
Once Voice Command is installed on your Toshiba Pocket
PC e800/e805, the program button 5 (recording button at
initial setting) is “assigned?and recording with program
button 5 is no longer available. If you want to use program
button 5 for recording while the Voice Command is
assigned, change the button assignment by tapping Start,
Settings, and then Buttons.
Setting Up Voice Command
Once installed on your Toshiba Pocket PC e800/e805, the Voice Command
Settings icon is displayed on Today screen. Tap this icon to launch



the Voice Command Settings application.
T a p t o launch
Voice Command
Settings.
Global Command
1. Press the recording button and release immediately. The Voice Command
starts. Wait for a notification sound to start speaking.
2. Say one of the available voice commands. For example, to launch
Inbox, say "run Inbox." When the command is successfully recog-
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nized, a confirmation tone sounds, and the Inbox screen appears. If
the command is not recognized, a rejection tone sounds and the
screen does not change.
User Command
You can define voice commands on Command Settings.
There are two kinds of commands:
?Commands to insert texts
?Commands to launch applications.
To use the commands to insert texts:
1. On the User Commands tab in the Voice Command Settings, define
a phrase you like to a command. For example, define “Thank you for
your email about “for the command insert text one.
2. Open the Inbox, then tap New from the command bar. At the creating
the message screen, say “insert text one.?The “Thank you for
your email about “is displayed on the screen.
To use the commands to launch applications:
1. On the User Commands tab in the Voice Command Settings, assign
an application you like to a command. For example, assign Solitaire
to the command run program one.
2. Say "run program one." The Solitaire screen is displayed.
NOTE When you say an undefined command, nothing happens
even if the command is recognized.
Using Voice Command for Each Application
For example, you can use voice commands in the Calendar application.
1. With the Calendar open, say "Very next appointment." The listing
mode screen appears, and it starts reading out very next appointment.
You can display the screen also by saying, "Move to listing



mode." For detail of the command list, refer to the Commands tab on
the Voice Command Settings.
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Tap to stop reading.
NOTE
Voice Command Settings
2. In listing mode, voice command for Calendar is active to current
focused appointment. For example, saying "read subject" reads the
subject of current focused appointment.
The target term of appointment is one month before to
one month after, based on current time.
For other commands, you can check the command from the Commands
tab of the Voice Command Settings.
You can check the voice command list or arrange the settings of voice
command. To start the Voice Command Settings, tap Start, Programs,
and then Voice Command Settings.
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Checking the Command List
On the Commands tab, you can select the all commands installed.
Displays the information for the
selected command.
Tap Tools, and then About to
display the version information
of the Voice Command Settings.
Arrange the Recognition Level of Voice Command
1. Tap Settings on the Voice Command Settings screen.
2. Set the recognition level as required. The higher level of recognition
that is set, the more sensitive the program is to the nuances of your
voice, and it makes it easier for your Toshiba Pocket PC e800/e805
to recognize the command. On the other hand, setting a higher level
of recognition may decrease voice recognition within noisy
environments.
It is recommended to set lower level within noisy environments.
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Tap and select the



recognition level
(0 to 5).
To define the action for a User Command:
1. Tap User Command tab on the Voice Command Settings screen.
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To define text for the command:
1. Tap and hold the command insert text xxx, then select Edit.
Tap to clear the action
that you defined for the
command.
NOTE
You can only clear the action for the command. The command
is not deleted.
2. Input the text you want to define at the text area. For example,
input
“Thank you for your email about. “Tap OK.
To assign a program to the command:
1. Tap and hold the command run program xxx, then select Edit.
2. Select the application you want to assign by tapping the Browse.
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3. Tap OK.
Using ConfigFree?
ConfigFree?is a set of utilities used for configuring networks that
use
both wired and wireless network devices. These utilities include the
following:
?ConfigFree Launcher?The ConfigFree Launcher utility is used as a
shortcut to open ConfigFree utilities.
?Search for Wireless Devices?This utility displays the available
Access Point and 802.11 ad hoc networks.
?Connectivity Doctor ?The Connectivity Doctor utility is used to help
fix networking problems with your Pocket PC.
?Profile Settings ?The Profiles utility is used to enable a faster and
more efficient network configuration. Multiple profiles can be created
Starting ConfigFree
To start ConfigFree:
for various network configurations.



1. Tap Start, Program, then ConfigFree.
2. Tap the ConfigFree utility you want.
Chapter 2: Basic Skills
Enter the parameter
specific to the program.
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ConfigFree Launcher
ConfigFree Launcher registers as an icon on the command bar at the bottom
of Today screen. You can switch to any ConfigFree utility by using
ConfigFree Launcher. A shortcut to the network configuration of your
operating system is also provided. Tap the icon to display a list of
profiles.
Profile Settings
Profile Settings enable a faster and more efficient network
configuration.
The network configuration that you create by this feature is managed
as a
profile. When you select a profile created using this feature, the
network
configuration of the PDA switches to the network configuration of that
profile.
Search for Wireless Devices
Search for Wireless Devices displays the available Access Point and
802.11 ad hoc networks visually. You can confirm these devices around
you easily.
Connectivity Doctor
Connectivity Doctor can help to fix networking problems that occur with
your pocket PC. Use this feature when you encounter a networking problem.
VQ-Select Utility
Using the VQ-Select utility, you can change the screen display mode
from
Video Graphics Array (VGA), which uses 320 x 240 pixels, to Quarter
Video Graphics Array (QVGA), which uses 240 x 320 pixels. The default
mode is VGA.
NOTE
80
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before changing the screen display mode.
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To change screen display modes
1. Tap Start, then VQ-Select.
A reset dialog warning box displays.
2. Tap OK.
3. Set the screen display mode you want (VGA or QVGA) and then
restart the device. When the Toshiba Pocket PC e800/e805 restarts,
your selected mode appears.
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Viewing menus in VGA mode
You can view system menus in VGA mode by tapping the VQ-Select setting,
as shown in the following screen.
Toshiba IP Phone for Pocket PC
Toshiba IP Phone for Pocket PC is an IP Phone utility that lets you:
?Call an IP Phone (VLI Gphone, Toshiba IP Phone)
?Call a phone
?Use answering machine functions on your Toshiba Pocket PC e800/
e805
?Check your buddies' current status or notify your buddies of your
current
status (offline, online, busy or away)
?Send and receive instant messages while you're talking
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Sign-up
If you sign up VLI Gphone Buddy Service, you can use all the functions
of
Toshiba IP Phone for Pocket PC shown here. You can find the Gphone
Buddy Service sign-up page at http://www.gphoneonline.com.
Without the VLI Gphone Buddy Service, all you can do is to call an IP
Phone by IP address answer a phone call or hang up a phone call.
Launching an application
1. Tap Start, Program, then Toshiba IP Phone.
2. When you launch it for the first time, enter your G-Number, password,
and name. If you select “Automatic sign-in,?Toshiba IP Phone
for Pocket PC signs in automatically next time you launch it.
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3. Tap Sign in. Toshiba IP Phone for Pocket PC displays the following
information:
  Date, Time
  Phone call state (talk times, if connected)
  Your party 's name
  Wireless link quality (the number of bars by the antenna icon)
  Good: Three
  Not bad: Two
  Poor: One

  No wireless link: Zero
  The number of new voice mail stored in your Toshiba IP Phone
for Pocket PC.
  Your status (Online, Offline, Busy or Away)
Calling an IP phone
To call an IP phone:
1. Tap Call.
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2. Tap the List tab if you use your buddy list. You can also tap the
Icon
tab if you use your buddy icons.
3. Tap a buddy.
4. Tap Connect.
Icon view List view
There are four buddy statuses shown below:
List view/Icon view Status
Online
Off line
Busy
Away
Calling a phone
To call a phone:
1. Tap Phone, and enter the phone number.
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2. Tap Connect.
NOTE When call is not idle, your current status becomes Busy.
Calling a phone using telephone directory
To call a phone using telephone directory:
1. Tap Phone.
2. Tap Telephone Directory.
3. Tap a contact on your telephone directory.
4. Tap Connect.
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Answering a call
To answer a call while hearing a phone ring, tap Call.
NOTE When call is not idle, your current status becomes Busy.
Answering a call automatically
Toshiba IP Phone can answer a call automatically after answering timer
has expired. You can configure whether you activate this function or
not.
When you activate this function, you can also customize the value of
answering timer. The default value of answering timer is 10 (seconds).
The length of answering message is less than or equal to 20 seconds.
You can configure answering message on the condition shown in
"Answering message audio file" on page 96.
Your calling party can record their voice message after hearing
answering
message. The length of recorded message is less than or equal to 20
seconds.
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Holding a call
To hold a call, tap Hold. Once the call is on hold, the Hold button
turns
into a Talk button. While holding a call shown below, if you tap Talk,
you
can talk again.
Hanging up
To hang up, tap Hang up.
Redialing using outgoing call history
You can redial using outgoing call history. You can configure the number



of outgoing call history stored at the same time. The default value
is 20. If
it exceeds the limit, the oldest outgoing call history is deleted.
To redial using outgoing call history:
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1. Tap Call history.
2. Tap the Outgoing tab.
3. Select an outgoing call history.
4. Tap Connect.
Calling back using incoming call history
You can call back using incoming call history. You can configure the
number
of incoming call history stored at the same time. The default value
is
20. If it exceeds the limit, the oldest incoming call history is deleted
whether it has voicemail message or not.
To call back using incoming call history:
1. Tap Call history
2. Tap the Incoming tab.
3. Select an incoming call history.
Chapter 2: Basic Skills
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4. Tap Connect.
Muting microphone
To mute the microphone, tap Mute. To restore the microphone, tap Mute
again.
Reducing acoustic echo
If you get an echo while speaking, use headphones. Acoustic echoes are
caused by the microphone’s close location your speaker. If you activate
the voice switch function, you can reduce this acoustic echo as well.
90
Chapter 2: Basic Skills
To activate voice switch function while you're talking, tap VSW.To
cancel
this function, tap VSW again.
Adding a contact to your buddy list
To add a contact: to your buddy list:



1. Tap Call to open your buddy list.
2. Tap the List tab if you use your buddy list. You can tap Icon tab
if you
use your buddy icons.
3. Tap Edit, then tap Add.
4. Enter the name and G-Number (these are required fields). Other
fields, such as Email and whether it is Toshiba IP Phone or not, are
optional.
5. Tap Save.
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Modifying a contact in your buddy list
To modify a contact: information in your buddy list:
1. Tap Call to open your buddy list.
2. Tap the List tab if you use your buddy list. You can tap Icon tab
if you
use your buddy icons.
3. Tap Edit.
4. Choose a contact.
5. Tap Modify
6. Enter the name and G-Number (these are required fields). Other
fields, such as Email and whether it is Toshiba IP Phone or not, are
optional.
7. Tap Save.
Removing a contact from your buddy list
To remove a contact from your buddy list:
1. Tap Call to open your buddy list.
2. Tap the List tab if you use your buddy list. You can tap the Icon
tab if
you use your buddy icons.
3. Tap Edit
4. Choose a contact.
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5. Tap Delete.
Playing back a voicemail
To play back a voicemail:
1. Tap Call history.
2. Tap the Incoming tab.



3. Select an incoming call history with voicemail button.
4. Tap Play back.
5. Start playing back a voicemail by using Voice Recorder which has
been executed automatically.
The green voicemail button means you've already listened to the
voice message, and the red voicemail button means you've not
listened to the voice message yet.
Chapter 2: Basic Skills
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Instant messaging (IM)
While you connect to another Toshiba IP Phone user by making an IP
phone call, you can send and receive instant message each other.
To start instant messaging:
1. Call another Toshiba IP phone user and wait to have the call
answered.
2. Tap IM after the call is connected.
3. Type your message in the second text box directly above the Send,
Clear and Exit buttons.
4. Tap Send.

All the messages including yours are displayed
in the first message box from the
top.
Type your messages here.
Presence Service (PS)
You can notify your buddies of your current status
1. Tap PS.
2. Select your new status.
3. Tap Notify if you notify your buddies of your new status.
Tap one of these status conditions.
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Calling an IP phone by its IP address
If you tap IP Connect at the first dialog after launching Toshiba IP
Phone
for Pocket PC, you can call an IP phone by its IP address.
1. Tap IP Connect at the first dialog after launching Toshiba IP Phone



for Pocket PC
2. Tap Call, and enter the IP address.
3. Tap Connect.
If you sign up VLI Gphone Buddy Service, you can use all the functions
of
Toshiba IP phone for Pocket PC shown here. Without the VLI Gphone
Buddy Service, you are limited to calling an IP phone by its IP address,
answering and hanging up on a call.
Configuring Toshiba IP Phone for Pocket PC
You can configure the following by tapping Configure:
Ringer audio file
You can configure ringer audio file. You can choose one of ringer audio
files that Toshiba IP phone for Pocket PC has. The default ringer audio
file
is defringer.wav. You can also select a ringer audio file of your own
creation.
NOTE When creating your own ringer audio files, make sure that
it is a 16-bit, 8 KHz, PCM recorded monophonic file (not
stereophonic), and no more than 30 seconds in length.
Automatic answer
You can configure your Toshiba Pocket PC e800/e805 to automatically
answer.
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Answering timer
When you activate Automatic answer function, you can also customize
the value of answering timer. The answering default value is 20
(seconds);
the range must be from 10 (seconds) to 30 (seconds).
Answering message audio file
You can configure answering message file (wav file) to a calling party
in
the case of automatic answer. You can also select an audio file of your
own creation.
NOTE When creating your own answering message audio files,
make sure that it is a 16-bit, 8 KHz, PCM recorded monophonic
file (not stereophonic), and no more than 20 seconds
in length.



Audio file while holding a call
You can configure an audio file to play for your party while the call
is holding.
You can choose one of the many available audio files that came standard
with Toshiba IP Phone for Pocket PC. The default audio file is
defrhold.wav. You can also select an audio file of your own creation.
NOTE When creating your own answering message audio files,
make sure that it is a 16-bit, 8 KHz, PCM recorded monophonic
file (not stereophonic), and no more than 30 seconds
in length.
The maximum number of outgoing call history
You can configure the maximum number of outgoing call history stored
at
the same time. The maximum number default value is 10; the value must
be 10 or 20.
The maximum number of incoming call history
You can configure the maximum number of incoming call history stored
at
the same time. The maximum number default value is 10; the value must
be 10 or 20.
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Chapter 3:
Microsoft ActiveSync
Using ActiveSync, you can synchronize information between your device
and PC or server. Synchronization compares the data on your device with
your PC and updates both computers with the most recent information.
For example:
?Keep Pocket Outlook data up-to-date by synchronizing your device
with Microsoft Outlook data on your PC.
?Synchronize Microsoft Word and Microsoft Excel files between your
device and desktop computer.
Your files are automatically converted to the correct format.
By default, ActiveSync does not automatically synchronize
all types of information. Use ActiveSync options to
turn synchronization on and off for specific information



types.
With ActiveSync, you can also:
?Change synchronization settings and synchronization schedule.
?Copy files between your device and PC.
?Back up and restore device information.
?Add and remove programs on your device.
Before you begin synchronization, install ActiveSync on your PC from
the
Toshiba Pocket PC Companion CD. For more information on installing
ActiveSync, see your Quick Start card. ActiveSync is already installed
on
your device.
After installation is complete, the ActiveSync Setup Wizard helps you
connect
your Pocket PC to your PC, set up a partnership so you can synchronize
information between your device and your desktop computer, and
customize your synchronization settings. Your first synchronization
process
will automatically begin when you finish using the wizard.
After your first synchronization, take a look at Calendar, Contacts,
and
Tasks on your device. You’ll notice that information you’ve stored in
Microsoft Outlook on your PC has been copied to your device, and you
didn’t have to type a word. Disconnect your device from your PC and
you’re ready to go!
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Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device. To switch
to
ActiveSync on your device, tap , and then tap ActiveSync.
For information about using ActiveSync on your PC, start ActiveSync
on
your PC, and then see ActiveSync Help.
For more information about ActiveSync on your device, switch to Active-
Sync, tap , and then tap Help.
View connection
status.



Tap to connect and
synchronize.
Tap to stop synchronization.
Tap to synchronize via IR or
change synchronization
settings.
Change the synchronization schedule
Using ActiveSync, you can schedule synchronization of your device on
two separate
schedules. Use the peak times schedule to synchronize during working
hours or other times you experience higher mail volumes. Use the off-peak
schedule to synchronize during times when you experience lower mail
volumes.
In ActiveSync on the device, tap Tools, Options, then select the Mobile
Schedule tab.
1. To synchronize periodically during peak times, select the frequency
of synchronization in the During peak times, sync list.
2. To synchronize periodically during off-peak times, select the
frequency
of synchronization in the During off-peak times, sync list.
3. To set the days and hours for peak times, tap Peak Times.
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Chapter 4:
Microsoft Pocket Outlook
Microsoft?Pocket Outlook includes Calendar, Contacts, Tasks, Inbox,
and
Notes. You can use these programs individually or together. For example,
email addresses stored in Contacts can be used to address email messages
in Inbox.
Using ActiveSync?you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your device. You
can also synchronize this information directly with a Microsoft
Exchange
server. Each time you synchronize, ActiveSync compares the changes
you made on your device and desktop computer or server and updates
both computers with the latest information. For information on using
ActiveSync, see ActiveSync Help on the desktop computer.



menu. You can switch to any of these programs by tapping them on the
Calendar: Scheduling Appointments and
Meetings
Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month and Year) and set Calendar to remind you of
appointments with a sound or other method.
NOTE You can customize the Calendar display, such as changing
the first day of the week, by tapping Options on the
Tools menu.
To create an appointment:
1. If you are in Day or Week view, tap the desired date and time for
the
appointment.
2. Tap New.
3. Using the input panel, enter a description and a location. Tap first
to
select the field. You can also tap and select available, predefined
text
or locations.
4. If needed, tap the date and time to change them.
5. Enter other desired information. You will need to hide the input
panel
to see all available fields.
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6. To add notes, tap the Notes tab. You can enter text, draw maps, or
create directions or recordings. For more information on creating
notes, see "Notes: Capturing Thoughts and Ideas" on page 103.
7. When finished, tap OK to return to the calendar (the appointment
is
automatically saved).
NOTE If you select Remind me in an appointment, your device
will remind you according to the options you have set.
Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed.
To change the appointment, tap Edit on the command bar.
Creating Meeting Requests



You can use Calendar to set up meetings with users of Outlook or Pocket
Outlook. The meeting request will be created automatically and sent
either when you synchronize Inbox or when you connect to your email
server. Indicate how you want meeting requests sent by tapping Tools
and then Options. If you send and receive email messages through
ActiveSync, select ActiveSync.
To schedule a meeting:
1. Create an appointment by tapping New.
2. In the appointment details, hide the input panel, and then tap
Attendees.
3. From the list of email addresses you’ve entered in Contacts, select
the meeting attendees.
The meeting notice is created automatically and placed in the Outbox
folder. For more information on sending and receiving meeting requests,
see Calendar Help and Inbox Help on the device.
Contacts: Tracking Friends and Colleagues
Contacts gives you quick and easy access to a list of your friends and
colleagues.
Using the device infrared (IR) port, you can quickly share Contacts
information with other device users.
NOTE To change the way information is displayed in the list, tap
Tools and then Options.
101
Toshiba Pocket PC e800/e805 User’s Guide
To find a contact:
1. Tap All Contacts to select the category of contacts you want displayed

in the list.
2. Tap Find a name and enter of a name to quickly find it in the list.
3. Tap the screen to see additional phone numbers and email address
for
the contact.
4. Tap on the contact to display or edit the contact details.
5. Tap and hold on the contact to display a pop-up menu of actions.
To create a contact:
1. Tap New.
2. Using the input panel, enter a name and other contact information.
You will need to scroll down to see all available fields (use the scroll



box or scroll arrows).
3. To assign the contact to a category, scroll to and tap Categories
and
select a category from the list. In the contact list, you can display
contacts by category.
4. To add notes, tap the Notes tab. You can enter text, draw maps, or
create directions or recordings. For more information on creating
notes, see "Notes: Capturing Thoughts and Ideas" on page 103.
5. When finished, tap OK to return to the contact list.
Finding a contact
There are four ways to find a contact:
?Tap , then Find, enter the contact name (first, last, or middle),
phone number, or address, select Contacts for the type, and then tap
Go.
?From Contacts, start typing a contact name until you see it displayed
on the screen. To show all contacts again, tap the text box at the top
of
the screen and clear the text, or tap the arrow icon to the right of
the
text box.
?In the contact list, tap the category list (labeled All Contacts by
default) and tap the category to which you've assigned a contact. To
show all contacts again, select All Contacts.
?To view the names of companies your contacts work for, in the contact
list, tap View, then By Company. The number of contacts that work for
that company will be displayed to the right of the company name.
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Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.
To change the contact information, tap Edit and make the changes.
Tasks: Keeping a To Do List
Use Tasks to keep track of things you need to do.
1. Tap All Tasks to select the category of tasks you want displayed.
2. Tap the task to display or edit. Tapping Priority allows you to sort
the
folders by ascending or descending order.
NOTE To change the way information is displayed in the list, tap



Tools and then Options.
To create a task:
1. Tap New.
2. Using the input panel, enter a description.
3. You can enter a start date and due date or enter other information
by
first tapping the field. If the input panel is open, you will need to
hide
it to see all available fields.
4. To assign the task to a category, tap Categories and select a category
from the list. In the task list, you can display tasks by category.
5. To add notes, tap the Notes tab. You can enter text, draw maps, or
create directions or recordings. For more information on creating
notes, see "Notes: Capturing Thoughts and Ideas" on page 103.
6. When finished, tap OK to return to the task list.
NOTE To quickly create a task with only a subject, tap Entry Bar
on the Tools menu. Then, tap Tap here to add a new
task and enter your task information.
Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed.
To
change the task, tap Edit and make the changes.
Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers
with Notes. You can create a written note or a recording. You can
also include a recording in a note. If a note is open when you create
the
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recording, it will be included in the note as an icon. If the note list
is displayed,
it will be created as a stand-alone recording.
Tap to change the sort order p

of the list.
Tap to open a note or play a
recording.
Tap and hold to display a pop-up p



menu of actions.
Tap to record.
Tap to show or hide the
Recording toolbar.
Tap to create a new item.
To create a note:
1. Tap New.
2. Create your note by writing, drawing, typing, and recording. For
more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see "Notes: Capturing Thoughts
and Ideas" on page 103.
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Tap to return to the note list
( the note is saved automatically ).
Tap to show or hide the input panel.
Tap to write on the screen.
Tap to add a recording to the note.
Inbox: Sending and Receiving Email Messages
Use Inbox to send and receive email messages in either of these ways:
?Synchronize email messages with Microsoft Exchange or Microsoft
Outlook on your PC.
?Send and receive email messages by connecting directly to an email
server through an Internet Service Provider (ISP) or a network.
Synchronizing Email Messages
Email messages can be synchronized through a general synchronization
process. You will need to enable Inbox synchronization in ActiveSync.
For
information on enabling Inbox synchronization, see ActiveSync Help on
the PC.
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During synchronization:
?Messages are copied from the Inbox folder on your PC or Exchange
server to the Inbox folder on your device. By default, you'll receive
messages from the last three days only, the first 100 lines of each
new



message, and file attachments of less than 100 KB in size.
?Messages in the Outbox folder on your device are transferred to
Exchange or Outlook and then sent from those programs.
?The messages on the two computers are linked. When you delete a
message on your device, it's deleted from your PC the next time you
synchronize.
?Messages in subfolders or other email folders in Outlook are
synchronized
only if they have been selected for synchronization in Active-
Sync.
Using the Message List
Messages you receive are displayed in the message list. By default,
the
most recently received messages are displayed first in the list.
To read your messages:
1. Tap Inbox to select the service and folder you want to display.
2. Tap the message to open. Tap and hold on the message to display a
3. Tapping Received Date allows you to sort the messages by ascend-
4. To connect, send and receive email, tap the Send/Receive icon on
5. To connect to a selected account, tap the Account icon on the compop-
up menu of actions.
ing or descending order
the command bar.
mand bar.
NOTE Unread messages are displayed in bold. When multiple
messages appear, use the scroll arrows on the command
bar to view the previous or next message.
To respond to a received message:
1. To reply to or forward the selected email, tap the Reply icon on
the
command bar.
2. Tap the OK to return to the message list.
NOTE To delete a message, tap the Delete E-mail icon on the
command bar.
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Tap to show or hide the co
header.



Composing Messages
To compose a new message:
1. In the message list, tap New.
2. In the To field, enter the email address of one or more recipients,
separating them with a semicolon, or select a name from the contact
list by tapping Address Book. All email addresses entered in the
email fields in Contacts appear in the Address Book.
Tap to send the message.
.
Tap to show/hide the recording toolbar.
Tap to display the Address Book.
Tap to insert common messages.
3. Compose your message. To enter preset or frequently used messages,
tap My Text and select a message.
4. Tap Send when you’ve finished the message. If you are working
offline, the message is moved to the Outbox folder and will be sent
the next time you connect. If you are working online, it is sent
immediately.
Managing Email Messages and Folders
Each email account has its own folder hierarchy with five default
folders:
Inbox, Outbox, Deleted Items, Drafts, and Sent Items. The messages you
receive and send through the mail account are stored in these folders.
You can also create additional folders within each hierarchy. The
Deleted
Items folder contains messages that have been deleted on the device.
The behavior of the Deleted Items and Sent Items folders depends on
the
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Inbox options you have chosen. In the message list, tap Tools and then
Options. On the Message tab, select your options.
If you want to organize messages into additional folders, tap Tools,
and
then Manage Folders to create new folders. To move a message to
another folder, in the message list, tap and hold the message and then
tap
Move on the pop-up menu.



Folder behavior with a direct connection to an email server
The behavior of the folders you create depends on whether you are using
ActiveSync, POP3, or IMAP4.
?If you use ActiveSync, email messages in the Inbox folder in Outlook
will automatically be synchronized with your device. You can select
to
synchronize additional folders by designating them for ActiveSync.
The folders you create and the messages you move will then be mirrored
on the server. For example, if you move two messages from the
Inbox folder to a folder named Family, and you have designated Family
for synchronization, the server creates a copy of the Family folder
and copies the messages into that folder. You can then read the messages
while away from your PC.
?If you use POP3 and you move email messages to a folder you created,
the link is broken between the messages on the device and their
copies on the mail server. The next time you connect, the mail server
will see that the messages are missing from the device Inbox and
delete them from the server. This prevents you from having duplicate
copies of a message, but it also means that you will no longer have
access to messages that you move to folders created from anywhere
except the device.
?If you use IMAP4, the folders you create and the email messages you
move are mirrored on the server. Therefore, messages are available
to you anytime you connect to your mail server, whether it is from your
device or PC. This synchronization of folders occurs whenever you
connect to your mail server, create new folders, or rename/delete
folders
when connected.
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Chapter 5:
Companion Programs
The companion programs consist of Microsoft?Pocket Word, Microsoft?
Pocket Excel, MSN Messenger, Windows Media?Player for Pocket PC,
Microsoft?Reader and Pictures.
To switch to a companion program on your device, tap Programs on the
menu, and then tap the program name.
Pocket Word



Pocket Word works with Microsoft Word on your computer to give you
easy access to copies of your documents. You can create new documents
on your device, or you can copy documents from your computer to your
device. Synchronize documents between your computer and your device
so that you have the most up-to-date content in both locations.
Use Pocket Word to create documents, such as letters, meeting minutes,
and trip reports. To create a new file, tap , Programs, Pocket Word,
and then New. A blank document appears. Or, if you’ve selected a template
for new documents in the Options dialog box, that template appears
with appropriate text and formatting already provided. You can open
only
one document at a time; when you open a second document, you’ll be
asked to save the first. You can save a document you create or edit
in a
variety of formats, including Word (.doc), Pocket Word (.psw), Rich
Text
Format (.rtf), and Plain Text (.txt).
Pocket Word contains a list of the files stored on your device. Tap
a file in
the list to open it. To delete, make copies of, and send files, tap
and hold a
file in the list. Then, select the appropriate action on the pop-up
menu.
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Tap to create a new document.
You can enter information by working in different modes, which you select
from the View menu. For each mode, display the toolbar for that mode
by
tapping Show/Hide on the command bar.
NOTE
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Select the type of folder you want displayed in the list.
Tap to change the sort order of
the list.
Tap to open a document.
Tap and hold an item to see a p
pop-up menu of actions.



You can change the zoom magnification by tapping View
and then Zoom. Then select the percentage you want.
Select a higher percentage to enter text and a lower one
to see more of your document. If you’re opening a Word
document created on a computer, select Wrap to Window
on the View menu so that you can see the entire
document.
Chapter 5: Companion Programs
Typing Mode
Using the input panel, enter typed text into the document. For more
information
on entering typed text, see Chapter 2.
To format existing text and to edit text, first select the text. You
can select
text as you do in a Word document, using your stylus instead of the
mouse to drag through the text you want to select. You can search a
document
to find text by tapping Edit and then Find/Replace.
Tap and hold to see a pop-up menu of actions.
Tap to show or hide the toolbar.
Tap to return to the document p
list ( changes are saved ( g
automatically ).
Tap to change formatting
options.
Tap to format text.
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled
lines
are displayed as a guide, and the zoom magnification is greater than
in
typing mode to allow you to write more easily. For more information
on
writing and selecting writing, see Chapter 2.
With Space button selected
drag to insert space.



An arrow appears showing the
space direction and size.
Tap to highlight selected text.
Tap to select formatting
options,
such as pen weight and line color.
Space button.
Pen button.
NOTE If you cross three ruled lines in a single stylus stroke, the
writing becomes a drawing, and can be edited and
manipulated as described in the following section. Written
words are converted to graphics (metafiles) when a
Pocket Word document is converted to a Word document
on your computer.
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Drawing Mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after the first
stroke,
you’ll see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of
the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.
Select Shape on the pop-up menu to convert objects to proper
shapes.
Resize an object by dragging
the selection handles.
Tap to select formatting options,
such as pen weight, line/font
color, and fill color.
Tap an arrow to see your
choices.
Pen button.
Recording Mode
In recording mode, embed a recording into your document. Recordings
are saved as .wav files. For more information on recording, see Chapter



2.
For more information on using Pocket Word, tap and then Help.
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Pocket Excel
Pocket Excel works with Microsoft Excel on your computer to give you
easy access to copies of your workbooks. You can create new workbooks
on your device, or you can copy workbooks from your computer to your
device. Synchronize workbooks between your computer and your device
so that you have the most up-to-date content in both locations.
Use Pocket Excel to create workbooks, such as expense reports and
mileage logs. To create a new file, tap , Programs, Pocket Excel, and
then New. A blank workbook appears. Or, if you’ve selected a template
for
new workbooks in the Options dialog box, that template appears with
appropriate text and formatting already provided. You can open only
one
workbook at a time; when you open a second workbook, you’ll be asked
to save the first. You can save a workbook you create or edit in a variety
of
formats, including Pocket Excel (.pxl) and Excel (.xls).
Pocket Excel contains a list of the files stored on your device. Tap
a file in
the list to open it. To delete, make copies of, and send files, tap
and hold a
file in the list. Then select the appropriate action from the pop-
up menu.
Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View
and then
Toolbar.
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Cell contents appear here as
you enter them.
Format button.
Auto Sum button.
Zoom button.



NOTE If your workbook contains sensitive information, you can
protect it with a password. To do so, open the workbook,
tap Edit, and then Password. Every time you open the
workbook, you will need to enter the password, so choose
one that is easy for you to remember but hard for others
to guess.
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Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:
?View in full-screen mode to see as much of your worksheet as possible.
Tap View and then Full Screen. To exit full-screen mode, tap
Restore.
?Show and hide window elements. Tap View and then tap the elements
you want to show or hide.
?Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View and then Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and column
labels visible as you scroll through a sheet.
?Split panes to view different areas of a large worksheet. Tap View
and then Split. Then drag the split bar to where you want it. To
remove the split, tap View and then Remove Split.
?Show and hide rows and columns. To hide a hidden row or column,
select a cell in the row or column you want to hide. Then tap Format,
then Row or Column, and then Hide. To show a hidden row or column,
tap Tools, then Go To, and then type a reference that is in the
hidden row or column. Then tap Format, then Row or Column, and
then Unhide.
For more information on using Pocket Excel, tap and then Help.
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MSN Messenger
MSN Messenger on your mobile device provides the same chat environment
as MSN Messenger on your PC. These features include:
?Seeing who is online.
?Sending and receiving instant messages.
?Having an instant message conversation with a group of contacts.
?Telling contacts that you are unavailable.



?Blocking contacts from seeing your status or sending you messages.
To use MSN Messenger, you must have a Microsoft Passport?account
or a Microsoft Exchange email account. You must have a Passport to use
MSN Messenger Service. If you have a Hotmail?or MSN account, you
already have a Passport. Once you have obtained either a Microsoft
Passport or a Microsoft Exchange account, you are ready to set up your
account.
NOTE Sign up for a Microsoft Passport account at
http://www.passport.com. Get a free Microsoft Hotmail
email address at http://www.hotmail.com.
To switch to MSN Messenger, tap , Programs, and then tap MSN Messenger.
Setting Up
Before you can use MSN Messenger, you must set up the instant messaging
account(s) to use. For MSN Messenger Service, you must have a
Microsoft Passport or Hotmail account. For Exchange Instant Messaging,
you must have an Exchange account.
To set up an account and sign in:
1. In the Tools menu, tap Options and then Accounts tab.
2. Select Enable MSN Messenger Service and/or Enable Exchange
Instant Messaging.
3. Enter your sign-in name and password for the selected account(s).
4. If you selected both accounts, under Sign in using this account
first, select which account to sign in to first.
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5. To sign in, tap the sign-in screen and then Sign in.
NOTE If you already use MSN Messenger on your computer,
your contacts will show up on your device without being
added again.
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Working with Contacts
The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send an email, block the contact from
chatting with you, or delete contacts from your list using the pop-up
menu.
Tap a contact to start a chat.



Tap and hold to display a pop- p p
up menu of actions.
NOTE To see others online without being seen, in the Tools
menu, tap My Status and select Appear Offline.
If you block a contact, you will appear offline but will
remain on the blocked contact’s list. To unblock a contact,
tap and hold the contact, then tap Unblock on the pop-up
menu.
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Chatting with Contacts
Tap a contact name to open a chat window. Enter your message in the
text entry area at the bottom of the screen or tap My Text to enter
a preset
message, and tap Send. To invite another contact to a multi-user chat,
in
the Tools menu, tap Invite and tap the contact you want to invite.
NOTE To switch back to the main window without closing a chat,
tap Contacts. To revert back to your chat window, tap
Chats and select the person with whom you were chatting.
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Enter message.
Tap to send message.
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To know if the contact you are chatting with is responding, look for
the
message under the text entry area.
View full chat.
View status of the chat.
For more information on using MSN Messenger, tap and then Help.
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Indicates the progress of the
current track.
Tap to adjust volume.
Tap to skip to the next song.
Windows Media Player
Use Microsoft Windows Media Player to play digital audio and video files



that are stored on your device or on a network. To switch to Windows
Media Player for Toshiba Pocket PC e800/e805, tap and then tap
Windows Media.
Tap to play a previous song.
Tap to stop.
Tap to play or pause.
Use Microsoft Windows Media Player on your computer to copy digital
audio and video files to your Toshiba Pocket PC e800/e805. You can play
Windows Media and MP3 files on your Toshiba Pocket PC e800/e805.
For more information about using Windows Media Player for Toshiba
Pocket PC e800/e805, tap , and then tap Help.
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Microsoft Reader
Use Microsoft Reader to read eBooks on your device. Download books
to your computer from your favorite eBook Web site. Then, use Active-
Sync to copy the book files to your activated device. The books appear
in
the Reader Library, where you can tap them in the list to open them.
Each book consists of a cover page, an optional table of contents, and
the
pages of the book. You can:
?Page through the book by using the Up/Down control on your device
or by tapping the page number on each page.
?Annotate the book with highlighting, bookmarks, notes, and drawings.
?Search for text and look up definitions for words.
The Guidebook contains all the information you'll need to use the
software.
To open the Guidebook, tap Help on the Reader command bar. Or,
on a book page, tap and hold on the book title, and then tap Help on
the
pop-up menu.
To switch to Microsoft Reader, tap , Programs, and then Microsoft
Reader.
Getting Books on Your Device
You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.
Sample books and a dictionary are also included in the MSReader folder



in the Extras folder on the Toshiba Pocket PC e800/e805 Companion CD.
Use ActiveSync to download the files from your computer to your activated
device as described in the Read Me file in the Microsoft?Reader
folder.
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Using the Library
The Library is your Reader home page; it displays a list of all books
stored
on your device or storage card.
To open the Library:
?On the Reader command bar, tap Library.
?On a book page, tap the book title, and then tap Library on the pop-up
menu.
To open a book, tap its title in the Library list.
Tap to scroll through the Library list.
Tap to select a sort order.
Tap here to navigate to other p g
parts of the Reader.
Tap to specify the books you y y y
want to display in the list.
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Reading a Book
Each book consists of a cover page, an optional table of contents, and
the
pages of the book. Navigation options are listed in the bottom portion
of
the cover page.
The first time you open a book, you’ll probably want to go to the first
page
or to the table of contents, if there is one. Subsequently, whenever
you
open the book, you’ll be automatically taken to the last page read.
In addition to the text, each book page includes a page number and book
title.
Tap to select a navigation option.
Drag to select text and then tap g



an option.
Tap arrows to turn the page, p p g
or tap and hold page # to bring up page riffle.
You can also page through a book by using the Up/Down control on your
device.
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Using Reader Features
Reading a book electronically gives you several options not available
with
paper books. These options are available from any book page.
Select text by dragging across the text on the page. Then, tap an option
on the pop-up menu, as described here:
?Search for Text. Find text in a book by tapping Find on the pop-up
menu. Enter the word you want to search for, and tap the desired Find
option. Reader highlights found text on the page. To close Find, tap
outside the box. To return to your original page, tap the title and
then
tap Return on the pop-up menu.
?Copy Text. You can copy text from books that support this feature into
any program that accepts text. On a book page, select the text you
want to copy, then, tap Copy Text on the pop-up menu. The text can
be pasted into the program of your choice.
?Bookmarks. When you add a bookmark to a book, a color-coded
bookmark icon appears in the right margin. You can add multiple
bookmarks to a book. Then, from anywhere in the book, tap the bookmark
icon to go to the bookmarked page.
?Highlights. When you highlight text, it appears with a colored
background.
?Notes. When you attach a note to text, you enter the text in a note
pad
that appears on top of the book page. A Note icon will display in the
left margin. To show or hide the note, tap the icon.
?Drawings. When you add a drawing, a Drawing icon appears in the
bottom-left corner of the page, and drawing tools appear across the
bottom of the page. Draw by dragging your stylus.
?To see a list of a book’s annotations, including bookmarks, highlights,
text notes, and drawings, tap Annotations Index on the book’s cover



page. You can tap an entry in the list to go to the annotated page.
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Removing a Book
When you finish reading a book, you can delete it to conserve space
on
your device. If a copy of the book is stored on your computer, you can
download it again at any time.
To remove a book from your device, tap and hold the title in the Library
list, and then tap Delete on the pop-up menu.
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Tap to set the picture as the
background on the Today Scree
Zoom button
Tap to crop a picture
Pictures
You can use Pictures to view .jpg pictures stored on your device or
on a
storage card, send pictures to others, view a slideshow of your pictures,
or set a picture as the background on the Today screen.
Edit Pictures
You can rotate, crop, zoom, and adjust the brightness and color contrast
of your .jpg pictures.
?Tap to rotate a picture 90 degrees counter-clockwise.
?Tap to crop a picture by dragging and selecting the crop area.
Tap outside of the box to stop cropping.
?Tap to display the Zoom panel, from which you can zoom in or
out of a picture, or return a picture to full-screen size.
?Tap Edit and then Brightness and Contrast to adjust the brightness
and contrast levels of a picture.
Tap to rotate a picture
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Send Pictures
You can send a .jpg picture to others as an email attachment. Tap Tools
and then Send via Email to create an email message with the picture
attached.



Set Picture as Background
You can use one of your own .jpg pictures as the background on the
Today screen, and specify how you want it displayed on the screen, such
as adjusting the transparency level.
1. In Pictures, tap the picture you want to set as the background.
2. Tap Tools and then Set as Today Wallpaper.
View Slideshow of Pictures
You can view your .jpg pictures as a slideshow on your device. Pictures
will display slides of the pictures shown in thumbnail view with 5-second
intervals between slides. In Pictures, tap to view pictures as a
slideshow.
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Chapter 6:
Pocket Internet Explorer
Use Microsoft?Pocket Internet Explorer to view Web or WAP pages in
either of these ways:
?During synchronization with your desktop computer, download your
favorite links and mobile favorites that are stored in the Mobile
Favorites
subfolder in Internet Explorer on the desktop computer.
?Connect to an Internet service provider (ISP) or network and browse
the Web. To do this, you’ll need to create the connection first, as
described in Chapter 7.
When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.
To switch to Pocket Internet Explorer, tap and then Internet Explorer.
The Mobile Favorites Folder
Favorites are stored in the Mobile Favorites subfolder of Favorites
in Internet
Explorer on your PC. This folder was created when you selected the
Favorites information type for synchronization in ActiveSync on your
PC.
Favorites must be stored in this folder to be synchronized.
Favorite Links
During synchronization, the list of favorite links in the Mobile



Favorites
folder on your PC is synchronized with Pocket Internet Explorer on your
device. Both computers are updated with changes made to either list
each time you synchronize. Unless you mark the favorite link as a mobile
favorite, only the link will be downloaded to your device, and you will
need
to connect to your ISP or network to view the content. For more
information
on synchronization, see ActiveSync Help on the PC.
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Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your device.
Synchronizing
mobile favorites downloads Web content to your device so that you
can view pages while you are disconnected from your ISP and desktop
computer.
Use the Internet Explorer plug-in installed with ActiveSync to create
mobile favorites quickly.
To create a mobile favorite:
1. In Internet Explorer 5 or greater on your PC, browse to the page
you
want to view offline.
2. Click Tools and then Create Mobile Favorite.
3. To change the link name, enter a new name in the Name box.
4. In the Update box, select a desired update schedule to keep the
page in the Mobile Favorites folder up to date.
5. To save the link in a subfolder of Mobile Favorites, click Create
In
and select the desired subfolder.
6. Click OK. Internet Explorer will download the latest version of the
page.
7. To download the pages that are linked to the mobile favorite you
just
created, in Internet Explorer on the PC, right-click the mobile favorite
and then click Properties. On the Download tab, specify the number
of links deep you want to download. To conserve device memory,



only go one level deep.
NOTE
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If you did not specify an update schedule in step 4, you will
need to manually download content to keep the information
updated on your desktop computer and device. Before
synchronizing with your device, in Internet Explorer on your
desktop computer, click Tools and then Synchronize. You
will see the last time content was downloaded to the desktop
computer, and you can manually download content if
needed.
You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your desktop
computer, click View, Toolbars, and then Customize.
Chapter 6: Pocket Internet Explorer
To save device memory
Mobile favorites take up storage memory on your device. To minimize
the
amount of memory used:
?In the settings for the Favorites information type in ActiveSync
options,
turn off pictures and sounds, or stop some mobile favorites from being
downloaded to the device. For more information, see ActiveSync
Help.
?Limit the number of downloaded linked pages. In Internet Explorer on
the desktop computer, right-click the mobile favorite you want to
change and then Properties. In the Download tab, specify 0 or 1 for
the number of linked pages you want to download.
Using AvantGo Channels
AvantGo is a free interactive service that gives you access to
personalized
content and thousands of popular Web sites. You subscribe to
AvantGo channels directly from your device. Then, you synchronize your
device and desktop computer, or connect to the Internet to download
the
content. For more information, visit the AvantGo Web site.
Synchronize an AvantGo channel:
1. In Pocket Internet Explorer on your device, tap to display your list



of favorites.
2. Tap the AvantGo Channels link.
3. Tap Activate.
4. Follow the directions on the screen. You will need to synchronize
your device with your PC and then tap My Channels to complete the
AvantGo setup.
When synchronization is complete, tap the AvantGo Channels link in your
list of favorites to see a few of the most popular channels. To add
or
remove channels, tap the Add or Remove link.
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Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your device without connecting
to
the Internet. You can also connect to the Internet through an ISP or
a network
connection and browse the Web.
Hide pictures button.
Favorites button.
Home button.
Refresh button.
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To view mobile favorites and channels:
1. Tap Favorites to display your list of favorites.
Tap the favorite you want to
view.
Tap to add or delete a folder or favorite link.
2. Tap the page you want to view.
You’ll see the page that was downloaded the last time you synchronized
with your PC. If the page is not on your device, the favorite will be
dimmed. You will need to synchronize with your PC again to download
the
page to your device, or connect to the Internet to view the page.
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To browse the Internet:
1. Set up a connection to your ISP or corporate network using
Connections,
as described in "Connect to the Internet" page 138.
2. To connect and start browsing, do one of the following:
?Tap Favorites, and then tap the favorite you want to view.
?Tap View and then Address Bar. In the address bar that appears
at the top of the screen, enter the Web address you want to visit
and then tap . Tap the arrow to choose from previously
entered addresses.
NOTE To add a favorite link while using the device, go to the page
you want to add, tap and hold on the page, and tap Add to
Favorites.
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Chapter 7:
Getting Connected
You can use your device to exchange information with other mobile
devices as well as your computer, a network, or the Internet. You have
the
following connection options:
?Use the infrared (IR) port on your device to send and receive files
between two devices. If this is the method you want to use, see the
following
section “Transfer Items Using Infrared.?
?Connect to your Internet account provider (ISP). Once connected, you
can send and receive email messages by using Inbox and view Web
or WAP pages by using Microsoft?Pocket Internet Explorer. The
communication
software for creating an ISP connection is already installed
on your device. Your account provider will provide software needed to
install other accounts, such as paging and fax accounts. If this is
the
method you want to use, see “Connect to an Internet Account Provider?
later in this chapter.
?Connect to the network at your company or organization where you
work. Once connected, you can send and receive email messages by
using Inbox, view Web or WAP pages by using Pocket Internet



Explorer, and synchronize with your computer. If this is the method
you want to use, see "Connect to Work" on page 140.
?Connect to your computer to synchronize remotely. Once connected,
you can synchronize information such as your Pocket Outlook
information.
If this is the method you want to use, see ActiveSync Help on
your computer or Connections Help on the device.
Transfer Items Using Infrared
Using infrared (IR), you can send and receive information, such as
contacts
and appointments, between two devices.
To send information:
1. Switch to the program where you created the item you want to send
and locate the item in the list.
2. Align the IR ports so that they are unobstructed and within a close
range.
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3. Tap and hold the item, and tap Beam Item on the pop-up menu.
NOTE You can also send items, but not folders, from File
Explorer. Tap and hold the item you want to send, and
then tap Beam File on the pop-up menu.
To receive information:
1. Align the IR ports so that they are unobstructed and within a close
range.
2. Have the owner of the other device send the information to you. Your
device will automatically receive it.
Connect to the Internet
You can connect to your ISP, and use the connection to send and receive
email messages and view Web or WAP pages.
You can connect to work in one of two ways:
?Create a modem connection. If this is the method you want to use, see
“To create a modem connection to an ISP.?
?Use an Ethernet card and a net tap to connect to the network. If this
is
the method you want to use, see “To create an Ethernet connection to
an ISP.?
To create a modem connection to an ISP:



1. Obtain the following information from your ISP: ISP dial-up access
telephone number, user name, password, and TCP/IP settings.
Some ISPs require information in front of the user name, such as
MSN/username.
2. If your device does not have a built-in modem, install a modem card,
or use or use a NULL modem cable and appropriate adapters to connect
an external modem to your device through the serial port.
3. Tap , Settings, Connections tab, Connections.
4. In My ISP, tap Add a new modem connection, and follow the
instructions in the New Connection wizard.
NOTE To change modem connection settings, in either My ISP
or My Work Network, tap Manage existing connections.
Select the desired modem connection, tap Edit,
and follow the instructions on the screen.
5. Enter a name for the connection, such as your ISP's name.
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6. In the Select a modem list, tap your modem type. If you are using
any type of external modem, in the Select a modem list, select the
modem by name. If a listing does not exist for your external modem,
tap Hayes Compatible on COM1.
7. Enter the phone number exactly as you want it dialed. If you
know part of the phone number will change frequently as you
travel, use dialing rules to avoid creating numerous modem
connections for the same phone number.
8. Enter your user name, password, and domain name as provided by
your ISP. If a domain name was not provided, try the connection
without entering a domain name.
9. You should not need to change any advanced settings. Instances
where you will want to change advanced settings include:
?You want to change baud rate settings, dialing string commands,
or credit card options.
?You need to change port settings.
?The server you are connecting to does not use dynamicallyassigned
addresses, and you need to enter your TCP/IP settings.
To change advanced settings, tap Advanced. Otherwise, tap Finish.
To start the connection, simply start using one of the following
programs.



Your device will automatically begin connecting. Once connected, you
can:
?Send and receive email messages by using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate
with the email server. For specific instructions, see "Connect Directly
to an Email Server" on page 143.
?Visit Web and WAP pages by using Pocket Internet Explorer, see
Chapter 6 "Mobile Favorites" on page 132.
?Send and receive instant messages with MSN Messenger. For more
information, see?"MSN Messenger" on page 117.
To create an Ethernet connection to an ISP:
1. You do not need to create a new connection on your device. Instead,
you must purchase and configure an Ethernet card that is compatible
with your device.
2. Obtain the following information from your ISP: user name, password,
and domain name.
3. Insert the Ethernet card into your device. For instructions on
inserting
and using the Ethernet card, see the owner’s manual for the
card.
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4. The first time you insert the card, Network Settings will appear
automatically so that you can configure the network card. If it does
not appear, or to change settings later, tap , Settings, Connections
tab, Connections, Advanced tab, Network Card.
5. If you need to enter specific server information, tap the appropriate
adapter. Most networks use DHCP, so you should not have to
change these settings unless your network administrator instructs
you to do so.
6. If necessary, connect the network card to the network by using a
network
cable. For information, see the documentation that came with
your network card.
To start a connection, insert the network card, and begin using a desired
program. For example, switch to Pocket Internet Explorer and browse
to a
Web page. Your device will automatically begin connecting.



Connect to Work
If you have access to a network at work, you can send email messages,
view intranet pages, synchronize your device, and possibly access the
Internet. You can connect to work in one of two ways:
?Create a modem connection by using a RAS account. Before you can
create this modem connection, your network administrator will need to
set up a RAS account for you. If this is the method you want to use,
see “To create a modem connection to a network.?Your network
administrator may also give you VPN settings.
?Use an Ethernet card and a net tap to connect to the network. If this
is
the method you want to use, see “To create an Ethernet connection to
a network.?
To create a modem connection to a network:

1. Get the following information from your network administrator:
dialup
access telephone number, user name, password, domain name,
and TCP/IP settings.
2. If your device does not have a built-in modem, install a modem card.
3. Tap , Settings, Connections and then tab Connections.
4. In My Work Network, tap Add a new modem connection, and follow
the instructions in the New Connection wizard.
5. Enter a name for the connection, such as your company's name.
6. In the Select a modem list, tap your modem type. If you are using
any type of external modem, in the Select a modem list, select the
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modem by name. If a listing does not exist for your external modem,
tap Hayes Compatible on COM1.
7. Enter the phone number exactly as you want it dialed. If you know
part of the phone number will change frequently as you travel, use
dialing rules to avoid creating numerous modem connections for
the same phone number.
8. Enter your user name, password, and domain name as provided by
your network administrator. If a domain name was not provided, try
the connection without entering a domain name.
9. You should not need to change any advanced settings. Instances



where you will want to change advanced settings include:
?You want to change baud rate settings, dialing string commands,
or credit card options.
?You need to change port settings.
?The server you are connecting to does not use dynamicallyassigned
addresses, and you need to enter your TCP/IP settings.
To change advanced settings, tap Advanced. Otherwise, tap Finish.
To start the connection, simply start using one of the following
programs.
Your device will automatically begin connecting. Once connected, you
can:
?Send and receive email messages by using Inbox. Before you can use
Inbox, you need to provide the information it needs to communicate
with the email server. For specific instructions, see "Connect Directly
to an Email Server" on page 143.
?Visit Internet or intranet Web or WAP pages by using Pocket Internet
Explorer.
?Send and receive instant messages with MSN Messenger. For more
information, see “MSN Messenger?in Chapter 5.
?Synchronize. For more information, see ActiveSync Help on the
computer.
To create an Ethernet connection to a network:
1. You do not need to create a new connection on your device. Instead,
you must purchase and configure an Ethernet card that is compatible
with your device.
2. Get the following information from your network administrator: user
name, password, and domain name.
3. Insert the Ethernet card into your device. For instructions on
inserting
and using the Ethernet card, see the owner’s manual for the card.
4. The first time you insert the card, Network Settings will appear
automatically so that you can configure the network card. If it does
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not appear, or to change settings later, tap , Settings, Connections
tab, Connections, Advanced tab, Network Card.
5. If you need to enter specific server information, tap the appropriate
adapter. Most networks use DHCP, so you should not have to



change these settings unless your network administrator instructs
you to do so.
6. If necessary, connect the network card to the network by using a
network
cable. For information, see the documentation that came with
your network card.
To start a connection, insert the network card, and begin using a desired
program. For example, switch to Pocket Internet Explorer and browse
to a
Web page. Your device will automatically begin connecting.
To set up a VPN server connection:
1. A VPN connection enables you to securely connect to servers, such
as a corporate network, via the Internet. Ask your network administrator
for your user name, password, domain name, TCP/IP settings,
and host name or IP address of the VPN server.
2. Tap , Settings, Connections and then tab Connections.
3. To create a new VPN server connection, in My Work Network, tap
Add a new VPN server connection and follow the instructions in
the New Connection wizard.
NOTE To change existing settings, in My Work Network, tap
Manage existing connections, VPN tab. Select the
desired VPN connection, tap Edit, and follow the instructions
on the screen.
4. In Name, enter a name for the connection, such as your company's
name. In Host name/IP, enter the VPN server name or IP address.
Next to VPN type, select the type of authentication to use with your
device: IPSec/L2TP or PPTP. If you aren't sure which option to
choose, ask your network administrator.
5. Select the type of authentication. If you select A pre-shared key,
enter the key provided by your network administrator.
6. Enter your user name, password, and domain name as provided by
your ISP or network administrator. If a domain name was not provided,
try the connection without entering a domain name.
7. You should not need to change any advanced settings. Instances
where you must change advanced settings include:
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?The server to which you are connecting does not use dynamically-



assigned addresses, and you need to enter your TCP/IP
settings.
?You need to change server DNS or WINS settings.
To change advanced settings, tap Advanced. Otherwise, tap Finish.
To edit proxy settings:
1. Tap , Settings, Connections tab.
2. To change proxy server settings, in My Work Network, tap Edit my
proxy server.
3. Select This network connects to the Internet and This network
uses a proxy server to connect to the Internet.
4. In the Proxy server box, enter the proxy server name.
5. To change such settings as port number or proxy server type, tap
Advanced and change desired settings.
End a Connection
To disconnect, do one of the following:
?When connected via dial-up or VPN, tap the Connection icon, , on
your navigation bar, and then tap End.
?When connected via cable or cradle, detach your device from the
cable or cradle.
?When connected via Infrared, move the device away from the PC or
device.
?When connected via a network (Ethernet) card, remove the card from
your device.
?When connected via a wireless network, switch off the connection.
Connect Directly to an Email Server
You can set up a connection to an email server so that you can send
and
receive email messages by using a modem or network connection and
Inbox on your device.
NOTE The ISP or network must use a POP3 or IMAP4 email
server and an SMTP gateway.
You can use multiple email accounts to receive your messages. For each
email account you intend to use, first set up and name the email account.
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If you use the same account to connect to different mailboxes, set up
and
name each mailbox connection.



To set up an email account:
?In Inbox on your device, tap Accounts, and then New Account. Follow
the directions in the New Account wizard.
For an explanation of a screen, tap and then Help. When finished, to
connect to your email server, tap Accounts and then Connect. For more
information on using the Inbox program, see "Inbox: Sending and
Receiving
Email Messages" on page 105.
Get Help on Connecting
More information on the procedures described here, as well as
information
on additional procedures, can be found in the following locations:
?"Inbox: Sending and Receiving Email Messages" on page 105.
?Online Help on the device. Tap and then Help. Tap View, All
Installed Help, and then Inbox or Connections.
?ActiveSync Help on the computer. In ActiveSync, Tap and then
Help.
?For troubleshooting information, see the Pocket PC Web site at: http://
www.microsoft.com/mobile/pocketpc
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Chapter 8:
Wi-Fi (IEEE 802.11b)
Wireless LAN
This chapter is valid for Wireless LAN model only.
Overview
NOTE
The IEEE 802.11b WLAN Adapter can connect your wireless Toshiba
Pocket PC e800/e805 to an existing IEEE 802.11b wireless network or
from its own Wireless Network. Using the adapter in the Toshiba Pocket
PC e800/e805, you can enjoy the complete mobile and high-speed wireless
Internet connectivity while in range of a Wi-Fi compatible access
point.
145
Toshiba Pocket PC e800/e805 User’s Guide
Join to Existing Network
Configure Wireless LAN Network
Pocket PC 2003 has a interface that enables you to join to a existing



network.
If Pocket PC 2003 detects a wireless network, it will show the above
menu. Also, if you join to encrypted network(s), Pocket PC 2003 will
require entering a Network (WEP) key.
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Launch Wireless LAN Configuration
In order to Configure Wireless LAN Settings, use the Configure Wireless
Networks Screen. To launch Configure Wireless Networks Screen, tap the
TMU (Traffic Monitoring Utility) Wireless LAN Indicator icon on the
navigation
bar, and then tap the “Config WLAN?Link. You can also launch by
tapping Start, Settings, System, then Wireless Networks.
Turn Off/On Wireless LAN connection
If you want to turn off/on the wireless LAN, tap the arrows icon on
the navigation
bar and launch the Connectivity window. If you tap the "Turn Wireless
off/on"" link on the window you can turn off/on the wireless LAN
module
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Power Off/On Wireless LAN modules
Traffic Monitor Utility (TMU) supplies Wireless power off/on function.
If
you want to turn off/on the wireless LAN tap the TMU icon and launch
the
Wireless LAN window. If you tap the “Power Wireless off/on?link on the
window you can turn off/on the wireless LAN module. Please refer to
page
134 for detailed information.
Select Preferred Network
TMU shows a Preferred network list where you can change wireless network
connections from this preferred list. If you want to connect to wireless
LAN network, you have to make a network setting and store to preferred
network list. See the "Wireless LAN Configuration" to set up wireless
network.
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IP Address:
IP Address
IP Address Page
Use the IP Address Page to view and edit the IP address, subnet mask
and default gateway. Click Connectivity (Arrows) icon, Settings,
Advanced, Network Card, Network Adapters, “IEEE 802.11b WLAN
Adapter.“You can also launch by tapping Start, Settings, Connections,
Connections, Advanced, Network Card, Network Adapters, “IEEE
802.11b WLAN Adapter.?
IP Address is Internet Protocol Address; a numeric address such as
10.37.238.100 that the domain name server translates into a domain
name. Each node on the IP network should have a unique IP address.
Subnet mask:
A number used to identify a sub-network when multiple networks share
an
IP address. For example 255.255.255.0
Default gateway:
This is a device used to forward IP packets to and form a remote
destination.
NOTE Please check with your network administrator for these
connection settings.
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DNS:
Name Servers Page
Use Name Servers Page to view and edit DNS, Alt DNS, WINS and Alt
WINDS. Click Connectivity (Arrows) icon, Settings, Advanced, Network
Card, Network Adapters, “IEEE 802.11b WLAN Adapter? then
Name Servers. You can also launch by tapping Start, Settings,
Connections,
Connections, Advanced, Network Card, Network Adapters,
“IEEE 802.11b WLAN Adapter? Name Servers.
Domain Name System is a database system that translates addressed
and domain names. For example the numeric address like 232.245.21.54
can becomes something such as cba.com. DNS can also be used to control
Internet email delivery.
Without setting the host computer's IP address in the
WINS, you cannot wirelessly synchronize your Pocket PC



with your host computer.
WINS:
In Windows Internet Naming Service has two functions; one is a Microsoft
NetBIOS name server that eliminates the broadcast needed to resolve
computer names to IP addresses by providing a cache or database of
translations. The other one is to set the IP address of the host computer
that you already construct the partnership for Network adapter Active
sync purpose.
NOTE
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Alt DNS:
Alt DNS stands for Alternative Domain Name System, Used to substitute
main DNS when necessary.
Alt WINS:
Alt WINS stands for Alternative Windows Internet Naming Service. Used
to substitute main WINS when necessary.
Wireless LAN Configuration
Set up a wireless network
Networks that you have already configured are preferred networks and
are listed in Wireless networks. You can select to connect to only
preferred
networks or have your device search for and connect to any available
network whether it is preferred or not.
Tap Start, Settings, Connections, Connections, Advanced, Network
Card, Wireless tab. You can also launch this by tapping Start, Settings,
System, Wireless Networks.
To change network settings, in Wireless networks, tap a network. If
you
do not see a desired network, tap Add new Settings... and follow the
instructions on the screen.
From Networks to access, select All available, Only access points or
Only computer-to-computer depending on the type of connected net-
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work(s). To connect only to networks you have already configured, clear
Automatically connect to non-preferred networks.
To change the network to connect listed in preferred network, tap and



hold
a network that you want to connect and select "Connect" from menu.
To delete network listed in preferred network, Tap and hold a network
that
you want to delete and select "Remove Settings" from menu.
NOTICE:
If you select to automatically connect to non-preferred networks, your
device will detect any new networks, your device will detect any new
networks
and provide you the opportunity to configure them.
Configure Wireless Network
A wireless network can be added either when the network is detected,
or
manually by entering settings information.
?Network name: It is also know as "SSID" and "ESSID". Enter a network
name, network name is a name given to the groups that form the
wireless LAN network, and up to 32 single-byte English characters
and symbols may be used. If the network was detected, the network
name is automatically entered and can't be changed.
?Connect to: Select what your network connects to, Work or Internet.
?This is a device-to-computer (ad hoc) connection: To connect to
an ad hoc connection, select this.
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Configure Network Authentication Screen
A wireless network can be added either when the network is detected,
or
manually by entering settings information. To determine if
authentication
Information is needed see your network administrator.
Check here to set WEP (Wired Equivalent
Privacy).Default is “Disable?
Check here to enable shared authentication
(Shared mode). Default is “Disable?
Check here if you can obtain WEP key
automatically from Access Point.
Almost case Default is “Enable?
In “Key?you enter the ASCII characters and



symbols corresponding to the selected WEP.
Select Key as transmit 1 - 4.
Check here to enable 802.1x authentication
Default is “Enable.
Select EAP type Default is “TLS(EAP-TLS)?
Show the Properties when you can connect to
Access Point with 802.1x authentication
?Data encryption (WEP Enabled)
Click here to enable data encryption.
?The Key is provided for me automatically:
Check here if you can obtain WEP key automatically from AP. Almost
case this function is used with 802.1X function. Default is "Enable".
?Network Key (WEP key):
Enter the ASCII characters and symbols that correspond to the mode
selected.
  64 bits (ASCII)
5-digit ASCII characters or symbols can be entered in "Network Key".
  128 bits (ASCII)
13-digit ASCII characters or symbols can be entered in "Network
Key".
  64 bits (HEX)
Hexadecimal 10-digit English letters and numerals can be entered
in “Network Key.?Letters and numerals that can be entered are 0-9
and A(a) - F(f).
  128 bits (HEX)
Hexadecimal 26-digit English letters and numerals can be entered
in “Network Key.?Letters and numerals that can be entered are 0-9
and A(a) - F(f).
?Key Index:
This becomes enabled when WEP is selected. Select 1 - 4.
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?Enable network access using IEEE 802.1X:
Check here to enable 802.1x validation function.
?EAP type:
Select protocol for using 802.1x validation function.
  TLS (EAP-TLS)
Transport Layer Security (TLS) protocol used by Windows 2000



Server, etc.
  PEAP
Protected EAP Protocol (PEAP) used by Windows.NET Server
2003, etc.
Please ask your network administrator for further details of the 802.1x
validation
procedure.
TMU Traffic Monitoring Utility
TMU Keeps users updated of current WLAN Module's activity status.
Icon Specification
Wireless Communication switch off:
Wireless Communication Switch, on the bottom of the PDA, is turned off.

Clicking on the icon gives you a warning message, "Please turn on
Wireless communication switch!" Click "OK" to close the Message Box.
Turn on the switch and you will see the icon turns to or ,
depends on the original setting for the WLAN Module Power.
Wireless Communication power off:
The WLAN Modules is at Power Off Status. Clicking on the icon displays
you a link "Power Wireless on". Click the link to turn on the Wireless
LAN module power and then the icon to .
Wireless Power on:
The WLAN Modules is at Power On Status. Clicking on the icon displays
you a link "Power Wireless off". Click the link to turn off the Wireless
LAN module power and then the icon to . Number of wave indicates
signal strength.
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Wireless LAN Manager
Wireless LAN Manager enables you to control some power management
settings and also enable to see some information of your Wireless LAN
adapter.
Wireless LAN Indicator icon on the navigation bar, and then tap the
"Info"
Link.
And you can also launch this by tapping Start, Settings, System, Wireless
LAN Manager
Manager Screen



?Enable Wireless LAN Indicator: If you check this, the wireless LAN
indicator is displayed in the navigation bar.
?Transmission Rate: Select transmission rate to be used from the
pulldown
menu. If you select "Fully Auto", the adapter is automatically set
to the most suitable transmission rate.
?Channel: If you make a ad-hoc network, you can select a channel that
used in that ad-hoc network from this list.
?Enable Power Saving Mode: Check this to use power saving mode.
  On Battery Power
Check this to run in power saving mode when on battery power.
Power is turned off if there is no transmission for the time specified.
Select the length of time for power saving mode from the pulldown
menu.
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  On External Power
Check this to run in power saving mode when on external power.
Power is turned off if there is no transmission for the time specified.
Select the length of time for power saving mode from the pulldown
menu.
Link Screen
?Link Quality
Link Quality shows quality of wireless LAN signal.
?Link Information
Link Information shows some information about your wireless LAN
adapter.
  SSID: Displays the SSID currently connected to the access point
or 802.11 ad hoc network.
  Channel: The number of the channel being used by the access
point or 802.11 ad hoc network.
  Tx Rate: Displays the transmission rate used.
  BSSID: Displays the BSSID set on the access point or 802.11 ad
hoc network.
  IP Address: Displays the IP address set.
  Subnet Mask: Displays the subnet mask set.
  Gateway: Displays the gateway IP address set.
  IP Renew: This is for attempting to renew an IP address, but can



only be used if DHCP is being used.
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Info Screen
?MAC (Media Access Control) Address:
Display Wireless LAN MAC Address. MAC Address is a hardware
address that uniquely identifies each device of network.
Display FW version that included Wireless LAN hardware.
Display Wireless LAN Driver version.
?Version Information:
  Firmware
  Driver
  Utility
Display Wireless LAN Configuration Utility version.
Toshiba Enroller
Configure "Toshiba Enroller", the tool for obtaining and administering
certificates
used for 802.1x validation. Please ask your network administrator
for configuration details.
Chapter 8: Wi-Fi (IEEE 802.11b) Wireless LAN
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Certificate for TLS
Enter here the user name of the person
obtaining the certificate.
Enter here the password of the user
obtaining the certificate. Passwords of more
than 14 letters will be blocked.
Enter the URL or IP address of the
certifying server (CA server) here.
Click there to request a certificate from
the certifying server(CA server).
Launch Certificate Import Wizard.
?User: Enter the user name of the person obtaining the client
certificate.
?Password: Enter the password of the user obtaining the client
certificate.
The password may be up to 14 single-byte characters in length.
If this length is exceeded, the password will be blocked.



?CA Server: Enter the URL or IP address of the certifying server issuing
the client certificate. Any URLs of more than 255 characters will be
blocked.
?Submit: After you have entered user name, password and CA server,
click this button to request a certificate from the certifying server.
Certificate Import Wizard
?Config Wireless: Launch Certificate Import Wizard.
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Root Cert Page
?Open Certificate:
Opens the root certificate. When the root certificate is opened
normally,
the person it has been issued to, the person it was issued by
and the period of validity will be displayed. The root certificate is
provided
by the .cer file.
?Install Certificate:
Registers the open root certificate in the system. This button is
enabled when the root certificate is opened normally.
NOTICE:
Pocket PC 2003 supports *.cer DER encoded root certificate file as
default. You can install root certificate if you double-click root
certificate
file.
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Manage Page
?Property:
Displays information on certificates obtained.
?Delete:
Deletes certificates.
Please use the greatest possible care when deleting certificates.
When using EAP-TLS, one client certificate and one root certificate
are
required as a minimum. When using PEAP, one root certificate is required
as a minimum.
Please ask your network administrator for details of operational



procedures.
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Advanced Page
?Request Page:
Part of the URL to be accessed when obtaining client certificates.
?Cert Template:
Template used when obtaining client certificates.
?Cert Attribute:
Attribute used when obtaining client certificates.
?Certificate for TLS:
If you check here, Obtain ClientCert and RootCert simultaneously.
Under normal circumstances, configuration is not needed unless
requested by your network administrator.
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Toshiba Certificate Import Wizard
Toshiba Certificate Import Wizard helps you obtain certificates from
network
or disk to certificate store more easily. The Toshiba Certificate Import
Wizard requires ActiveSync environment to obtain certificate from
server.
Please prepare the Cradle and PC that can connect to Certification
Authority (CA) Server.
The Toshiba Certificate Import Wizard obtains Certification Authority
via
ActiveSync path through a network connection.
You can exit this wizard when you tap OK. All operations on this wizard
will be cancelled.
Start Screen
Select 802.1x type from above menu and tap Next >.
For more in formation on authentication procedures, refer to "Configure
Network Authentication Screen" on page 153.
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Example: Obtain TLS Certificate from server (1)
Obtaining a certificate for TLS always requires an ActiveSync
connection.



Place your Toshiba Pocket PC 3750/e805 into the cradle and tap Next
>.
After tapping, if there are any problems about active syncing. Wizard
will
pop-up the problem.
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Example: Obtain TLS Certificate from server (2)
You have to enter your user name, password, and CA server name (or IP)
to
obtain certificates from server. After filling parameters, tap Next
>, If there is
something wrong with the parameters, Wizard will display the problem.
Example: Obtain TLS Certificate from server (3)
If you succeed in obtaining a Certificate from the server, the
Certificate
that you received.
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Example: Obtain PEAP Certificate from a file (1)
If your network supports PEAP authentication, you can obtain a
certificate
from file. Similar to the steps taken while obtaining a TLS certificate,
select From file (recommended), and tap Next >.
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Example: Obtain PEAP Certificate from a file (2)
Select Certificate from file. Certificate file should be provided from
your
network administrator. If you don't have that, please contact to your
network
administrator.
Toshiba Certificate Import Wizard supports only DER encoded root
certificate.
If you try to import other format certificate file, Wizard will pop-up
the
error.
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Example: Obtain PEAP Certificate from a file (3)
If you succeeded in obtaining the certificate from the server, the
certificate
will display on the screen like the figure above. Since PEAP
authentication
doesn't require client certification, the wizard will not show
information
about client certification. If you tap Finish, certificates are stored
to the
system.
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Chapter 9:
Optional Functions
You can also launch Home by tapping Home .
Home
You can launch built-in or installed applications (programs) by tapping
an
icon displayed on the Home screen. It can display a list of running
programs,
and easily activate or stop a specific program. The Home screen
displays the remaining battery power, Today information and frequently
used setting icons, and can be personalized by changing the background
or by adding icons and tabs.
Launching an Application From the Home Screen
1. Tap Start, Programs, and then Home to display the Home screen.
NOTE
2. Tap the desired tab (Running, Main, Programs, or Games) and then
tap the application icon you want to launch. The selected application
starts up.
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3. Tap New on the command bar for commands such as Paste or Add.
Information on applications (About, Tab Setting, etc.) are available
by



tapping Accounts.
4. To verify that the application is open, tap the Running tab.
NOTE
About the Home Screen
The default Home screen is the parallel display style with information
window
display.
170
Information window.
The information
can be displayed/
hidden.
The display style
can be switched
between parallel
and tab.
Launching applications: you can launch an application by
moving the cursor button or scroller to select and pressing
the center of the cursor button to confirm.
Adding tabs: you can add tabs up to a maximum of 10
kinds and icons up to 18 in a tab.

1st window.
Tab selection box.
Tap this to switch
between tabs.
2nd window.
About the Information Window
The information window displays the remaining battery power, hardware
information and Today information such as today’s tasks and
appointments.
Need applicable Mt.Shasta/Yellowstone screen here.
Displays the date and time. Tap to display the Clock setting screen
Displays the number of current tasks as of today and the number of tasks
finished
or soon to be finished as of today. Tap to launch Tasks.
Displays the number of unread mail and the sender of the latest unread
mail. Tap



to launch Inbox.
Displays today’s next appointment. Tap to launch Calendar.
Chapter 9: Optional Functions
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Display item
<not ready>
Name
Power
Memory
Screen light
System Information
VQ-select
Volume ON/OFF
Description
Tap to display the Power setting screen.
Tap to display the Memory setting screen.
Tap to display the Screen light setting
screen.
Tap to display the system information.
Tap to display the VGA-QVGA setting
screen.
Tap to toggle volume ON/OFF.
This icon is interlocked with the display of
volume ON/OFF that has been switched
using the icon on the navigation bar. Note,
however, that the navigation bar display is
not changed even if volume is toggled ON/
OFF using this button.
About Running
The Running tab displays the active application names. The icons do
not
appear.
Application Activate/Stop:
Tap the application name you want to activate, or tap and hold the
application
name and select Activate in the pop-up menu.
1. Tap to activate/tap to quit the desired application.



2. Tap on the screen within the Running tab to quit all applications.
3. You can select the View or Tools menu on the Running tab to get
more information about an application (About), view the application
in a certain color (Text color), or look at the Tab Setting.
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Need applicable Mt.Shasta/Yellowstone screen here.
NOTE To display the Running tab pop-up menu, tap and hold
any portion of the screen other than the application name.
In this case, only the Stop All is selectable.
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Tabs
Programs
<Not
ready>
Display Icon List
The following list shows the tabs and icons for the initial setup.
Icons Tabs
Running -
Main
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Applications
-
Pocket
Internet
Explorer
Windows
Media Player
Notes
Tasks
Inbox
Calendar
Contacts
VQ-select
Applications Icons
File Explorer
DataBackup



MSN
Messenger
Pocket Word
Pocket Excel
Calculator
Solitaire
Jawbreaker
need Pictures
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Moving Application Icons
You can move icons in tabs or between tabs. To create a new tab, see
"Tab Settings" on page 178.
To move icons in tabs:
1. Drag and drop the desired icon to the desired position with the icon
in a tapped state. When the icon is moved, the icon near where the
icon is to be moved is highlighted. When the icon is dropped, the
icon is moved to the position of the highlighted icon. If there is no
highlighted icon when the icon is dropped, the icon is moved to the
end of the icons.
NOTE When “Icons are sorted as launched order (Effective for
all tabs)?is selected in the Tab Settings screen, icons in
tabs are sorted in the order that they are launched. Icons
cannot be moved in tabs when this is set.
To move icons to another tab using the pop-up menu:
1. Tap and hold the icon you want to move to display the pop-up menu.
2. Tap Cut on the pop-up menu.
3. Tap the destination tab, then tap and hold any portion other than
the
icon, and then tap Paste on the pop-up menu. The selected icon is

pasted next to the last icon on the tab screen.
NOTE The moved icon is placed next to the last icon on the tab
screen. When “Icons are sorted as launched order (Effective
for all tabs)?is selected in the “Tab Settings?screen,
icons in tabs are sorted in the order that they are
launched. An icon cannot be moved into a tab that
already includes 18 icons.
To move icons to another tab using drag and drop:



1. Tap the icon you want to move.
2. Drag the icon to the destination tab, and then drop it. The name
of
the destination tab is displayed inverted, the icon is moved, and that
icon in the original tab screen is deleted.
175
Toshiba Pocket PC e800/e805 User’s Guide
NOTE
Deleting an Icon
1. Tap and hold the icon you want to delete to display the pop-up menu.
2. Tap Drop on the pop-up menu. The icon is deleted and the next icon
automatically shifts to fill the deleted icon position.
Adding an Icon
You can add the application and your file icons to the Home screen.
1. Tap Edit and then Add to display the Add Application screen.
You can also select Add from the pop-up menu displayed by tapping
and holding any portion other than the icon.
2. Tap   of Application file box to show the file list. If you cannot
locate
the file, find it by tapping Browse. To refer to all folders and files,
tap
Browse to show the Browse screen. When the file is selected, its
name is displayed in the Application file box.
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Icons that can be moved are displayed inverted when
they are tapped. The moved icon is placed next to the
last icon on the tab screen. When “Icons are sorted as
launched order (Effective for all tabs)?is selected in the
“Tab Settings?screen, icons in tabs are sorted in the
order that they are launched. An icon cannot be moved
into a tab that already includes 18 icons.
Tap to designate a folder you want to
browse. When a storage card is inserted,
files or folders contained in the storage
card are displayed from the top directory.
Tap to move to one upper directory
folder above the currently displayed
one.



Tap to select kinds of application or file to
be browsed.
If a file is selected from the list, the screen
returns to the Add Application screen. Chapter 9: Optional Functions
3. Enter the icon name (up to a maximum of 32 characters) in the
Application
name box that is to be displayed on the Home screen.
4. When finished, tap OK to close the Add Application screen, and the
new icon is added to the Home screen.
NOTE If the Application file is not designated, or if the Application
name is not entered, you cannot add a new icon.
You cannot launch the icon added from the storage card,
if the same card is not inserted in the Toshiba Pocket PC
e800/e805.
Renaming Icons
You can rename icons (applications).
1. Tap and hold the icon to rename. The pop-up menu is displayed.
2. Tap Rename from the pop-up menu. The icon can be renamed.
3. Change the name using the input panel, and tap the screen.
NOTE Tapping anywhere on the screen other than the navigation
bar or the command bar also fixes the name.
In addition to the above method, the name is fixed when
the screen contents have changed.
Switching Icon Display
When icons are displayed in tab display style, their display can be
switched from the View menu. Select Large Icon or Small Icon to suit
your
preference.
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(Example) Small Icon
Tab Settings
On the Tab Settings screen you can add, delete or rename a tab as well
as select a bitmap image to display on the screen background.
To add a tab:
1. Tap Tools, and then Tab Settings.
2. Tap New to display a box to enter the new tab name.
3. Enter a new tab name (up to a maximum of 10 characters). When



finished, tap OK to return to the Tab Settings screen.
4. Tap OK on the Tab Settings screen to return to the Home screen. A
new tab is added to the right of the existing tab.
NOTE The number of tabs can be increased to 10. The tab
order cannot be re-arranged.
To delete a tab:
1. Tap Tools, and then Tab Settings.
2. Select the tab name to delete, and then tap Delete. The Confirmation
Delete tab appears, followed by the Delete tab confirmation dialog
box appears. Please note that all the icons contained in the same
tab will also be deleted.
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3. Tap Yes on the Delete tab dialog to delete the tab. When finished,
the screen returns to Tab Settings screen.
4. Tap OK on the Tab Settings screen to return to the Home screen.
You cannot delete the Running tab. NOTE
To change the name of a tab:
1. Tap Tools and then Tab Settings.
2. Select the tab name you want to change, and then tap Modify.
3. Enter a new tab name (up to a maximum of 10 characters). When
finished, tap OK to return to the Tab Settings screen.
4. Tap OK on the Tab Settings screen to return to the Home screen.
You cannot rename the Running tab. NOTE
To sort icons:
Icons in tabs can be sorted in the order that they were last launched.
1. Tap Tools and then Tab Settings.
2. Select the “Icons are sorted as launched order (Effective for all
tabs)?
check box.
3. Tap OK on the Tab Settings screen to return to the Home screen.
To move icons in a tab, clear the check box. NOTE
To change a background:
1. Tap Tools and then Tab Settings.
2. Select the tab name you want to change, and then tap Modify.
3. Tap Browse. The Browse screen is displayed. Even if a storage card
is inserted, the files in the storage card will not be displayed.
4. To return to the previous screen, tap the desired bitmap file from



the
list.
5. To return to the Tab Settings screen, tap OK.
6. Tap OK on the Tab Settings screen to return to the Home screen.
NOTE If the selected file is not a designated file type, you cannot
set it on your screen background. The Home screen
image display range is 240 pixels (W) x 268 pixels (H).
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Background Color and Text Color Setting
You can use Background Color to select a color for the background for
each tab. Additionally, Text Color is available to apply a color for
the application
name for each tab.
To apply Background Color and Text Color:
1. Tap Tools and then Tab Settings.
2. Select the tab name you want to change, and then tap Modify.
3. Tap Background color or Text color to display the color list.
4. Select the color, and tap OK to return to the previous screen.
5. To return to the Tab Settings screen, tap OK.
6. Tap OK on the Tab Settings screen to return to the Home screen.
NOTE When a background image is set, the background image
will stay intact and not change even if a background color
is set. Note, however, that if the image does not completely

fill the background, the background color will form
a border around the image. Background color and text
color can also be set from the View menu.
Home Help
Tapping an icon displayed at Home launches that application. In addition
to applications, it is also possible to register icons for associated
files
here. The Home screen is divided into tabs. There are 4 tab types as
default, and up to 10 types of tab can be registered. As for the icons
on
the tab, up to 18 icons per one tab can be registered.
An image can be used as the background for the tab screen.
Running Tab



The names of currently running applications are displayed at the Running
tab.
Applications can be switched or quit here.
Text Color can be selected from the View menu, and Tab Settings and
About can be selected from the Tools menu.
?To activate applications, tap and hold the name of the application
you want to activate to, then tap Activate from the pop-up menu.
?To stop an application, tap and hold the name of the application
you want to stop, then choose Stop from the pop-up menu. If Stop
all is selected from the pop-up menu, all currently running applications
are stopped.
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?Stop all can also be selected by tapping and holding on the Running
tab screen without selecting an application name.
Launching applications
When an icon on the tab screen is tapped, the application or associated
file registered at the icon is launched.
?Applications can also be launched by selecting them with the cursor
button then pressing on the center of the cursor button.
Switching the icon display
Tap on the View menu to display the current display settings. Current
display
settings are indicated by check mark at the left. To switch the display,
select Large Icon or Small Icon.
Icon settings
1. Moving icons (using the pop-up menu)
1. Tap and hold the icon you want to move on the tab screen.
2. When the pop-up menu appears, select Cut from the menu.
3. Tap on the tab to which you want to move the icon, then tap
Paste from the Edit menu to move the icon and display it on the
tab screen.
?It is not possible to move icons to tabs already containing 18
icons. When an icon is moved, it is positioned at the very end of
the tab’s icons.
2. Deleting icons
1. Tap and hold the icon you want to delete. A pop-up menu
appears.



2. Tap Drop from the pop-up menu to delete the selected icon from
the tab screen.
?When an icon is deleted, subsequent icons are all moved up one
place.
3. Adding icons
1. Tap the tab to which you want to add an icon to select that tab.
2. Tap Add from the Edit menu to display the Add Application
screen.
3. Tap the Application file box.
4. From the list, tap the application you want to add. To select a file
not on the list, tap Browse, then select the file from the Browse
Dialog.
181
Toshiba Pocket PC e800/e805 User’s Guide
5. Input the name of the icon you want to add (up to 32 characters)
in the Application name box.
6. Tap OK. The new icon is added.
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?Associated files can be specified for added icons.
?If either one of Application file or Application name is not filled
in, an icon can not be added.
4. Browse Dialog
1. Tap the Folder box to select the folder to be browsed.
2. Tap the Type box to select the type of file to be browsed.
3. The list of the files of the specified type and in the specified
folder
appears on the screen. Select the desired application or file or
the image to be used as the background and tap it. The original
screen reappears.
?If a storage card is inserted into the main unit when adding icons,
icons of applications and files on the storage card are also displayed
on the browse screen. The folders and files on the storage
card can be displayed in the Folder box, beginning at the
topmost level.
?If an icon on a storage card is added, that storage card must be
inserted when the icon is tapped or the file will not be launched.
Tab settings



1. Switching tabs
Tap on another tab to switch the tab screen.
Initially four tabs are registered: Running, Main, Programs and Games.
2. Changing tab names
1. Select Tab Settings from the Tools menu. The Tab Settings
screen appears.
2. Tap the Select tab box to select the tab to be changed.
3. Tap Rename. The screen for inputting the new tab name
appears.
4. Input the new tab name (up to 10 characters) into the Rename to
box.
5. Tap OK. The tab name is changed and the Tab Settings screen
reappears.
6. Tap OK at the upper right to return to the Home screen.
7. Deleting tabs
1. Select Tab Settings from the Tools menu. The Tab Settings
screen appears.
2. Tap the Select tab box to select the tab to be deleted.
3. Tap Delete. A dialog asking you to confirm you want to delete the
tab appears.
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4. Tap Yes. The tab is deleted and the Tab Settings screen reappears.
5. Tap OK at the upper right to return to the Home screen.
?Note that when a tab is deleted, all the icons on that tab are also
deleted.
?Delete cannot be selected if there are only two tabs on the Home
4. Adding tabs
1. Select Tab Settings from the Tools menu. The Tab Settings
screen.
screen appears.
the New tab box.
2. Tap New. An input screen appears.
3. Input the name you want to give the tab (up to 10 characters) into
4. Tap OK. The new tab is added and the Tab Settings screen
reappears.
5. Tap OK at the upper right to return to the Home screen.
5. Setting the background image



1. Select Tab Settings from the Tools menu. The Tab Settings
screen appears.
2. Select the tab whose background you want to set at the Select
tab box.
3. Tap Browse to display the Browse Dialog.
4. Select and tap the image to be used as the background. The Tab
Settings screen reappears.
5. Tap OK at the upper right to return to the Home screen.
6. Setting the text color
Different colors can be set for the application names at the different
tabs.
1. Display the tab whose color you want to set, then select Text
Color from the View menu.
2. Tap the color you want to set from the list of display colors. That
color is set for the application names.
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How to Make a Backup
Periodical backup of your data is highly recommended. You can make a
backup of the Toshiba Pocket PC e800/e805 data to a storage device.
Additionally, if you have backed up your data on a storage device, you
can
restore that data in your Toshiba Pocket PC e800/e805 as well as delete
backup file data from the storage device.
Data of the following three types can be backed up:
File: Includes a file created by Pocket Word, Pocket Excel, Notes, or
an
additionally installed program.
Registry: Settings information on Windows Mobile 2003 or built-in
programs.
Database: Microsoft Pocket Outlook information.
1. Data such as the password in Settings cannot be
restored.
2. The data stored in the Flash ROM disk cannot be
back up.
3. Before backing up or restoring data, stop other applications,
and connect the AC adapter to the Toshiba
Pocket PC e800/e805.



4. If you make a backup to the CF/SD card or Flash
ROM Disk using the DataBackup Utility, please DO
NOT: remove the CF/SD card, reset the device, and/
or turn off the device’s power until the backup is
completed.
5. If you restore the data from the CF/SD card or Flash
ROM Disk by DataBackup Utility, please DO NOT:
remove the CF/SD card, reset the device, and/or
turn off the device’s power until the restore is completed.
Failure to follow any of the above procedures may result
in the loss of data.
Making a Backup
Before performing the backup or restore operations, do the following;
?Check that there is enough space in the main unit’s memory and on
the storage device. The backup process will stop if the storage device
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becomes full before completing the backup. The backup data is saved
as a .dbk file on your storage device.
?Make sure the main unit’s power is off when loading and unloading the
CF/SD card.
?Save current data in the main unit’s memory before backing it up on
the storage device.
1. To make a backup to the CF/SD card, insert a CF Card or SD Card.
Make sure to do so in the proper direction.
2. Tap Start, Programs, and then DataBackup to display the DataBackup
screen shown below.
3. Tap Backup from Functionality, and select the storage destination.
Tap to select Backup.
Tap to select the
storage destination.
Tap to select:
Whole data: All files
stored in main memory,
registry, and database.
PIM data: Pocket Outlook
data (Contacts,
Calendar, and Task).



4. Tap Start. The screen for confirming that other applications have
ended appears.
5. To display the Backup password input screen, tap OK.
6. Enter a password. You can enter a password up to a maximum of 16
characters. Backup can be made even without entry of a password.
If a password is entered, that password is required at the time of
restore.
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NOTE If you forget the password, you cannot restore the
backup data. Do not forget your password. Write down
the password and keep it in a safe place where only you
know.
7. When finished, tap OK. The progress bar is displayed during the
backup process. When the backup is completed, the backup finish
message appears. The backup time that is displayed on screen is
the time that the backup was started.
8. Tap OK to return to the previous screen.
9. Tap Exit to close the DataBackup screen.
NOTE The backup process will stop if the storage device
becomes full before completing the backup. Before starting
the backup, check the remaining storage device
capacity.
If the storage card is write-protected, you cannot save the
backup data. Cancel the write-protection before starting
the backup.
Backups can also be made periodically. For more information,
see "Making an Auto Backup" on page 189.
Backup files are always overwritten.
Carrying Out the Restore Operation
To restore is to overwrite the backed up data from the storage device
onto
the main memory of your Toshiba Pocket PC e800/e805. Prior to restoring
your data, please consider the following:
?If the same file name exists in the main memory of your Toshiba
Pocket PC e800/e805, this file data is replaced with the backup data
from the storage device.
?If files exist in the main memory but not in the backup file, they



will not
be overwritten.
1. To restore from the CF/SD card, insert the CF/SD card that contains
the backup data into your Toshiba Pocket PC e800/e805.
2. Tap Start, Programs, and then DataBackup to display the
DataBackup screen shown on the following page.
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3. Tap Restore from Functionality, and select the storage destination.
Tap Restore.
Tap to select the
storage destination.
4. Tap Start. The screen for confirming that other applications have
ended appears.
5. Tap OK to display the Restore password input screen.
6. Enter the password used when backing up the data (if the file was
previously created without a password, then a password is not
required).
7. When finished, tap OK. The progress bar is displayed during the
restore process. When the restore is completed, the restore finish
message appears.
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8. Tap OK. Your Toshiba Pocket PC e800/e805 is now reset and it will
automatically restart.
If your Toshiba Pocket PC e800/e805 memory becomes
short of its capacity during restore, the restore process
stops. Increase the memory allocation of the main memory
of your Toshiba Pocket PC e800/e805 (see "Customize
Your Toshiba Pocket PC" on page 58), and then
restart the restore procedure.
Data backed up on a legacy model Toshiba Pocket PC or
another manufacturer’s Pocket PC (simply called "other
Pocket PC" from here on) cannot be restored to your
Toshiba Pocket PC e800/e805. To load other Pocket PC
data to your Toshiba Pocket PC e800/e805, use Active-
Sync to synchronize the personal computer with the
other Pocket PC. Next, synchronize the personal computer



with Toshiba Pocket PC e800/e805, and then load
the data to Toshiba Pocket PC e800/e805.
Deleting a Backup File
You can delete a backup file and replace it at another time or make
room
for more data on your Toshiba Pocket PC e800/e805.
To delete the backup data on CF/SD card:
1. Insert the CF Card or the SD Card into your Toshiba Pocket PC
e800/e805.
2. To display the Backup screen, tap Start, Programs, then
DataBackup.
3. Tap Delete Backup File from Functionality, and select the storage
destination.
4. Tap Start.
5. To delete the backup file, tap OK.
6. Tap Exit to close to the DataBackup screen.
Making an Auto Backup
You can set up your Toshiba Pocket PC e800/e805 to automatically
backup files at a specified time intervals. Select the backup time,
occurrence,
and frequency that best suits your needs. For example, when you
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select auto backup set1, data is automatically backed up at the specified
day of the week and time.
NOTE Even if your Toshiba Pocket PC e800/e805 is turned off,
data is periodically backed up.
To make a backup to the CF/SD card:
1. Insert a CF Card or a SD Card
2. To display the DataBackup screen, tap Start, Programs, then
DataBackup.
3. Tap Auto backup settings from the Tools menu. The Settings
screen is displayed.
4. Set the desired items.
Select Do auto-backup.
If required, enter a password.
Select the storage device.
Select if power off backups



are required.
5. Tap OK. The settings data is saved and periodical backups will be
made at the preset time.
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6. Tap Exit to close to the Backup screen.
NOTE If the "Do auto backup only when power is off" check box
is not marked, the auto backup confirmation screen will
be displayed if your Pocket PC is ON when the auto
backup occurs. The backup will be automatically started if
you tap OK or about 30 seconds elapses after the confirmation
screen is displayed. Tap Cancel to stop the
backup.
If the "Do auto backup only when power is off" check box
is selected, the message screen will be displayed, and
the backup will be started after about 10 seconds if your
Pocket PC is off when the auto backup occurs.
Auto backups will only occur if the AC Adapter is connected
or the remaining battery charge is 50% or more.
You can confirm whether or not auto backups have
occurred by checking when the last backup was made.
Depending on the conditions, auto backups may not
occur.
Auto backups will not occur if the preset storage card is
not inserted in the card slot at the specified auto backup
time.
Do not turn your Toshiba Pocket PC e800/e805 off during
an auto backup. Doing so might damage the data or your
Toshiba Pocket PC e800/e805.
If the storage device runs out of data storage space during
an auto backup, the backup will end midway. Before
an auto backup is made, check the amount of free space
on the storage device.
System Information
The System Information program displays the system information such
as CPU clock, CPU stepping, Boot Loader Version, OS Version, PIC Version,
MAC address (WirlessLAN model only), and UUID. The information
is displayed by accessing the Identity, Memory, Drivers, System, and



Wireless tabs.
To launch the program, tap Start, Settings, System, and then System
Information.
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T
about Identity ,
, and Wireless
settings.
Memory Tab
Identity Tab
The opening menu presents identification information for product

service.
The Memory tab presents information about the systems RAM, ROM, and
Flash ROM Disk.
Driver Tab
The Driver tab displays the drivers used by the system’s software
applications.
System Tab
The System tab displays CPU, operating system, and other system
information.
Wireless Tab
The Wireless tab displays information about the Built-in Wireless LAN
adapter.
Tools Menu
The Tools menu displays the system information and allows it to be
exported to a text (*.txt) file. Export exports all system information
parameters
to a text (*.txt), and About displays the system information version.
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ATI Presentation Pack
The Toshiba Expansion Pack with ATI IMAGEON Dual Display Solution
comes bundled with the ATI Presentation Pack, which includes the IA
Presenter
and IA Screen Mirror modules.
IA Presenter



Take your Microsoft Windows PowerPoint slides and use IA Presenter to
run a smooth presentation directly from your Pocket PC. IA Presenter
can
run as a standalone mobile PowerPoint player using your portable
device’s LCD screen. But with IA Presenter and the Toshiba Expansion
Pack linked to an LCD projector or a monitor, you can create powerful
presentations
from your Pocket PC.
IA Screen Mirror
The IA Screen Mirror with the Toshiba Expansion Pack projects the current
contents of your Pocket PC’s LCD screen onto an external projector,
or monitor. It can display up to nine different images from your LCD
output
at the same time on the second display. See page 203 for information
on updates.
IA Presenter
Getting Started
After you invoke IA Presenter, the screen lists all the converted Power-
Point presentations currently in your \My Documents folder. A sample
presentation

file is included with the installation, so at least one file will be
listed when you initially invoke IA Presenter.
To receive a presentation file into the \My Documents folder of your
Pocket PC via Infrared beaming, tap Tools in the lower left corner of
the
screen, then select Receive via InfraRed...from the menu shown above.
To drag-and-drop a PowerPoint file from your computer to your Pocket
PC, see the section Using IA Presenter’s Desktop Converter on the
next page.
The Options... command on the Tools Menu opens the General, File,
Display,
and VGA Output tabs. These tabs are explained in the on-line Help
file, which can be accessed from the Tools Menu by tapping Help....
Or,
after opening one of the tabs, select Help from the Windows Start Menu.
Installing the ATI Presentation Pack
All components of the ATI Presentation Pack are installed together by



doing as follows:
1. Make sure your Pocket PC is connected to your computer and that
an ActiveSync connection has been established.
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2. Start the ATI Presentation Pack installation by running the Setup
program.
NOTE You can setup ATI Presentation Pack from Companion
CD
3. After accepting the license agreement, choose the folder to which
you want the ATI Presentation Pack to be installed. Click Next to
accept the default destination folder; click Browse... to specify a
different
folder.
4. Check your Pocket PC screen for any additional steps required to
complete the installation.
Using IA Presenter’s Desktop Converter
When you drag-and-drop a PowerPoint file from your PC to your Pocket
PC, the ActiveSync Converter in the IA Presenter will automatically
convert
the PowerPoint file to a special IA Presenter format for your Pocket
PC, using the resolution you specify. The file will be placed in any
folder
on your mobile device where you choose to drag-and-drop it.
NOTE PowerPoint 97 or PowerPoint 2000 (or greater) is necessary
for using IA Presenter’s Desktop Converter.
There are two ways to open the “Set ActiveSync Conversion Options?dialog
box:
?1) Select ATI Presentation Pack from the Start Menu, and then Set
IA Presenter ActiveSync Conversion Options from the submenu.
The dialog box will open, establishing it as your default PowerPoint
filter
for your ActiveSync drag-and-drop operations. You can choose a
dimension and then clear the Show this option dialog box next time
check box (it is selected by default as shown in the figure above).
If
you cleared it, the dialog box will not open whenever you drag-anddrop
a file from your computer to your mobile device. Instead, the



dimension you specified will be used during each conversion.
?2) You can set the dimension each time you drag-and-drop a Power-
Point file from your computer to your mobile device. If the Show this
option dialog box next time check box has not been cleared, the IA
Presenter “Set ActiveSync Conversion Options?dialog box will open
automatically every time you drag-drop a PowerPoint file to your
Pocket PC.
Choosing Dimensions for the Converted .IAP File
The conversion filter supports both PPT and PPS PowerPoint files. The
conversion options are:
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  Pocket PC LCD Size ?320 x 240: Select this option if you only
want to display the presentation on the LCD screen of your Pocket
PC. However, if you have tried the 320 x 240 button and then find
that images on the Pocket PC screen have been stretched to fit
the screen, and you do not want this effect, try converting again
using the User-defined button. After selecting User-defined,
enter 240 in the first box, and 320 in the second box.
If you want to prepare the file to project the presentation to a VGA
screen

or video monitor, select one of these options:
  VGA ?640 x 480
  SVGA ?800 x 600
  User-defined: If you do not want to use one of the pre-defined
dimensions listed above, select the User-defined option and
enter your own value in the fields.
XGA 1024 x 768 is not supported. NOTE
Opening a Presentation and Using View Modes
When you invoke IA Presenter, the first screen that appears lists all
the
converted PowerPoint presentations currently in your \My Documents
folder. Tap on the name of the file you want to load. You can then choose
from the following view modes.
Normal View
Normal view allows you to view the current slide in the upper pane,
while



still able to navigate slides conveniently using the lower thumbnail
pane.
You can drag the Splitter Bar that divides the two panes up or down,
to
adjust the screen distribution above and below the splitter. The Normal
View icon is located at the leftmost side of the Toolbar, as shown below.
You can also use the stylus to pan the slide image in the upper pane
to
show the part covered by the lower pane. The splitter position will
automatically
be remembered across multiple application sessions, freeing
you from having to adjust the splitter position again during the current
IA
Presenter session.
To display a different slide in the upper pane, simply tap on the desired
thumbnail in the lower pane, or use the Slide Title Bar (unnamed slides
will be represented by a number in the Slide Title Bar drop-down list).
The
lower thumbnail pane in Normal view provides slide navigation. If you
want to select multiple slides for further operations, use the Slide
Sorter
view, as explained in the next section.
You can project the currently selected slide to VGA Display by activating
the VGA Slide Toggle command on the View Menu, or by tapping the
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VGA Slide Output Toggle icon at the rightmost side of the Toolbar. To
end the projection, select the command again to toggle it off.
Slide Sorter
Slide Sorter view fills the entire application space with either large
or small
thumbnails, depending on whether Large Thumbnail or Small Thumbnail
is active on the View Menu. You can select:
?One slide by tapping on it, or
?Multiple adjacent slides by dragging your stylus over them, or
?If you select Multiple Select Mode on the Edit Menu, you can tap,
drag, or a combination thereof, to select multiple slides that are
separated.



Selected slides will be highlighted by a different border color.
You can project an individual slide to the VGA output by activating
the
VGA Slide Toggle command on the View Menu, or by tapping the VGA
Slide Output Toggle icon at the rightmost side of the Toolbar. When
you
activate this function:
?If one slide is selected at the time you toggle the VGA Slide Output
“on,?that slide will be output to the VGA Display.
?If multiple slides happen to be selected, the first selected slide
in
the sequence will be output to the VGA Display.
?If no slides are selected, there is no change to the current status
of
the VGA Display. That is, if an image is already displayed on the
VGA Display, that image remains until you select a slide on your
LCD screen for projection.
To end the projection and return to viewing the slide only on your mobile
device’s screen, just select the command again (or tap the icon a second
time) to toggle it off.
Indicator Icons under Thumbnails
Under each thumbnail in Slide Sorter view mode, there may be various
small icons displayed which indicate the status/attributes of the slide,
as
follows:
The transition icon indicates that a transition effect has been
associated
with the slide, and tapping the icon will “demo?the transition
effect.
The shape icon indicates that the slide contains animated shapes.
If you assigned a transition delay-time to the slide in the Automatically
field of the Edit Menu, Slide Transition... screen, the delaytime
will be shown.
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The slide number is always shown at the right. If the slide has been
hidden using the Hide Slide command on the Edit Menu, the slide
number will be enclosed in a red box with a line crossing it out.



Notes Page
Notes Page view displays the current slide content in the upper pane,
with
the lower pane displaying the speaker notes that were entered for the
original PowerPoint presentation, or entered/edited in IA Presenter.
The
upper pane operation is the same as in Normal view. The lower pane is
both a Notes display window and an editing window. After editing a Note,
tap OK in the upper right corner to save it.
When in Notes Page view mode, you can project the currently-selected
slide to VGA output by activating the VGA Slide Toggle command on the
View Menu, or by tapping the VGA Slide Output Toggle icon at the rightmost
side of the Toolbar. To end the projection and return to viewing the
slide only on your mobile device screen, just select the command again
to
toggle it off.
Quick Notes
The Quick Notes command on the View Menu (and the Quick Notes View
icon on the Toolbar) gives you a view mode that combines the thumbnail
images of Slide Sorter view with the Notes pane of the Notes Page view.
When you tap on a thumbnail, a border around it indicates it is selected.
You can also use the Up, Down, Left, or Right buttons on your mobile
device to move the selection focus (or the Slide Title Bar, if you chose
to
display it).
The lower pane displays the Speaker Notes that were entered for the
original
PowerPoint presentation, or entered/edited in IA Presenter. The lower
pane is both a Notes display window and an editing window. Tap in the
lower pane to start editing a Speaker Note. The editing functionality
is the
same as for Notes Page view.
If the Cut/Copy/Paste/Clear/Undo/Select All commands are required for
editing the text, press your stylus within the Notes pane to activate
the
pop-up editing menu. The Notes-editing operation can be undone by
selecting the multiple-steps Undo command on the Edit Menu, pop-up
menu, or Toolbar.



Slide Show
The Slide Show command on the View Menu starts a full screen Slide
Show on the Pocket PC’s LCD screen. (If you want to project the slide
show to VGA output, you must use the VGA Slide Show command.)
Before selecting Slide Show or VGA Slide Show, you should select Set
Up Show... from the Tools Menu to set up the desired behavior for your
slide show.
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If the Auto-Rotate option is cleared in the Tools, Options, Display
tab,
the slide will be automatically rotated according to the direction you
choose (Left or Right).
Depending on the slide advancement setting specified in the Slide
Transition
dialog box, you can tap to advance the slide (or the next animated
object); use the navigation (arrows) buttons of your Pocket PC to
advance/back play the slides; or, IA Presenter will automatically
advance
slides based on the number of seconds (delaytime) you set. Sound effects
will also be played according to your assignment.
Pop-Up Menu for Slide Show Mode
If the Show Pop-up-Menu Button option is cleared in the Tools, Options,
and then Display tab, a small transparent icon will be shown in the
upper
left corner of the LCD screen. Tapping on the small icon will activate
the
Slide Show mode’s pop-up control menu. If this option isn’t cleared,
you
can always tap-and-hold your stylus during Slide Show mode to activate
the pop-up menu. The commands on the menu are explained below.
Next/Previous
Displays the next or previous slide, or next or previous animated object
(if
the animated object display was designed). Hidden slides won’t be
shown.
Go
The Go submenu allows you to jump to the First Slide, Last Slide,



Previously
Viewed Slide, or jump to any slide using Navigate by Title.
Trigger
If the Trigger mode is selected, the slide show will advance according
to
the mode you set using the Tools Set Up Show... command or Set Up

Show icon. For example, if you have specified to advance the slides
manually,
they will advance each time you tap on the screen. If the slide show
is
set to play automatically, you can use the pop-up menu to put it on
pause
or end it immediately. IA Presenter is set to Trigger mode by default.
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Pen
Select the Pen command to enter Ink annotation mode. During the Ink
annotation mode, you can use the stylus to mark or highlight the
presentation
elements on the screen. To exit the Ink annotation mode, select the
Trigger, VGA Pointer, or VGA Zoom mode from the pop-up menu.
Use the Pen Color submenu to choose the Ink color, and use the Pen
Width submenu to choose a thickness.
If Pen mode is active when you select Blank from the Screen submenu,
you will be able to draw or write Ink annotation on the projected black
screen. (The Screen submenu also lets you undo the most recent Ink
stroke, or erase all of the Ink strokes.)
VGA Pointer
This mode works only when IA Presenter is in VGA Slide Show view. After
you select the VGA Pointer command, your stylus movements on the
LCD screen will simulate a laser pen light on the VGA screen during
presentations.
(To exit the VGA Pointer mode, select Trigger, Pen, or VGA
Zoom from the pop-up menu.)
VGA Zoom
This mode works only when IA Presenter is in VGA Slide Show view. After
you select the VGA Zoom mode, you will be able to specify a portion



of
the screen which will be projected to the VGA screen, and also a zoom
ratio for that specific area. (To exit VGA Zoom mode, select Trigger,
Pen,
or VGA Pointer from the pop-up menu.)
The message that appears on your screen when you invoke VGA Zoom
mode depends on the value that is currently selected on the VGA Zoom
Size submenu. The message will either tell you to tap-and-drag your
stylus
to define an area yourself, or it will tell you to simply tap your stylus
to
create a zoom area of pre-defined size. You can specify the zoom ratio
using the VGA Zoom Ratio submenu, accessed from the Slide Show
pop-up menu.
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Pen Color
Tapping Pen Color opens a submenu of available colors to use for your
Ink annotation when in Pen mode. Select one of the available colors
as
the new pen color. The Reset command resets the pen color to the
default White color.
Pen Width
Tapping Pen Width opens a submenu of available pen widths to use for
your Ink annotation when in Pen mode. Select a thickness settings as
the
new pen width to be used for Ink strokes on the LCD screen (and projection
to VGA output, if desired). The 1 Unit option is the thinnest setting.
Higher values give you thicker widths.
VGA Zoom Size
The VGA Zoom Size command opens a submenu of “zoom area?
options. When you invoke VGA Zoom mode by selecting it on the pop-
up
menu, the current setting on the VGA Zoom Size submenu will be activated.
The Quarter, Large, Medium, Small, and Tiny settings on the submenu
represent pre-defined areas. For example, if Quarter is selected,
tapping
on your LCD screen will automatically produce a rectangular area which



is
the size of one-quarter of your LCD screen (centered around the spot
where you tapped).
The “zoom area?will be displayed on top of the already-existing
projection
of the entire slide on the VGA screen.
After the rectangular zoom area exists on your screen, you can drag
it to
any part of the screen you wish. It can also be converted to any of
the
other pre-defined sizes by pressing your stylus on the LCD screen to
open the pop-up menu again, then selecting a different value from the
VGA Zoom Size submenu. The size of the existing area will then be
changed accordingly.
If you select Drag Select on the submenu, you will be able to drag your
stylus on the LCD screen and freely define any area for zooming. After
the
desired area has been specified, you can drag it to any portion of the
screen. You can also resize it by dragging any of its corners. To specify
the zoom ratio for the projected zoom area, use the VGA Zoom Ratio
command.
VGA Zoom Ratio
The VGA Zoom Ratio command opens a submenu of pre-defined “zoom
ratio?options. When you invoke VGA Zoom mode by selecting it on the
pop-up menu, the current setting on the VGA Zoom Ratio submenu will
be activated.
Screen
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The Screen submenu contains commands that allow you to pause a Slide
Show (Pause Auto Play), project a blank screen (Blank), undo the most
recent Ink stroke (Clear Last Pen), or erase all Ink strokes (Clear
All
Pen).
Pause Auto Play
If you have specified that you want slides to advance automatically
after a
specified number of seconds (using the Set Up Show... command on the



Tools Menu or the Set Up Show icon on the Toolbar), you can select
Pause Auto Play during the playing of a slide show to pause the show.
When ready to continue the automatic progress of a slide show, tap
Resume Auto Play.
Blank
When you select Blank, your LCD screen will become completely black,
and the black screen will also be projected to your VGA screen. (After
you
have selected Blank, the command name changes to Restore. Tap
Restore when you are ready to return to the slide that was previously
displayed.)
Using the Blank Option with Pen Mode:
When the Blank option is active and IA Presenter is in Pen mode, you
can
write or draw digital Ink on the screen, and it will be output to the
VGA
device. In effect, this allows you to project an “electronic blackboard?
which you might find useful when giving a presentation to an audience.
Be
aware that any Ink strokes you draw on the Blank screen will be lost
when
you exit Blank mode. They cannot be retained.
When IA Presenter is in VGA Zoom mode or VGA Pointer mode, the
Blank option is not available.
Clear Last Pen
Erases the last individual Ink stroke. This command can be applied
repeatedly until there are no more Ink strokes in the current slide.
Clear All Pen
Erases all the pen strokes on the current slide.
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Speaker Notes
This command displays the current slide’s Note text (if any) in a pop-up
window, with the slide number also shown, on top of the displayed slide.
To advance the slide or object when the Speaker Notes window is shown,
tap on the underlying slide. When you advance the slides, the Speaker
Notes window remains open and interactively displays the Note text of
the



related slide. To close the Speaker Notes window, tap the X in the upper
right corner.
End Show
This command terminates the Slide Show playback mode and returns to
the mode you were using prior to entering Slide Show mode. The Action
button on your Pocket PC can also be used to exit Slide Show mode.
VGA Slide Show
VGA Slide Show mode operates almost identically to the Slide Show
mode, except for the following operational differences:
?You should use the VGA Output tab in the Tools, then Options...
command to set VGA output-related options. You can also elect to
have IA Presenter perform dithering for your slide if you project your
slide to an external VGA/video device with less color capability (such
as only 256 colors available).
?During VGA Slide Show mode, the presentation output will be directed
to both the Pocket PC’s LCD screen and the external connected VGA
device or video device.
The Pocket PC will always show the reduced size version, while the
VGA/video device will view the original matching dimensions set during
ActiveSync conversion. Or if your current presentation has a
dimension specified which is different from the exact dimension of
your selected output dimension, IA Presenter will automatically re-size
the slides to fit the output dimensions.
?The Ink annotation will be projected to both the VGA video device and
the LCD screen.
?You can use VGA Zoom on the pop-up menu to designate an area on
a slide during VGA Slide Show view, and project that specific area to
the VGA screen (on top of the already-existing projection of the entire
slide). Use the VGA Zoom Size command to specify an area of predefined
size, or manually drag your stylus on the LCD screen to specify
the desired area of the slide. Then use the VGA Zoom Ratio command
to choose the ratio at which you want the zoomed area to be
projected. After the “zoom window?has been created, it can be
dragged to enclose other portions of the slide on your LCD screen,
and this movement will also be reflected in the projected image on the
VGA output.
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?You can use the VGA Pointer command on the pop-up menu to
enable movements of your stylus on the LCD screen to simulate a
laser pen light on the VGA screen during VGA Slide Show presentations.
?In addition to being able to draw digital Ink annotation on your slides,
you can project a black screen to the VGA output and write or draw
projected Ink on it. To use Ink on the blank screen, make sure you are
in Pen mode on the Slide Show pop-up menu before selecting Blank
from the Screen submenu.
In addition, before a VGA Slide Show can be projected to a VGA screen,
you must specify the appropriate settings. Select Options... from the
Tools Menu, then tap VGA Output.
More information about the General, File, Display, and VGA Output tabs
are included in the on-line Help.
Controlling Transition Effects
Any transition effects that were assigned in your original PowerPoint
file
will be retained when the IA Presenter Converter converts it to an .iap
file
on your Pocket PC.
However, IA Presenter also furnishes many attractive transition effects
that can be assigned to the .iap file. You can assign a particular
transition
effect to an individual selected slide, or to all slides in the current
file.
After you select one or more slides, tap Slide Transition... on the
Edit
Menu or the icon on the Toolbar.
The Slide Transition screen will appear. In it, you can select a
transition
effect, a speed for the transition effect, method of slide advancement
during
a slide show, and associate a sound (.wav file) to a slide.
Merging Presentations
You can merge the slides of two different presentations into one file.
The
new inserted slides will adopt the Master Slide style of the current
file.
Therefore, you should first open the presentation whose Master Slide



style you want to adopt to.
The next thing you should do is select Options... from the Tools Menu
and open the File tab. Tap OK to close the tab and save the settings.
If you selected To Current Selection in the File tab as the insertion
position,
use your stylus to tap the desired insertion point in the current file
(in
Slide Sorter view). Or, select the slide after which you want the
imported
slides to be inserted.
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Select the Insert Slides From Files... command from the Tools Menu.
A
listing of files will appear. Tap the name of the file whose slides
you want
to merge with the current file, and it will be done immediately. This
command
can be undone or redone (Edit Menu). You can also use Save Presentation
As... (Tools Menu) if you wish to save a backup copy before
you start the merge operation, if desired.
More information about the General, File, Display, and VGA Output tabs
are included in the on-line Help.
IA Screen Mirror
IA Screen Mirror projects an exact emulation of your mobile device’s
screen contents (LCD display) onto a connected external VGA output
device or television monitor via the Composite video or S-video
terminals.
It allows you to project and display multiple LCD screens on the VGA
screen simultaneously, “freeze?them in the desired state, and maintain
one as the active viewport. Flexible output control options let you
control
the allocation of CPU utilization, orientation, resolution, and color
optimization/
dithering of projected images.
Getting Started.
Tap the IA Screen Mirror icon in your Programs group to start the IA
Screen Mirror program.



1. Use the Layout tab to set up the viewports to which you will
project images.
2. Use the Switch tab to assign a “switching?button on your mobile
device.
3. Use the Refresh tab and VGA tab to customize other parameters
as desired.
4. Tap OK to project the LCD screen contents onto the active viewport.
5. Start and operate the application you want to project (“foreground
application?.
6. To make adjustments to the settings, use the “switching?button
on your mobile device to freeze the active viewport and return to
the IA Screen Mirror control screens. Tap OK to continue the projecting.
7. Use the Exit Program button to terminate IA Screen Mirror
entirely and stop projection to the VGA screen.
For more information please refer to the on-line Help.
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On-line Help
This Manual serves as a quick-reference guide. For more details about
any feature, consult the on-line Help. When using IA Presenter, select
Tools, then Help for the main Help table of contents. In IA Screen Mirror,
tap the Help button in the About tab to access the main Help file.
Context-
sensitive Help is also available. If, during some operations, you cannot
open the Tools Menu, you can access the context-sensitive Help
messages via the Windows Start Menu.
A Note about Updates to the ATI Presentation Pack
Your copy of the ATI Presentation Pack contains the latest versions
of IA
Presenter and IA Screen Mirror. For updates, please visit the IA Style
web
site (www.iastyle.com).
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Correction
Charge the battery.
Lock side.
Switch Battery Pack Lock to
the Lock side.
Charge the battery.
Select , Settings,
System, Power to set to
alter the power shut down
time.
Replace the main battery
with a new one.
Troubleshooting
Check the following guide for the possible cause of a problem and how
to
correct it.
Cause Symptom
The battery power is
exhausted.
Even if the power button is
pressed and the power
does not turn on.
The main battery or the Attach the main battery/High
High Capacity Battery is Capacity Battery and switch
not attached. Battery Pack Lock to the
Battery Pack Lock is at
the Release side.
exhausted.
The power was suddenly The battery power is
cut off.
Automatic suspend is
active.
The battery is extinct. Even if the battery is
completely charged, it
discharges after a short
period of time.
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Cause Symptom
The screen was tapped, Touch screen
but the correct action was adjustment is incorrect.
not executed.
Insufficient memory The operation is slow in
response.
Some malfunction.
Some malfunction. The screen was tapped,
but there is no response.
The operation button
does not work either.
The screen light is off. The screen is dark.
The screen is hard to see. Brightness setting is
incorrect.
?Cannot connect to your
computer.
The USB driver of your Reselect the USB driver.
computer may not be
ActiveSync does not
function when your
Toshiba Pocket PC e800/ compatible.
e805 is connected to your
computer with a cradle or
USB cable.
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Correction
Select , Settings,
System, Screen, Align
Screen to adjust the touch
screen.
Secure the free memory.
Quit the application if it is not
in use.
Reset the system. If no
action is observed after
resetting the system,



initialize the system.
(However, the data will be
deleted.)
Reset the system. If no
action is observed after
resetting the system,
initialize the system.
(However, the data will be
deleted.)
Press and hold the power
button until the screen light is
turned on.
Select , Settings,
System, Screen Light to
adjust the screen brightness
for better sight.
See Help of ActiveSync.
Symptom
Cannot access the
Internet.
Following message is
displayed.
“NOT ENOUGH
BATTERY POWER.
USB devices can not be
used. Because PDA’s
battery power is low.?
Following message is
displayed.
“TOO MUCH USB
CONNECTION.
Connecting USB devices
are too much.?
Following message is
displayed.
“USB OVER CURRENT is too large.
DETECT USB device is
turned off. Please



disconnect USB device.?
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Correction Cause
The connecting using a Check whether the
specified cellular phone connecting using a specified
connection cable was not cellular phone connection
correct. cable is correct.
are satisfactory.
Radio waves of a Carry out communications
connected cellular phone where radio wave conditions
are getting worse.
Carry out correct setting. Setting is incorrect.
low to use USB devices.
The Battery power is too Charge the battery or
connect AC adapter.
The total power This USB port supports total
consumption of 500mA USB device. Confirm
connected USB devices connected USB device.
is too large.
The total power
consumption of
This USB port supports total
500mA USB device. Confirm
connected USB devices connected USB device.
To enable USB port again,
turn off the power of Pocket
PC or push Reset Switch.
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If the function cannot be restored even if the reset button
is pressed, initialize your Toshiba Pocket PC e800/e805.
Resetting
Reset is equivalent to "Restarting" a computer. Reset the Pocket PC
e800/e805 when a button or tapping the screen does not respond. When
your Toshiba Pocket PC e800/e805 is reset, all data that was not stored
during operation will be deleted.
NOTE
When the power is on, press the reset switch with the stylus, then



release.
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Clear Memory
When you initialize your Toshiba Pocket PC e800/e805, it returns to
the status when it was purchased.
When you initialize your Toshiba Pocket PC e800/e805,
all data stored in the memory is deleted. Your Toshiba
Pocket PC e800/e805's initially installed programs are
not deleted.
Before initialization, remove all CF/SD cards.
1. Turn off the power.
2. Press the power button while pressing and holding the reset switch
with the stylus, and then release the power button.
3. When a screen appears, release the reset switch. When initialization
is completed, the Welcome screen appears. Set up the system
according to the screen as in the case of startup procedure.
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Troubleshooting for Wi-Fi
If you encounter some problems while using our product, please refer
to
this troubleshooting section.
Problems
  Cannot connect to the
network
  
  
  
  
  
   
The host computer cannot
wirelessly connect with my
Toshiba Pocket PC e800/
e805
  
  



  
  
   
Cannot edit the "Channel" In Infrastructure mode, the channel is
field in "Infrastructure"
Mode?
decided by the Access Point. You can only
join the existing network formed by the
working Access Point, not to create a new
Wireless Network.
Reset the Toshiba Pocket PC e800/e805. The Toshiba Pocket PC
e800/e805 freezes
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Make sure the Wireless
Communication Switch is turned on.
Check if the SSID is correct (note
that it is case-sensitive)
Check Link Quality in Config Page. If
the link quality is poor, rescan and
find another Access Point.
Check if the operating mode is set
properly. See Config Page.
Check if the WEP key is correctly
entered.
Be sure you are in the range of a
working Access Point.
Make sure the channel been set is in
the range of 1 to 11.
Make sure you have setup the
partnership for your Toshiba Pocket
PC e800/e805 and your host
computer.
Make sure you are within the range
of a working network.
Make sure you have entered the IP
address of the host computer as the
WINS server on your Toshiba Pocket
PC e800/e805.



Reset your Handheld PC or Toshiba
Pocket PC e800/e805 to make the
TCP/IP settings take effect.
Make sure the SSID, WEP keys and
channel for all devices in the network
are set the same.
Make sure the channel been set is in
the range of 1 to 11.
Solutions
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FAQ for Wi-Fi
A. Compatibility
A1: Should I use equipment with the same brand as the
IEEE802.11b WLAN Adapter’s to enable the wireless communication?
This is not necessary. IEEE802.11b WLAN Adapter is Wi-Fi certified
which means that it will work well with differing brands of equipment
as long as the equipment is also Wi-Fi certified.
A2: Can I connect IEEE802.11b WLAN Adapter to other devices
using Bluetooth?
No, you can only connect the IEEE802.11b WLAN Adapter to other
IEEE802.11b equipment.
B. Wireless LAN Connectivity
B1: How do I form a wireless network?
Typically, you can form a wireless network by connecting Access
Points. Different Access Points should have different channels.
Every devices connected to the network should have the same
SSID. When you are using Access Points, set the mode to “Infrastructure?
mode. Without Access Points, you can still build a network
where adapters communicate peer-to-peer using a shared SSID.
When you are not using Access Points, change the operating mode
to be ?02.11Ad Hoc? To set the operating mode, click Start, Settings,
System, Wireless LAN Utility, then Config.
B2: How can I connect my Toshiba Pocket PC e800/e805 to the
usable Wireless Network?
Click Start, Settings, System, Wireless LAN Utility, Scan to view
Scan Page where you can find the usable Wireless Network. If you
cannot see all the networks you are expecting, please click “Rescan?
to see the list of usable Wireless Networks. Choose one Wireless



Network you want and double click the BSSID to connect to the network.
Once the network is chosen, you need to configure the
IEEE802.11b WLAN adapter.
Click Start, Settings, Connections, Network Adapters, IEEE802.11b
WLAN Adapter, Properties, IP Address to set IP address, Subnet mask
and Default gateway settings. Click Start, Settings, System, Wireless
LAN Utility to edit other settings, such as Mode and SSID etc. If the
WEP
Mode of the Wireless Network you selected is enabled (64bit or 128bit
WEP Mode), please choose the proper WEP KeyID and the proper WEP
Key value network.
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More Information
B4. What is 802.11 Ad Hoc Network? What should I do to form an
802.11 Ad Hoc Network?
B5. What is the difference between “Infrastructure?and ?02.11 Ad
Hoc?Network Mode?
How do I choose?
B6. Could I use the 802.11 Ad Hoc Mode to access the LAN
resources? How can I access the LAN resource without an
Access Point?
B7. What should I do if my host computer cannot wirelessly connect
with my Toshiba Pocket PC e800/e805?
E1. What is WEP?
E2. How many WEP security service mode does Wireless LAN support?
E3. How to set the WEP security service?
B3: How do I know whether or not my Pocket PC has already connected
to an AP successfully?
1. Check BSSID. When there is a link, the current Basic Service
Set ID of the Access Point been used will be shown in the
BSSID field in Link Page. When the adapter is disconnected with
the Access Point, “Non-associated?will appear in the BSSID
field. To view BSSID, from your Toshiba Pocket PC e800/e805,
click Start, Settings, System, Wireless LAN Utility, then Link.
2. Check Link Quality. Link Quality shows how clearly the adapter
can hear the Access Point. If the quality is poor, it’s better to rescan
and find a better performance Access Point or re-arrange



the AP’s position for better performance. To view Link Quality,
from your Toshiba Pocket PC e800/e805, click Start, Settings,
System, Wireless LAN Utility, Config.
B4: What is 802.11 Ad Hoc Network? What should I do to form an
802.11 Ad Hoc Network?
802.11 Ad Hoc Mode is used to create a peer-to-peer connection
without an Access Point. The SSID must be the same among stations
to enable the wireless communication within the local area network.
NOTE You need to choose a proper SSID and channel for the
first 802.11 Ad Hoc station. For other stations want to join

the same SSID group, you could only choose the same
SSID as the first station for connection. The Channel setting
for the 802.11 Ad Hoc Network stations to join the
existing 802.11 Ad Hoc Network will automatically be set
as the channel number of the network
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More Information
B5. What is the difference between “Infrastructure?and ?02.11 Ad
Hoc?Network Mode?
How do I choose?
B6. Could I use the 802.11 Ad Hoc Mode to access the LAN
resources? How can I access the LAN resource without an
Access Point?
B7. What should I do if my host computer cannot wirelessly connect
with my Toshiba Pocket PC e800/e805?
B5: What is the difference between “Infrastructure?and ?02.11 Ad
Hoc?Network Mode?
How do I choose?
Infrastructure Mode is used to connect your Toshiba Pocket PC
e800/e805 with the Access Point. Usually, to form a Wireless Network,
you can connect your Access Point to the ADSL, Cable Model
or LAN Ethernet and then configure the Access Point base on the
User Guide for the Access Point to set the proper SSID, Channel
and WEP security service. After that, configure the IEEE 802.11b
WLAN adapter. Set the same SSID, Channel and WEP as the
Access Point’s. 802.11 Ad Hoc Mode allows your Toshiba Pocket



PC e800/e805 to form its own local network where devices communicate
peer-to-peer, using a shared SSID, without Access Points.
Under 802.11 Ad Hoc mode, the SSID must be the same among stations
so that the devices can communicate properly within the Wireless
Network. If you want to form your network without any Access
Points, you should choose 802.11 Ad Hoc mode.
B6: Could I use the 802.11 Ad Hoc Mode to access the LAN
resources? How can I access the LAN resource without an
Access Point?
Yes, you can access the LAN resources without an Access Point.
Follow the steps shown below:
(1) Make sure your host computer already successfully connect to
the LAN or Internet through the LAN Adapter or the Modem.
(2) Install the Wireless LAN Adapter into your Host computer
successfully
and set 802.11 Ad Hoc Mode and the proper SSID to
form the 802.11 Ad Hoc Network. Install and enable the ICS
(Internet Sharing Software, such as “SyGate?..) function in your
host computer. (Note that the Windows 2K or later version, OS,
supports the ICS function in Local Area Connection Properties?
Sharing)
(3) Set your Toshiba Pocket PC e800/e805 as 802.11 Ad Hoc Mode
and choose the same SSID to join the 802.11 Ad Hoc Network
(choose the DHCP to get the IP assigned).
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(4) Check and make sure the Wireless LAN Adapter in the 802.11
Ad Hoc Network have the same IP group. (You can “ping?each
other to make sure the connection is successful)
(5) Now you can access the LAN resource successfully.
B7: What should I do if my host computer cannot wirelessly connect
with my Toshiba Pocket PC e800/e805?
(1) Make sure you have setup the partnership for your Toshiba
Pocket PC e800/e805 and your host computer.
(2) Make sure you are within the range of a working network.
(3) Make sure you have entered the IP address of the host computer
as the WINS server on your Toshiba Pocket PC e800/
e805.



(4) Reset your Toshiba Pocket PC e800/e805 to make the TCP/IP
settings take effect
(5) Make sure the SSID, WEP keys and channel for all devices in
the network are set the same.
(6) Make sure the channel been set is in the range of 1 to 11.
C. Application
C1: What should I do to use the ActiveSync Function through Wireless
Network?
(1) Make sure you have already setup the partnership for your
Toshiba Pocket PC e800/e805 and your host computer through
USB Interface and the ActiveSync can work properly. (The
ActiveSync connection Interface should also choose the Ethernet
interface for Wireless LAN ActiveSync Connection)
(2) Make sure you are within the range of a working Wireless Network.
(3) Make sure you can “ping?your Toshiba Pocket PC e800/e805
from your Host Computer. (Make sure the SSID, WEP keys and
channel for all devices in the network are set the same.)
(4) Make sure you have entered the IP address of the host computer
as the WINS server on your Toshiba Pocket PC e800/
e805.
(5) Reset your Toshiba Pocket PC e800/e805 to make the TCP/IP
settings take effect and execute the ActiveSync function in the
Toshiba Pocket PC e800/e805 to enjoy the high speed Active-
Sync Wirelessly.
C2: How do I wirelessly browse the Internet?
(1) If your network uses DHCP (Dynamic Host Configuration Protocol),
an IP address and DNS (or WINS) will be assigned automatically.
On your Toshiba Pocket PC e800/e805, simply click
Start, Setting, Connection, Network Adapters, IEEE802.11b
217
Chapter 11: Additional Information
WLAN Adapter, then Properties to set the proper setting for
Internet connection.
(2) If your network does not use DHCP, you should enter the IP
address, subnet mask, gateway and DNS (or WINS).
IP Address is Internet Protocol Address; a numeric address
such as 10.37.238.100 that the domain name server translates
into a domain name. Each node on the IP network should have a



unique IP address.
Subnet mask is a number used to identify a subnetwork when
multiple networks share one IP address. For example
255.255.255.0Gateway is a device used to forward IP packets to
and from a remote destination.
DNS stands for Domain Name System, a database system,
which translates addresses and domain names. For example, a
numeric address like 232.245.021.54 can become something like
cba.com.
WINS stands for Windows Internet Naming Service which has
two functions; one is a Microsoft Net BIO name server that eliminates
the broadcasts needed to resolve computer names to IP
addresses by providing a cache or database of translations. The
other one is to set the IP address of the host computer that you
already construct the partnership for Network adapter Active
sync purpose.
To set IP address, Subnet mask and Gateway, click Start, Settings,
Connections, Network Adapters, IEEE802.11b WLAN
Adapter, Properties, IP Address. To set DNS or WINS (Windows
Internet Naming Service), click Start, Settings, Connections, Network
Adapters, IEEE802.11b WLAN Adapter, Properties, Name
Servers.
(3) To ping your Toshiba Pocket PC e800/e805 from your host computer.
In the Host Computer, open the DOS command mode
window, type the command “Ping?followed by the IP address,
such as “Ping 140.124.40.112? If you can see the reply from this
IP address, the connection is complete. You are now ready to
browse the Internet using Internet Explorer on your Toshiba
Pocket PC e800/e805.
C3: How do I check my email on my wireless Toshiba Pocket PC
e800/e805?
(1) Please make sure that you can use the ActiveSync function
through USB Interface at first, and make sure you can use the
ActiveSync to receive and send email successfully. For corporate
email received and sent, please check with your network
administrator for necessary connection settings.
(2) Make sure you have entered the IP address of the host computer
as the WINS server on your Toshiba Pocket PC e800/



e805.
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(3) Reset your Toshiba Pocket PC e800/e805 to make the TCP/IP
settings take effect and execute the ActiveSync function in
Toshiba Pocket PC e800/e805 to enjoy the high speed, wireless
ActiveSync to receive and send email.
You need to choose a proper SSID and channel for the
first 802.11 Ad Hoc station. For other stations want to join
the same SSID group, you could only choose the same
SSID as the first station, but the channel will not take
effect. The 802.11 Ad Hoc must enter the proper SSID.
Blank SSID for the 802.11 Ad Hoc Mode is not allowed.
The stations want to join the 802.11 Ad Hoc Network must
have the same SSID and are suggested to have the same
IP Address in the Network group.
D. Settings
D1: What is SSID? What should I set in the SSID field?
SSID stands for Service Set Identification, which is the ID to form
the
Wireless Network. You can set up to 32 characters in the SSID field.
For the Infrastructure Mode, you should set the SSID the same as
the Access Point been connected with. To create a 802.11 Ad Hoc
Network, the SSID must be the same among stations to enable the
wireless communication within the local area network.
NOTE
D2: Why can’t I choose the “Channel?field in “Infrastructure?
Mode?
For the Infrastructure Mode, the Channel is decided by the Access
Point. You can only join the existing Access Point formed Wireless
Network but not create a new Wireless Network. That is the reason
why you can’t set the “Channel?setting.
D3: When should I set the IP address, Subnet mask and Default
gateway settings?
When the Wireless Network does not have the DHCP server, you
should set your own IP address, Submask and Default gateway for
Wireless Network connection. Otherwise, the OS might set the different
Network group IP address for you, which will cause the disconnection



for the Wireless Network.
D4: How can I set the IP address, Subnet mask and Default gateway
settings?
Simply click Start Settings Connections Network adapter IEEE802.11b
WLAN Adapter Properties IP Address to set IP address, Subnet mask
and Default gateway settings.
D5: What Transmit Rate should I choose for Wireless Connection?
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Suggest you to use the “Fully Auto option in the “Transmission
Rate?field for full Transmission Data Rate range to automatically
adjust the Best Communication Data Rate and to be compatible with
other Low speed 802.11 Wireless Device.
E. Security
E1: What is WEP?
WEP stands for Wired Equivalent Privacy, a security service, used to
prevent the unauthorized access to your wireless network.
E2: How many WEP security service modes does my Wireless LAN
support?
WEP stands for Wired Equivalent Privacy that is the security service
for the Wireless Network. There are three WEP security service
modes available for “IEEE 802.11b WLAN Adapter?formed Wireless
Network. The first is “Disable?which will disable the WEP security
service; the second is ?4bit?which will support 5 bytes Hexadecimal
value WEP security service; the third is ?28bit?which will support 13
bytes Hexadecimal value WEP security service.
E3: How do I set the WEP security service?
Please click Start, Settings, System, Wireless LAN Utility, and then
Security to view Security page where you can set the WEP security
service. Please choose the proper WEP Key Mode, WEP KeyID and
WEP Key value for the Wireless Network.
NOTE The WEP Mode, WEP KeyID and WEP Key value must
be exactly the same as your Wireless Network’s to enable
the connection.
Example of setting the WEP:
You can choose
1. WEP Mode ?4bit? KeyID ??and Key ?234567890?
or



2. WEP Mode ?28bit? KeyID ??and Key
?2345678901234567890123456?
or
3. WEP Mode “Disable?for connection
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F. Performance
F1: Will IEEE802.11b WLAN Adapter work in the environment where
Bluetooth network is employed?
Yes, IEEE802.11b WLAN Adapter can coexist with Bluetooth environment.
F2: How far is the working range of IEEE802.11b WLAN Adapter?
It depends on the data transmission rate and the condition of the
environments. The higher the data rate, the smaller the range it
could cover. At 11 Mbps, the adapter can go up to 300 meter in an
outdoor environment; however, in an indoor environment, it can only
go up to 100 meter. Because of the ceilings, higher RF interference,
interior walls and reflected signals, indoor range is usually shorter
than outdoor range.
F3: How does the data transmission rate work?
IEEE802.11b WLAN Adapter allows you to choose one of the six
data rate options: Fixed 1Mbps, Fixed 2Mbps, Fixed 5.5Mbps, Fixed
11 Mbps, Auto Select 1 or 2 Mbps, and Fully Auto.
The farther the distance between two communicating devices, the
slower the data rate should be used. Basically, with slower data rate,
the data delivery will be more reliable. If you don’t know which data
rate should be used, simply choose “Fully Auto? and the data rate
will automatically step down from 11 Mbps, 5.5 Mbps, 2 Mbps, to 1
Mbps if you move farther your Toshiba Pocket PC e800/e805 away
from the Access Point or other connected mobile device.
F4: The Wireless LAN uses lots of power. What should I do to save
power?
(1) Please turn off the Wireless LAN Switch if you are not using the
Wireless Network currently, or
(2) Click Turn Off on the TMU icon.
(3) Click Start, Settings, System, then Wireless LAN Utility Manager
to get into Manager Page and enable the “Enable Power Saving
Mode,?and then tap Apply.
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NOTE (1) Turn off the Wireless LAN Switch will cause the disconnection
of the Wireless Network, please make sure
to close all the Wireless Connection before you execute
this function.
(2) The Turn Off function on the TMU icon will cause the
disconnection of the Wireless Network, please make
sure to close all the Wireless Connection before you
execute this function.
(3) Enable “Power Saving Mode?will keep the connectivity
but will lower down the average throughput due to
longer connection period for the Wireless Network.
(4) If you are in 802.11 Ad Hoc Mode, you are not allowed
to enable “Power Saving Mode? because Ad Hoc
Mode doesn’t support this function.
F5: How do I make sure that the Wireless LAN SW has been
installed successfully and that Wireless LAN already work properly?
(1) Please check if the “IEEE 802.11b WLAN Adapter?already exist
in Start, Settings, Connections, Network Adapters; if not, the
Wireless LAN Driver is not Installed successfully.
(2) Please check if the Wireless LAN Utility already exist and could
be opened successfully by simply click Start, Settings, System,
then Wireless LAN Utility.
(3) Click Start, Settings, System, Wireless LAN Utility, Link to check
the current Link information in the Link Page.
Error Messages for Bluetooth
This section explains the causes of and solutions for the various
displayed
error messages.
Error messages during COM/DUN service
An error has occurred with the Bluetooth SD Card. Confirm that the
card is working properly.
Cause There was an error when loading the driver.
Solution Try reinserting the Card.
Unable to retrieve Local Device information.
Solution Reset the Toshiba Pocket PC.
Unable to retrieve Local Device information due to insufficient memory.
Check the amount of available memory.
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The remote device does not support OPP service.
The remote device does not support this function.
Cause
Unable to send the object.
Cause Local Device is unable to send a contact, schedule, task, or
business card due to a problem with the signal or a similar
communications error.
Unable to receive the object.
Cause Local Device is unable to receive a contact, schedule, task, or
business card due to a problem with the signal or a similar
communications error.
Select the item you want to send.
Cause You have not selected an item to send.
Unable to store all receiving data due to insufficient memory.
Cause A contact, schedule, or task cannot be stored due to insufficient
memory.
Solution Delete any unneeded data to increase the memory capacity.
Name not specified in owner information.
Cause A name has not been specified in the Name area of the owner
information.
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Cause An error occurred while trying to delete a file or folder, or
a separate
file or folder exists within the specified folder.
Solution Remove the file or folder from the specified folder and try
deleting
it again.
Unable to delete read-only file.
Cause Local Device tried to delete a file on the remote device, but
because it is a read-only file, it could not be deleted.
The selected file/folder already exists. Enter another file/folder
name.
Cause The name you tried to enter already exists.



Solution Enter a different name.
Enter a file/folder name.
Cause Either nothing has been entered for the name or the name consists
of spaces or begins with a period.
Solution Enter a correct name.
The following characters cannot be used in the file/folder name. \ /
You entered an invalid character in the file/folder name.
; , : * ? " < > |
Cause
Solution Rename the file/folder using correct characters.
Cannot rename file/folder.
Cause A processing error occurred because the entered name
exceeded the maximum length.
Solution Enter a shorter name.
Enter the folder name.
Cause After creating or changing a folder, either nothing has been
entered for the name or the name consists of spaces or begins
with a period.
Solution Enter a correct folder name.
The following characters cannot be used in the folder name. \ /
You entered an invalid character in the new folder name.
; , : * ? " < > |
Cause
Solution Rename the folder using correct characters.
The folder name could not be created.
Cause A processing error occurred because the entered name
exceeded the maximum length.
Solution Enter a shorter name.
The specified file could not be executed.
Cause You selected Execute or Receive/Execute, but the specified file
is not executable or the associated application software could
not be found.
The connection destination server is not selected. Select a server.
Cause You have not selected the device to which you want connect.
Sending or receiving failed. Cancelling process.
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The folder that you tried to locate in Local Device does not exist.



Cause
A communications error occurred.
Cause An internal OBEX error occurred when the remote device was
started.
Solution If the device you to which you were unable to connect is not
a
Bluetooth SD Card, try the operation again without FTP
authentication.
Troubleshooting for Toshiba IP Phone for
Pocket PC
VLI Lookup Server Not Accessible
Check Internet connection referring to “Troubleshooting for Wi-Fi.?

VLI Buddy Server Not Accessible
Check Internet connection referring to “Troubleshooting for Wi-Fi.?
Your G-Number or Password is Wrong
Make sure you set your G-Number and password properly.
Cannot call an IP phone
Make sure you log on to VLI Buddy Server. If you log on to it properly,
your status (Online, Offline, Busy or Away) is shown.
Check contact information in your buddy list or of your buddy icon.
Confirm your party's status is not offline.
Cannot call a phone
Make sure you log on to VLI Buddy Server. If you log on to it properly,
your status (Online, Offline, Busy or Away) is shown.
You cannot hear your party's voice
Check speaker volume on your Pocket PC.
Your party cannot hear your voice
Check microphone volume on your Pocket PC.
Make sure muting microphone is not activated. If Mute button color is
red,
push Mute button again.
Cannot see your buddy list
Make sure you log on to VLI Buddy Server. If you log on to it properly,
your status (Online, Offline, Busy, or Away) is shown.
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Specifications
External dimensions



Weight
Operating conditions
Battery type
Processor
Memory
Flash ROM Disk
Display
Interfaces
DC-IN
Headphone
Microphone
SD card slot
Infrared port
Cradle connection port
Audio
Accessories
Although the display is manufactured using an extremely high
technology,
there may be a case that some dots do not light or always light. It
is not a
malfunction.
32 MB
Chapter 11: Additional Information
Approximate 5.0 in (130 mm) x 3.2 in (78 mm) x 0.7 in (16
mm) (L x W x H)
Approximate 195g (6.9 oz.) with Wireless LAN module
(optional)
Temperature: 32°F to 104°F (0°C to 40°C), relative humidity:
30% to 80% when only the Toshiba Pocket e800/e805
is operating. Temperature capable of charging 41°F to
104°F (5°C to 40°C).
Lithium-Ion battery
Intel?PXA 255 Processor at 400 MHz
RAM: 64 MB, ROM: 32 MB
3.8?TFT Color LCD screen, 240 x 320 pixels, up to 64K colors
3.5 mm, stereo, mini-plug compatible
Integrated with 3.5 mm, stereo, mini-plug
SD memory card, SD I/O card or Multimedia card



The security function of the SD memory card is disabled. Data
encrypted by the SD memory card security function compatible
equipment is not usable.
Based on IrDA ver.1.3
Maximum data transmission speed: 115 kbps.
RGB, USB Host/Client
AC 97 codec, mono record, stereo playback, 8.0 KHz, 11.025
KHz, 22.05 KHz, and 44.1 KHz sample rate. Full duplex
record and playback. On board microphone. on board
speaker. Stereo earphone/microphone jack. Software volume
control.
AC Adapter, USB client cable, stylus pen, cradle, USB host
cable, battery pack, high capacity battery pack,
battery charger.
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